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Preface

As part of an effort to improve and enhance the performance and capabilities of its product 
lines, EMC periodically releases revisions of its hardware and software. Therefore, some 
functions described in this document may not be supported by all versions of the software or 
hardware currently in use. For the most up-to-date information on product features, refer to 
your product release notes.

If a product does not function properly or does not function as described in this document, 
please contact your EMC representative.

Audience This document is part of the NetWorker documentation set and is intended for use by 
system administrators during the installation and setup of NetWorker software.

NetWorker product documentation
This section describes the additional documentation and information products that 
are available with NetWorker.

EMC NetWorker Release 7.6 Service Pack 1 Installation Guide
Provides instructions for installing or updating the NetWorker software for clients, 
console and server on all supported platforms. 

EMC NetWorker Release 7.6 Service Pack 1 Cluster Installation Guide
Contains information related to installation of the NetWorker software on cluster 
server and clients. 

EMC NetWorker Release 7.6 Service Pack 1 Administration Guide
Describes how configure and maintain the NetWorker software. 

EMC NetWorker Release 7.6 Service Pack 1 Release Notes
Contain information on new features and changes, fixed problems, known 
limitations, environment and system requirements for the latest NetWorker software 
release. 

NetWorker Data Domain Deduplication Devices Integration Guide
Provides planning and configuration information on the use of Data Domain devices 
for data deduplication backup and storage in a NetWorker environment.

EMC NetWorker Licensing Guide
Provides information about licensing NetWorker products and features. 
Preface 7
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EMC NetWorker License Manager 9th Edition Installation and Administration 
Guide   
Provides installation, set up, and configuration information for the NetWorker 
License Manager product.

NetWorker 7.6 Service Pack 1 Error Message Guide 
Provides information on common NetWorker error messages. 

NetWorker 7.6 Service Pack 1 Performance Optimization Planning Guide 
Contains basic performance tuning information for NetWorker. 

NetWorker 7.6 Service Pack 1 Command Reference Guide 
Provides reference information for NetWorker commands and options. 

NetWorker Management Console Online Help
Describes the day-to-day administration tasks performed in the NetWorker 
Management Console and the NetWorker Administration window. To view Help, 
click Help in the main menu.

NetWorker User Online Help
The NetWorker User program is the Windows client interface. Describes how to use 
the NetWorker User program which is the Windows client interface connect to a 
NetWorker server to back up, recover, archive, and retrieve files over a network. 

NetWorker related documentation
For more information about NetWorker software, refer to this documentation:

EMC Information Protection Software Compatibility Guide 
A list of supported client, server, and storage node operating systems for the 
following software products: AlphaStor, ArchiveXtender, DiskXtender for 
Unix/Linux, DiskXtender for Windows, Backup Advisor, AutoStart, AutoStart SE, 
RepliStor, NetWorker, and NetWorker Modules and Options. 

E-lab Issue Tracker
Issue Tracker offers up-to-date status and information on NetWorker known 
limitations and fixed bugs that could impact your operations. E-Lab Issue Tracker 
Query allows you to find issues in the Issue Tracker database by matching issue 
number, product feature, host operating system, fixed version, or other fields.

NetWorker Procedure Generator 
The NetWorker Procedure Generator (NPG) is a stand-alone Windows application 
used to generate precise user driven steps for high demand tasks carried out by 
customers, Support and the field. With the NPG, each procedure is tailored and 
generated based on user-selectable prompts. This generated procedure gathers the 
most critical parts of NetWorker product guides and combines experts' advice into a 
single document with a standardized format. 

Note: To access the E-lab Issue Tracker or the NetWorker Procedure Generator, go to 
http://www.Powerlink.emc.com. You must have a service agreement to use this site.

Technical Notes and White Papers
Provides an in-depth technical perspective of a product or products as applied to 
critical business issues or requirements. Technical Notes and White paper types 
include technology and business considerations, applied technologies, detailed 
reviews, and best practices planning. 
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide8
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Conventions used in
this document

EMC uses the following conventions for special notices.

Note: A note presents information that is important, but not hazard-related.

IMPORTANT!
An important notice contains information essential to operation of the software. 

Typographical conventions
EMC uses the following type style conventions in this document:

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, 

buttons, fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, functions, utilities
• URLs, pathnames, filenames, directory names, computer names, filenames, 

links, groups, service keys, file systems, notifications

Bold Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system calls, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, 

buttons, fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside of 

running text 

Courier bold Used for:
• Specific user input (such as commands) 

Courier italic Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example
9
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Where to get help EMC support, product, and licensing information can be obtained as follows.

Product information — For documentation, release notes, software updates, or for 
information about EMC products, licensing, and service, go to the EMC Powerlink 
website (registration required) at:

http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer Service on 
Powerlink. To open a service request through Powerlink, you must have a valid 
support agreement. Please contact your EMC sales representative for details about 
obtaining a valid support agreement or to answer any questions about your account.

Your comments Your suggestions will help us continue to improve the accuracy, organization, and 
overall quality of the user publications. Please send your opinion of this document to:

BSGdocumentation@emc.com

If you have issues, comments, or questions about specific information or procedures, 
please include the title and, if available, the part number, the revision (for example, 
A01), the page numbers, and any other details that will help us locate the subject you 
are addressing.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide10
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Introduction
About the NetWorker product
The EMC® NetWorker product is a suite of storage management software that 
provides backup, recovery, and other services to computers with a wide variety of 
operating systems and data types. NetWorker products for different operating 
systems are interoperable. This provides the flexibility to design a storage 
management system that works best with the current computing environment.

The NetWorker software is distributed in these formats:

◆ In a media kit that contains the software and electronic documentation for several 
related NetWorker products.

◆ As a downloadable archive file from the EMC website.

 The NetWorker product has these components: 

◆ NetWorker client

◆ NetWorker storage node

◆ NetWorker server

◆ NetWorker Management Console

NetWorker client

The NetWorker client software communicates with the NetWorker server and 
provides recover and ad hoc (manual) backup functionality. The NetWorker client 
software is installed on all computers that are backed up to the NetWorker server. 

NetWorker storage node

Data can be backed up directly to devices that are attached to a NetWorker server, or 
to a NetWorker storage node. A storage node controls storage devices such as tape 
drivers, autochangers, and silos. 

Storage nodes depend on the NetWorker server for these functions:

◆ Control over which clients use the storage node’s devices for backups

◆ License management

◆ Management of the client file indexes that track each client’s data

◆ Management of the media database that tracks the data on each volume

NetWorker storage nodes and the NetWorker server can use different operating 
systems. To use a NetWorker storage node on a Linux operating system with a 
NetWorker server that is running another operating system, the storage node’s 
enabler on the server must be of the same edition as the base enabler for the 
NetWorker server.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide12
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NetWorker server

The NetWorker server software provides control and scheduling for NetWorker 
operations. It enables you to:

◆ Enter the enabler licenses for the NetWorker server and all the functions the 
NetWorker server controls, such as autochanger modules and additional client 
connections licenses.

◆ Define the clients, devices, and media that the NetWorker server controls.

◆ Define the schedules for backups and other operations.

◆ Monitor the results of backups and other operations.

◆ Manage the client file indexes that track each client’s data.

◆ Manage the media database that tracks the data contained on each volume.

NetWorker Management Console
All NetWorker servers and clients are managed from the NetWorker Management 
Console. The Console replaces the NetWorker Administration program (nwadmin) 
which is no longer available.

To administer NetWorker servers, the Console must be:

◆ Installed on an AIX, HP-UX, Linux, Solarisa, or Microsoft Windows host.

◆ Accessed through a graphical user interface on the host with a web-enabled 
browser that has the specified version of Java Runtime configured.

The Console provides reporting, managing, and monitoring capabilities for all 
NetWorker servers and clients. 

Multiple users can access the Console server concurrently from different browser 
sessions. A computer that hosts the web-enabled browser can also be a NetWorker 
client, server, or storage node.
About the NetWorker product 13
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Supported devices
NetWorker software supports a variety of media types and devices, either 
stand-alone or in an autochanger or silo tape library. Devices can be attached to a 
NetWorker server or designated storage node. 

The term autochanger refers to a variety of backup devices: 

◆ Autoloader 

◆ Carousel

◆ Datawheel

◆ Jukebox

◆ Library

◆ Near-line storage

The EMC Information Protection Software Compatibility Guide provides the latest list of 
supported devices.

Enabler codes
Enabler codes (licenses), which activate the functionality of NetWorker software, are 
generally sold separately. The NetWorker 7.6 Service Pack 1 License Guide provides 
information.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide14



2

This chapter includes these sections:

◆ General requirements ........................................................................  16
◆ TCP/IP requirements ........................................................................  18
◆ Client software requirements ...........................................................  23
◆ Storage node requirements ...............................................................  25
◆ Storage device requirements ............................................................  26
◆ Server software requirements...........................................................  27
◆ Console ................................................................................................  31

Software Requirements
Software Requirements 15



Software Requirements
General requirements
These requirements apply to Microsoft Windows and UNIX operating systems.

Microsoft Windows requirements
These are general NetWorker for Windows software installation requirements:

◆ Do not include an underscore character ( _ ) in Windows computer names.

◆ If the NetWorker software is installed on a File Allocation Table (FAT) partition, 
do not disable long name support.

◆ Microsoft Windows Installer 2.0 (msiexec.exe) was included with the NetWorker 
release 7.6 software. If the target computer has an older version of the Windows 
Installer, it will be updated and a reboot will be required during the NetWorker 
software installation or update. Refer to the Microsoft Windows documentation 
for instructions on how to determine the Windows Installer version and to update 
the version if required.

◆ InstallShield requires that the entire installation program is in memory, even to 
install only a single NetWorker software component.

◆ Ensure that the latest Microsoft Windows update or critical patch has been 
installed.

UNIX requirements
For NetWorker UNIX software installation:

◆ Ensure that the latest patches for the operating system are installed.

◆ Ensure that the block-size mode for tape devices that are used with the 
NetWorker software is set to variable. Otherwise, data recovery might fail. The 
procedure for setting the device block size varies depending on the operating 
system. For information about setting the tape device block size in the operating 
system, refer to the operating system’s documentation.

Available file descriptors 
Increase the number of file descriptors available per process by setting either of these:

◆ The global kernel parameter 

◆ In the NetWorker start script:

# ulimit -n 2048

Note: This command might differ depending on the operating system.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide16
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Language support

To view non-English data, ensure that the operating system is installed with the 
required language support software and that the corresponding language locale is 
enabled.

Note: NetWorker software does not support locales (defined by the operating system) or code 
sets that remap characters that have special meaning for file systems. Depending on the file 
system, these special characters may include the forward slash (/), the backward slash (\), the 
colon (:), or the period(.). For example, De_DE.646 is an unsupported locale. The NetWorker 
administration guide provides the latest information.
General requirements 17
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TCP/IP requirements
These are the TCP/IP network communication requirements: 

◆ All NetWorker server, storage nodes, and client host computers must have 
TCP/IP installed, configured, and networked.

◆ The NetWorker server hostname must be added to the Domain Name System 
(DNS) database for the network, or to the local hosts file located in:

• On Microsoft Windows:

%SystemRoot%\system32\drivers\etc

• ON UNIX:

/etc/hosts

Note: If DNS is used, reverse lookup must be correctly configured.

◆ All Linux, and UNIX, operating systems require a ::1 entry in the /etc/hosts file 
for the local host in order to run the NetWorker software. The entry must be in the 
form ::1 localhost aliases.

◆ If the NetWorker server host is a Dynamic Host Configuration Protocol (DHCP) 
client, it must have a reserved address.

◆ The TCP/IP hostname must be identical to the computer name. Do not include an 
underscore character (_) in the computer name.

◆ If DHCP with dynamic addresses is used, DHCP must be synchronized with 
DNS.

◆ The NetWorker server’s TCP/IP hostname and computer name must be the 
same.

Increase TCP backlog buffer size

1. Increase the TCP backlog buffer size:

Note: The TCP backlog parameter defines how many half-open connections can be kept in 
the backlog queue. If the incoming connections exceed this value, packet loss might occur 
on the NetWorker server. Packet loss can result in the failure, or unresponsiveness of the 
NetWorker server.

• Linux, set the connection backlog to the maximum value allowed:

net.ipv4.tcp_max_syn_backlog = 8192
net.core.netdev_max_backlog = 8192

• Solaris:

tcp_conn_req_max_q 4096
tcp_conn_req_max_q0 4096

• HP-UX:

tcp_conn_request_max 16384 
socket_caching_tcp 5000

More details are available in the NetWorker Performance Optimization Planning Guide.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide18



Software Requirements
Updating for the IPv6 protocol

Internet Protocol version 6 (IPv6) is a new internet protocol that can be used 
concurrently with IPv4 or in a pure IPv6 environment. IPv6 increases the number of 
available IP addresses, and adds improvements in areas such as routing and network 
autoconfiguration.

IPv6 is in the form [#:#:#:#:#:#]:Port. The square brackets are required to enclose the 
six decimal integers. The following is an example of an IPv6 address as it would be 
entered from the command line or the user interface:

http://[2001:720:1500::1:a100]:80/index.html

Ensure that the following tasks are performed when updating to an IPv6 
environment or switching between IPv4 and IPv6.

Add ::1 entry to the hosts file
All Linux, and UNIX operating systems require a ::1 entry in the /etc/hosts file for 
the local host in order to resolve the loopback address, and run the NetWorker 
software. The entry must be in the form:

::1 localhost aliases

IMPORTANT!
Once the system has been configured for an IPv6 environment, the ::1 entry must 
remain in the /etc/hosts file, whether operating in an IPv4 or IPv6 configuration.

NMC server IP address/hostname updates
If the IP address/hostname of the NMC server is modified or protocols such as IPv6 
are added or removed, perform the following:

1. Shut down NMC.

2. Navigate to the NMC bin directory and run the operating system-specific 
command:

• On Windows:

a. Go to C:\Program Files\Legato\Management\GST\bin.

b. Run gstconfig.

• On Solaris:

a. Ensure that the LD_LIBRARY_PATH environment variable contains 
/opt/LGTOnmc/bin:/opt/LGTOnmc/sybase/lib export 
LD_LIBRARY_PATH.

b. As root, run ./gstconfig.
TCP/IP requirements 19
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• On Linux:

a. Ensure that the LD_LIBRARY_PATH environment variable contains 
/opt/lgtonmc/bin:/opt/lgtonmc/sybase/lib export 
LD_LIBRARY_PATH.

b. As root, run ./gstconfig.

• On AIX:

a. Ensure that the LIBPATH environment variable contains 
/opt/lgtonmc/bin:/opt/lgtonmc/sybase/lib export LIBPATH. 

b. As root, run ./gstconfig.

• On HP-UX:

a. Ensure that the SHLIB_PATH environment variable contains 
/opt/lgtonmc/bin:/opt/lgtonmc/sybase/lib export SHLIB_PATH.

b. As root, run ./gstconfig.

IPv4/IPv6 interoperability
Since older NetWorker clients and storage nodes are supported with the NetWorker 
release 7.6 software, there are IPv6 and IPv4 interoperability considerations when the 
NetWorker server is installed on a machine using IPv6. 

Table 1 on page 20 indicates the interoperability conditions of NetWorker release 7.6 
servers and clients on platforms with various IP addresses, and the ways in which a 
NetWorker client can address a NetWorker server.

The table indicates the following conditions:

◆ NetWorker 7.5, and 7.6 and later (client/server) residing on an IPv4-only host.

◆ NetWorker 7.5, and 7.6 and later (client/server) residing on an IPv6-only host.

◆ NetWorker 7.5, and 7.6 and later (client/server) requiring dual-stack transports, 
but not requiring a host to have both IPv4 and IPv6 addresses.

Note: This table assumes on a dual-address machine the DNS lookup returns the IPv6 address 
first, if it exists, and then the IPv4 address, and that the network topology is correctly 
configured to allow IPv4 to IPv6 communication by way of translation.

Table 1 Matrix of interoperability of NetWorker 7.5 and earlier, and 7.6 and later clients 

NetWorker client release Platform
NetWorker 7.5 and 
earlier

NetWorker 7.6 and later 
server host

NetWorker 7.5, and 7.6 and later 
client

IPv4 Host IPv4 IPv4 translated in IPv6

IPv6 Host N/A IPv6

Dual stack IPv4 IPv6

NetWorker pre-7.5 client IPv4 Host IPv4 IPv4 translated in IPv6

IPv6 Host N/A N/A

Dual stack IPv4 IPv4 translated in IPv6
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide20
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Table 2 on page 21 shows the interoperability considerations of NetWorker servers 
and clients previous to release 7.6 and later on operating systems with various IP 
addresses, and the ways in which a NetWorker client can address NetWorker 7.5 and 
earlier, and a 7.6 and later server.

The table indicates the following conditions:

◆ NetWorker pre-7.5, and 7.5, 7.6 and later (client/server) residing on an IPv4-only 
host.

◆ NetWorker pre-7.5, and 7.5, 7.6 and later (client/server) residing on a dual-stack 
transport but that can only be addressed through an IPv4 address.

Note: This table assumes on a dual-address machine, the DNS lookup returns the IPv6 address 
first, if it exists, then the IPv4 address, and that the network topology is correctly configured to 
allow IPv4 to IPv6 communication by way of translation.

Optimizing DNS lookups on IPv4-only AIX computers
The default behavior of the AIX name resolver is to attempt lookups of both IPv4 and 
IPv6 addresses.

AIX first retrieves the address locally, and if this fails, requests the address from the 
DNS server. For servers that do not have IPv6 configured, this operation only returns 
a failure message after the request times out. Since the NetWorker software relies on 
AIX for resolving address information, NetWorker commands can appear to not be 
responding. 

Note: Any program which calls one of several AIX name resolution APIs that includes 
resolving IPv6 protocol will experience the same delays.

If the server is configured for IPv4 only:

1. Override the default behavior for DNS lookups. The NSORDER variable, 
/etc/irs.conf file and /etc/netsvc.conf file control name resolution. These entries 
must be changed, depending on the name resolution ordering in place, so that 
NetWorker services do not attempt to lookup IPv6 addresses against DNS.

Table 2 Matrix of interoperability of NetWorker pre-7.5 and 7.5 and later clients 

NetWorker client release Platform

NetWorker 7.5 and 7.6 
and later server IPv4 
host

NetWorker 7.5, and 7.6 and 
later server IPv6 host

NetWorker 7.5, and 7.6 client IPv4 host IPv4 IPv4 translated in IPv6

IPv6 host N/A IPv6

Dual stack IPv4 IPv6

NetWorker pre-7.5 clients IPv4 host IPv4 IPv4 translated in IPv6

IPv6 host N/A N/A

Dual stack IPv4 IPv4 translated in IPv6
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2. Ensure that AIX hosts use local name resolution ordering. The recommended 
name resolution ordering method is to use the /etc/netsvc.conf file. The order of 
priority in which AIX consults the files is:

• NSORDER

• irs.conf

• netsvc.conf

3. Update each name resolution ordering file, or files, that are in use so that the 
server attempts to lookup IPv4 addresses only with DNS. The following entries 
show how to update each file:

• Change the NSORDER variable to this:

export NSORDER=local,bind4

• Change the hosts entry in the /etc/irs.conf file to this:

hosts local
hosts dns4

• Change the hosts=local,bind entry in the /etc/netsvc.conf file to this:

hosts=local, bind4

IPv6 limitations
The following limitations apply when using IPv6 addresses for NetWorker release 7.6 
and later:

JRE version 1.6 must be installed in a pure IPv6 Windows environment 
If using NetWorker in a Windows environment with IPv6, only JRE version 1.6 is 
supported for running NMC.

Connecting to web server via IPv6 fails using Internet Explorer 6
Internet Explorer 6 does not handle IPv6 addresses. If you attempt to connect to the 
GST web server via an IPv6 address using the IE6 web browser, the browser does not 
connect and returns an error.

Use the Internet Explorer 7 web browser. This problem does not occur on IE7.

Do not perform client backups using temporary IPv6 addresses
Temporary or randomly generated IPv6 TCP/IP addresses are not supported in 
NetWorker. If the address for a client is not stored in DNS or in a hosts file and has 
not been added to the client resource, NetWorker will be unable to back up the client.
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Client software requirements
For NetWorker clients on the same hardware platform as the NetWorker server, use 
the same installation files to install the clients and server. The client software can be 
installed either on a remote network file system-mounted directory or a local drive. If 
the NetWorker software is installed on a remote file system, the NetWorker metadata 
(for example, /nsr) must still reside on a local file system.

The EMC Information Protection Software Compatibility Guide provides a list of 
supported operating systems.

On Mac OS X: NetWorker client support
The ClientPak installation requires the following:

◆ A supported Mac OS X system:

• Mac OS X Client and Server versions 10.3.9 and up and 10.4.x for PowerPC

• Mac OS X Client and Server versions 10.4.4 and up for Intel

◆ NetWorker products:

• NetWorker server software, release 7.4 and later on a supported UNIX, Linux, 
or Microsoft Windows platform.

• NetWorker client software for Mac OS X.

• A license enabler code appropriate for the number of NetWorker client 
connections.

• Appropriate storage devices installed and properly configured. The EMC 
Information Protection Software Compatibility Guide provides a list of supported 
devices.

◆ These supported file systems:

• HFS+ (including journaled)

• HFS

• UFS

Table 3 on page 23 and lists the space requirements for installing the ClientPak 
software.

Table 3 NetWorker ClientPak default locations and space requirements 

Software and documentation files NetWorker default location Space required

NetWorker client program files /usr/bin 9 MB

NetWorker client system binaries /usr/sbin 12 MB

NetWorker client executables /usr/lib/nsr 1 MB

NetWorker man pages /usr/share/man 1 MB

PDF files Optional Varies
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On HP Tru64 UNIX

To install NetWorker software on an HP Tru64 UNIX client system, the following 
requirements must be met:

◆ HP Tru64 UNIX version 5.1B-3 or later must be installed.

◆ Motif version 2.1 or later software must be installed.

◆ At least 50 MB of disk space in /usr/opt.

The minimum software listed in Table 4 on page 24 is installed.

Note: The installation requirements differ, depending on whether or not the clients have the 
same operating system as the NetWorker server.

On Linux
Table 5 on page 24 lists the requirements that must be met to install NetWorker 
software on a Linux client system. 

Deduplication client cache file size requirements

Clients that are configured to use deduplication backups require additional disk 
space for caches. The number of caches varies depending on the number of backup 
paths included in the Save set attribute of the Client resource. Each backup bath in the 
Save set attribute requires two caches: a file cache and a cache for hash tables. 

By default, the file cache can be up to 1/8 of the RAM on the machine, and the hash 
cache can be up to 1/16 of the RAM. Both have a maximum size of 2 GB. Therefore, 
the maximum disk space required for caching on a deduplication client is the sum of 
the maximum size of the file and hash caches, multiplied by the number of backup 
paths defined in the client’s Save set attribute.

Table 4 HP Tru64 UNIX: required client software

Package identifier Package name Description

IOSWWEURLOCxxx Worldwide European Unicode
Locales

Worldwide European Unicode Locales
package is located in the Worldwide
Language support kit, which is
available on the Tru64 Associate
Product CD 1

DSKMOTIF21xxx Motif 2.1.30 Motif libraries

OSFBASExxx Tru64 UNIX Base System Base operating system software

OSFCLINETxxx Basic Networking Services Network server communications

OSFMANOSxxx
(Optional)

Ref Pages (Admin/User Reference 
pages)

Reference pages for the base 
operating system; a requirement for 
viewing the NetWorker man pages

Table 5 Linux: required client software

Package identifier Package name Description

openmotif Open Motif Open Motif runtime libraries and 
executables
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Storage node requirements
To install the NetWorker storage node software, the following requirements must be 
met:

◆ At least one supported storage device must be attached and installed. The device 
can either be a stand-alone device, autochanger, or silo tape library. The EMC 
Information Protection Software Compatibility Guide provides a list of supported 
devices.

◆ NetWorker software also supports the use of file type and advanced file type 
devices. The NetWorker Administrator Guide provides more details.

The EMC Information Protection Software Compatibility Guide provides a list of 
supported operating systems.
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Storage device requirements
Install one or more storage devices prior to installing the NetWorker server software. 
Ensure that you install the SCSI adapter, cabling, and termination. The NetWorker 
installation program assumes that the storage devices have been properly installed 
and configured, and that the operating system recognizes the devices. The EMC 
Information Protection Software Compatibility Guide provides a list of the supported 
devices.

Note: Use a nonrewinding device for NetWorker backups. NetWorker software writes a 
filemark on the volume at the end of each backup. When the next backup occurs,NetWorker 
software appends data to the volume based on the position of the filemark. If a device 
automatically rewinds the tape, the filemark position is lost and the next backup overwrites 
existing data. In that case, you would not be able to recover the previous backup data.
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Server software requirements
This section describes the default location and space requirements for NetWorker 
software.

Excessive I/O service times
If I/O service times increase, there is a negative impact on the NetWorker server 
responsiveness and stability. Service times as high as:

◆ 50ms causes:

• NMC disconnects and/or errors

• Slower backups because of lower NetWorker server responsiveness

◆ 150ms causes:

• NetWorker server reliability issues

• Complete failure during normal operations

Default location and space requirements

These pathnames and directories are required for installation: 

◆ The directory on the server is large enough for the NetWorker resources, client, 
server indexes, and media database (usually /nsr).

◆ The system pathname of at least one storage device for use by the NetWorker 
server to back up and recover files.

◆ If a tape device is being used to back up data, use a valid pathname for that 
device. The tape device must be nonrewinding. 

◆ A directory for the PDF documentation files and for Adobe Acrobat Reader (if it 
is not already installed).

If the default locations and space requirements are accepted during installation, the 
installation script creates the directories listed in these sections:

◆ “Microsoft Windows location and space requirements” on page 27

◆ “Linux location and space requirements” on page 28

◆ “UNIX location and space requirements” on page 28

Microsoft Windows location and space requirements
Table 6 on page 27 specifies the location and space requirements for the NetWorker 
software in a Microsoft Windows environment.

Table 6 Microsoft Windows location and space requirements (page 1 of 2)

NetWorker files Location

Space

x86 x64 ia64

Client files Legato\nsr\bin 22 MB 28 MB 23 MB

Console Legato\management 263 MB 263 MB 263 MB

Storage node Legato\nsr\bin 27 MB 34 MB 32 MB

Server Legato\nsr\bin 33 MB 39 MB 40 MB
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Linux location and space requirements
Table 7 on page 28 specifies the location and space requirements for the NetWorker 
software in a Linux environment.

UNIX location and space requirements
Table 8 on page 28 specifies the location and space requirements. 

Client file index, media 
database

Legato\nsr\index
Legato\nsr\mm

varies varies varies

Daemons Legato\nsr\bin 1.5 MB 2 MB 3.2 MB

NetWorker License 
Manager

Legato\nsr\bin 275 MB 275 MB not supported

Table 6 Microsoft Windows location and space requirements (page 2 of 2)

NetWorker files Location

Space

x86 x64 ia64

Table 7 Linux location and space requirements

NetWorker files
Linux Itanium Processor Linux for x86

Location Space Location Space

Client files /usr/bin 35 MB /usr/bin 23 MB

Console /usr/bin not applicable /usr/bin 252 MB

Storage node /usr/bin 72 MB /usr/bin 48 MB

Server /usr/bin 93 MB /usr/bin 63 MB

Client file index, media database /nsr varies /nsr varies

Man pages /usr/share/man 2 MB /usr/share/man 2 MB

NetWorker License Manager /usr/sbin
/usr/nsr/lic/res
/nsr/lic/res

2 MB
22 MB
21 MB

/usr/sbin
/usr/nsr/lic/res
/nsr/lic/res

2 MB
22 MB
21 MB

Table 8 UNIX location and space requirements (page 1 of 2)

NetWorker files AIX HPUXa IRIXb Solaris HP Tru64 UNIX

Client

In /usr/bin
/usr/lib/nsr

/opt/networker/bin /usr/etc /usr/bin, /usr/lib/nsr
/usr/sbin

usr/opt/networker/bin

Size 82 MB 130 MB 69 MB 110 MB 80 MB

Console 

In /opt/lgtonmc /opt/networker/bin not applicable /opt/LGTOnmc not applicable

Size 297 MB 316 MB not applicable 270 MB not applicable

Storage node

In /usr/bin
/usr/lib

/opt/networker/bin not applicable usr/sbin, /usr/lib/nsr, 
/usr/kernel/drv

usr/opt/networker/bin
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Required server software

This section lists the required server software for Microsoft Windows, Linux, and 
Tru64 UNIX Version 5.1B-3 or later distributions.

Linux requirements
Table 9 on page 29 lists the Linux distributions supported in NetWorker 7.6 server 
software along with package requirements for each of the installations.

Note: Ensure that the kernel is supported and that the required package is installed before 
beginning the NetWorker software installation. The Linux distribution software 
documentation provides information.

Size 96 MB 109 MB not applicable 92 MB 175 MB

Server

In /usr/bin /opt/networker/bin not applicable usr/lib/nsr
/usr/sbin

usr/opt/networker/bin

Size 146 MB 177 MB not applicable 161 MB 220 MB

Client file index,media database

In /nsr /nsr /nsr /nsr /nsr

Size varies varies varies varies varies

Man pages

In /usr/share/man /opt/networker/man /usr/share/catman/p_man
/usr/share/catman/a_man

/usr/bin usr/opt/networker/man

Size 1 MB 1 MB 1 MB 1 MB 1 MB

NetWorker License Manager

In /usr/bin, /nsr/lic /opt/networker/bin /usr/etc /usr/sbin usr/opt/networker/bin

Size 3.2 MB 5 MB 4 MB 3.7 MB 5 MB

a. HPUX installations also require 25 MB of space, located in /tmp, to temporarily accommodate the swinstall program.

b. IRIX installations require an additional 80 MB of space, located in /tmp/nsr_extract, to permit software extraction.

Table 8 UNIX location and space requirements (page 2 of 2)

NetWorker files AIX HPUXa IRIXb Solaris HP Tru64 UNIX

Table 9 Required Linux software distributions (page 1 of 2)

Linux distribution Linux Itanium Processor Linux for x86

Kernel
Additional modules, 
libraries, and upgrades Kernel

Additional modules, 
libraries, and upgrades

SuSE Linux
Enterprise Server 8

2.4.18-1 pdksh-5.2.14-19.i386.rpm 2.4.19-4GB pdksh-5.2.14-532.i386.rpm

SuSE Linux 
Enterprise Server 9

2.4.18-1 pdksh-5.2.14-19.i386.rpm 2.4.19-4GB pdksh-5.2.14-532.i386.rpm
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Memory and storage requirements
Table 10 on page 30 lists the minimum memory and storage requirements for the 
NetWorker Server for Linux software. Additionally, because the client file index and 
media database that a NetWorker server generates can grow large over time, the 
NetWorker server needs enough free storage space to accommodate the indexes listed 
in Table 10.

HP Tru64 UNIX specific requirements
Table 11 on page 30 lists the required server and storage node software for HP Tru64 
UNIX Version 5.1B-3 or later.

SuSE Linux
Enterprise Server 10

2.6.9-5.EL and 
higher

pdksh-5.2.14-801.i586.rpm 2.6.9-5.EL and 
higher

pdksh-5.2.14-801.i586.rpm

Red Hat Enterprise 
Server 3 

2.4.21-4.EL dksh-5.2.14-21.i386.rpm 2.4.21-4.EL pdksh-5.2.14-21.i386.rpm

Red Hat Enterprise 
Server 4

2.6.9-5.EL and 
higher

dksh-5.2.14-30.i386.rpm 2.6.9-5.EL and 
higher

pdksh-5.2.14-30.i386.rpm

Table 9 Required Linux software distributions (page 2 of 2)

Linux distribution Linux Itanium Processor Linux for x86

Kernel
Additional modules, 
libraries, and upgrades Kernel

Additional modules, 
libraries, and upgrades

Table 10 NetWorker server memory and storage requirements

Requirements Linux Itanium Processor Linux for x86

Recommended RAM  256 MB 256 MB

Disk storage for software 512 MB 512 MB

Online indexes 5% of total backup data 
(allows for up to three times the index size 
during software update conversion)

5% of total backup data 
(allows for up to three times the index size during 
software update conversion)

Table 11 HP Tru64 UNIX required server and storage node software

Package identifier Package name Description

IOSWWEURLOCxxx Worldwide European Unicode
Locales

Worldwide European Unicode Locales
package is located in Worldwide
Language support kit which is
available on the Tru64 Associate
Product CD 1

DSKMOTIF21xxx Motif 2.1.30 Motif libraries

OSFBASExxx Tru64 UNIX Base System Base operating system software

OSFCLINETxxx Basic Networking Services Network server communications

OSFPRINTxxx
(server only)

Local Printer Support (Printing 
Environment)

Support needed to print the bootstrap file and 
information from NetWorker windows that appears in 
tabular format

OSFMANOSxxx
(Optional)

Ref Pages (Admin/User Reference 
pages)

Reference pages for the base operating system; a 
requirement for viewing the NetWorker man pages
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Console
This section lists the Console server, client and database software requirements:

◆ “Console server” on page 31

◆ “Console database” on page 34

◆ “Console client” on page 35

◆ “Using international fonts in UNIX non-US locale environments” on page 35

Console server
Install the Console server software on one computer in the datazone to manage the 
NetWorker server. Only one installation of the NetWorker Console server is required 
to manage multiple NetWorker servers.

The general requirements for installing the Console server include the following:

◆ An installed and licensed network of NetWorker servers, clients, and storage 
nodes. The NetWorker License Manager software is optional.

◆ A Java Runtime Environment (JRE), which is required in order to:

• Support the command line reporting feature.

• Download the Console client and display the user interface.

Note: 64-bit versions of NetWorker require the 32-bit JRE.

◆ Set up a User/Group with limited privileges that NMC will use to run the web 
server. This must be a non-root user. For example, the Solaris, Linux, and AIX 
operating systems have a default user/group [nobody/nobody] that can be used.

Note: If the environment runs only LDAPS, also known as LDAP over SSL, and you are not 
using native NetWorker user authentication, the Console server must not be installed on a 
Solaris server. However, the Console server can still be installed on a Linux, Windows, AIX or 
HP-UX server.

System requirements

Table 12 on page 31 lists the system requirements for the Console server and 
database.

Table 12 Console server and database requirements (page 1 of 3)

System features Operating system Requirement

Processor and RAM AIX Minimum: 1 GHz with 256 MB of RAM, 512 MB to run reports.
As the number of NetWorker servers being monitored increases, 
increase the computer’s capabilities.
• For 50 servers: Dual 500 MHz with no less than 192 MB
• For 100 servers: Dual 800 MHz with no less than 256 MB
• For 200 servers: Dual 1.3 GHz with no less than 512 MB

HP-UX

Microsoft Windows

Linux

Solaris
Console 31



Software Requirements
Operating system AIX • AIX5L version 5.2 (32-bit, 64-bit)
• AIX5L version 5.3 (32-bit, 64-bit)
• AIX6L version 6.1

HP-UX • HP-UX 11i v2, v3

Microsoft Windows • Windows XP x86
• Windows XP 64-bit
• Windows Vista x86
• Windows Vista 64-bit
• Windows Server 2003 x86
• Windows Server 2003 64-bit
• Windows Server 2008 x86
• Windows Server 2008 64-bit

Linux • Red Hat Enterprise Server 4
• Red Hat Enterprise Server 5
• Oracle Enterprise Linux 4
• Oracle Enterprise Linux 5
• SuSE Linux Enterprise Server 9
• SuSE Linux Enterprise Server 10

Note: SuSE Linux Enterprise Server version 9.2 is not supported.

SGI IRIX • SGI IRIX 6.5.25-30

Solaris • Solaris 9, 10, 11

Software AIX The NetWorker client release 7.6 or later software must already be 
installed and running.

HP-UX The NetWorker client release 7.6 or later software must already be 
installed and running.

Linux The NetWorker client release 7.6 or later software must already be 
installed and running.

Microsoft Windows The NetWorker client release 7.6 or later software must already be 
installed and running.

Note: NetWorker Remote Exec service must be installed and 
running. If the service is stopped, the Setup Wizard issues an error 
message.

Solaris The NetWorker client release 7.6 or later software must already be 
installed and running.

Table 12 Console server and database requirements (page 2 of 3)

System features Operating system Requirement
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Java Runtime 
Environment

AIX JRE starting from version 1.6 or later. This is required to run the 
command line reporting feature.

HP-UX Use the WebStart included with JRE 1.6, or JRE version 1.6_01 
(which includes WebStart).

Linux JRE starting from version 1.6 or later. This is required to run the 
command line reporting feature.

Microsoft Windows JRE version 1.6.0 and later for these Windows platforms:
Windows 7
Windows Vista
Windows 2008
Windows 2008 R2
This is required to run the command line reporting feature.

Note: JRE version 1.6 or later is also required for an IPv6 
environment.

Solaris JRE starting from version 1.5_11 or later. This is required to run the 
command line reporting feature.

Browsers AIX • Mozilla 1.7 on the supported AIX platforms.

HP-UX • Mozilla 1.7 on the supported HP-UX platforms.

Linux • Netscape Communicator 7.2, on the supported Linux platforms.
• Mozilla 1.7 on the supported Linux platforms.

Microsoft Windows • Microsoft Internet Explorer 6.x on the supported Microsoft 
Windows platforms. Microsoft Internet Explorer 7.x, and 8 on 
supported Microsoft Windows Vista, XP, and 2008.

Solaris • Netscape Communicator 7, on the supported Solaris platforms.
• Mozilla 1.7 on the supported Solaris platforms.

Available disk space AIX • 350 MB + x, where: x is a buffer of disk space for the Console 
database. 

• JRE with Web Start: 55 MB

HP-UX • 350 MB + x, where: x is a buffer of disk space for the Console 
database.

• JRE with Web Start: 55 MB

Linux server • 60 MB + x, where: x is a buffer of disk space for the Console 
database.

Microsoft Windows 
server

• 220 MB + x, where: x is a buffer of disk space for the Console 
database.

• JRE with Web Start: 55 MB

Solaris server • 350 MB + x, where: x is a buffer of disk space for the Console 
database.

Table 12 Console server and database requirements (page 3 of 3)

System features Operating system Requirement
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Console database

This section provides information on estimating the size and space requirements for 
the Console database:

◆ “Formula for estimating the size of the NetWorker Management Console 
database” on page 34

◆ “Formula for estimating the space required for the Console database 
information” on page 34

Formula for estimating the size of the NetWorker Management Console database
The Console server collects data from the NetWorker servers in the enterprise, and 
stores the data in its local Console database. By default, the database is installed on 
the local file system that can provide the most available space. Console integrates and 
processes this information to produce reports that facilitate trend analysis, capacity 
planning, and problem detection. The  NetWorker administrator guide provides 
information about reports.

To store the collected data, allocate sufficient disk space for the Console database. 
Several factors affect the amount of disk space required:

◆ The number of NetWorker servers monitored for the reports

◆ The number of savegroups run by each of those servers

◆ The frequency with which savegroups are run

◆ The length of time report data is saved (data retention policies)

Note: Since the amount of required disk space is directly related to the amount of historical 
data stored, the requirements can vary greatly, on average between 0.5 GB and several GB. 
Allow for this when planning hardware requirements.

Formula for estimating the space required for the Console database information
Use these formulas to estimate the space needed for different types of data and to 
estimate the total space required.

Save set media database
To estimate the space needed for the save set media database, multiply the weekly 
amount of save sets by the number of:

◆ NetWorker servers monitored by the Console

◆ Weeks in the Save Set Output policy

The result indicates the length of time that a save set took to run successfully. The 
results also identify the number of files that were backed up, and how much data was 
saved during the operation.

Save set output
To estimate the space needed for the save set media database, multiply the weekly 
amount of output messages by the number of:

◆ NetWorker servers monitored by the Console

◆ Save Set Output Retention policy

The result indicates how many groups and save sets were attempted and their 
success or failure.
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Savegroup completion data
To estimate the space needed for the save set media database, multiply the weekly 
amount of savegroups by the number of:

◆ NetWorker servers monitored by the Console

◆ Weeks in the Completion Data Retention policy

The result can be used to troubleshoot backup problems

Console client

Although the Console client does not need to be installed separately, the JRE which 
includes Java Web Start must be installed in order to download and run the program 
properly. 

When connecting to the Console server for the first time, there is a prompt to 
download the JRE and the Console client application. 

Table 12 on page 31 lists the system requirements for installing the Console client.

Using international fonts in UNIX non-US locale environments

The Console software can run (in English mode) on localized operating systems. It 
supports retrieval of double-byte characters from NetWorker data. 

If the appropriate non-English font is not available on the Console client, the 
retrieved data appears as illegible.

To use or view data from a localized, non-English NetWorker server:

1. Ensure that the appropriate language support package is installed for the 
NetWorker software.

2. Ensure that the appropriate font is available to the Console client.

Note: If required, obtain the fonts from the operating system vendor and intall them.

3. From the Console menu, select View > Fonts and perform one of these tasks: 

• Change the language locale to match that of the localized NetWorker language 
locale.

• Choose a language font that is already loaded in the operating system and 
which matches the location of the localized NetWorker language locale. 

Changing the language locale to match that of non-localized NetWorker data
There are two ways to change the language locale to match that of the localized 
NetWorker language locale. Choose one of the following:

◆ Before logging in to the host system:

1. Select Options on the Login dialog box. 

2. Select Options > Language.

3. Select a locale from one of three alphabetical lists.
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◆ After logging in to the host system:

1. Type the setenv command to change the locale.

2. Depending on the language, select one of these:

– To match the French NetWorker locale, type:
setenv LANG fr
setenv LC_ALL fr

– To match the Japanese NetWorker locale, type:
setenv LANG ja
setenv LC_ALL ja

– To match the Simplified Chinese NetWorker locale, type:
setenv LANG zh
setenv LC_ALL zh

Changing the language font to view localized NetWorker data
Instead of changing the language locale, you can change the Console font, so that 
localized NetWorker data can be viewed from the Console software. The appropriate 
font must be loaded in the operating system of the Console server and client.

To load a font:

1. To select a language font, select Console > View > Font. The Change Font dialog 
appears.

2. Select the appropriate font and font size, if the default size is inappropriate and 
click OK.

Using a non-US locale
When using Console software in a non-US environment, support for the language 
locale and various language character sets is derived from the host operating system. 
In order to display non-English characters, the host operating system must have 
installed a font (or fonts) that supports those characters.

The Console client, rather than the Console server, must have the appropriate 
language character sets supported in the client operating system. By default, Console 
software uses a non-UNICODE font that supports US English. 

If the font is loaded in the operating system, a language locale that is supported by a 
localized version of NetWorker software automatically recognizes the font for the 
associated localized language. If the required font is loaded in the operating system, 
an appropriate language font can then be selected. 
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Installation roadmap
Use this roadmap when installing the NetWorker software:

1. Review Chapter 2, “Software Requirements,” and note the default directory 
location and space requirements.

Mac OS X requirements are provided in the section “On Mac OS X: NetWorker 
client support” on page 23.

2. If there is an earlier release of NetWorker software installed, update the software:

• Microsoft Windows instructions are available in “Update the NetWorker 
software on Microsoft Windows” on page 47.

• UNIX instructions are available in “Update the NetWorker software on UNIX” 
on page 53.

3. Access the NetWorker software:

• Microsoft Windows instructions are available in “Microsoft Windows” on 
page 39.

• UNIX instructions are available in “UNIX” on page 40.

4. Install the required NetWorker software:

• Microsoft Windows installation information is available in “Microsoft 
Windows Installation” on page 139.

• UNIX installation instructions are available in the appropriate chapters:

– Chapter 5, “AIX Installation,” 
– Chapter 6, “HP-UX Installation,”
– Chapter 11, “HP Tru64 UNIX Installation,”
– Chapter 7, “IRIX Installation,” 
– Chapter 8, “Linux Installation,”
– Chapter 9, “Mac OS X Client Installation,”
– Chapter 10, “Solaris Installation,”

Note: Install the Console server software on one computer in the datazone to manage the 
NetWorker server. Only one installation of the Console server is required to manage 
multiple NetWorker servers.

5. Test the NetWorker software. Chapter 13, “Verify the Installation,” provides 
information.

6. Enable and register all NetWorker products. The NetWorker 7.6 Service Pack 1 
License Guide provides information.
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Accessing the software
The procedure for accessing the installation files differs for Microsoft Windows and 
UNIX environments. Refer to the appropriate section for instructions:

◆ “Microsoft Windows” on page 39

◆ “UNIX” on page 40

Microsoft Windows

Access the installation files from one of either a local DVD drive or from the EMC 
Powerlink website at http://Powerlink.EMC.com.

From a local DVD drive
To access NetWorker installation files on a local CD-ROM:

1. Log in with administrator privileges where the NetWorker software is being 
installed.

2. Insert the NetWorker software media into the DVD drive.

3. If Autorun is enabled, the NetWorker software installation screen appears 
automatically. Perform the following:

a. Select Install NetWorker Release 7.6.1 software.

b. In the File Download dialog box select Run this program from its current 
location.

c. If a security warning appears, click Yes to continue.

4. If Autorun is disabled, change directories to the appropriate location:

• win_x86 (to install on a 32-bit computer)

• win_x64 (to install on a 64-bit computer)

• win_ia64 (to install on a 64-bit computer)

From the website
To access the installation software from the Powerlink® website:

1. Log in with administrator privileges where the NetWorker software is being 
installed.

2. Create a temporary folder to download and extract the evaluation software.

3. Go to the http://Powerlink.EMC.com website, select Support > Software 
Downloads and Licensing > Downloads J-O > NetWorker.

4. Download the evaluation software to the temporary folder and change to that 
folder.

5. Extract the downloaded file.
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UNIX

Access the installation files from one of either a local DVD or the EMC website.

From a local DVD drive
To access the NetWorker software from a local DVD drive:

1. Log in as root on the computer where the NetWorker software is being installed.

2. Mount the media and locate the appropriate installation directory.

3. For UNIX platforms:

a. Ensure that the PATH environment variable for the user root on the 
NetWorker server and the user on each NetWorker client contain the directory 
where the NetWorker executables reside.

b. For IRIX only, add a symbolic link from the source directory to the target 
directory. For example:

ln -s /dvd/irix/networkr.tar /tmp/sgi.tardist

Table 13 on page 40 provides a listing of the NetWorker installation directories. 

4. Install the software by using the instructions in the appropriate chapters: 

• Chapter 5, “AIX Installation,” 

• Chapter 6, “HP-UX Installation,”

• Chapter 11, “HP Tru64 UNIX Installation,”

• Chapter 7, “IRIX Installation,” 

• Chapter 8, “Linux Installation,”

• Chapter 9, “Mac OS X Client Installation,”

• Chapter 10, “Solaris Installation,”

From the website
To access the installation software from the EMC website:

1. Log in as root on the computer where the NetWorker software is being installed.

2. Create a temporary folder to download and extract the evaluation software.

3. Go to the http://Powerlink.EMC.com website, select Support > Software 
Downloads and Licensing > Downloads J-O > NetWorker, and navigate to the 
appropriate content management download site.

Table 13 NetWorker installation directories

Operating system NetWorker installation directory

AIX /usr/bin

HP-UX /opt/networker/bin

HP Tru64 UNIX /usr/opt/networker/bin

IRIX /usr/etc

Linux  /usr/sbin

Mac OS X  /usr/sbin

Solaris /usr/sbin
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4. Ensure that there is enough disk space to contain both the compressed download 
NetWorker software file and the fully uncompressed files as listed in Table 14 on 
page 41. 

5. Download the NetWorker evaluation software to a temporary directory.

6. Uncompress the downloaded software. Table 15 on page 41 provides details.

7. For IRIX only, add a symbolic link from the source directory to the target 
directory. For example:

ln -s targetdir/nw761_irix_tar /tmp/sgi.tardist

Table 14 Size of compressed and uncompressed files

Operating system Compressed file Uncompressed file

AIX 55 MB 715 MB

HP-UX  45 MB 740 MB

HP Tru64 UNIX 105 MB 275 MB

IRIX 75 MB 75 MB

Linux for IBM PowerPC 20 MB 20 MB

Linux for Intel x86 35 MB 350 MB

Linux for Intel x86-64 350 MB 350 MB

Linux Itanium 105 MB 105 MB

Mac OS X not applicable Not applicable

Solaris for Intel x86 20 MB 355 MB

Solaris for Intel x86-64 70 MB 195 MB

Table 15 Uncompress the downloaded software file

Operating system Command to uncompress and download the software

AIX gunzip nw761_aix.tar.gz

HP-UX 11.x gunzip nw761_hpux11_64.pkg.gz

HP-UX 11i on the Itanium Processor Family (IPF) gunzip nw761_hpux11_ia64.pkg.gz

HP Tru64 UNIX gunzip nw761_tru64.tar.gz

IRIX gunzip nw761_sgi.tar.gz

Linux for IBM PowerPC gunzip nw761_linux_ppc64.tar.gz

Linux for Intel x86 gunzip nw761_linux_x86.tar.gz

Linux for Intel x86-64 gunzip nw761_linux_x86_64.tar.gz

Linux Itanium gunzip nw761_linux_ia64

Mac OS X not applicable

Solaris for Intel x86 gunzip nw761_solaris_x86.tar.gz

Solaris for Intel x86-64 gunzip nw761_solaris_amd64.tar.gz
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8. Extract the uncompressed file by using these commands as listed in Table 16 on 
page 42.

The NetWorker distribution software directories and files are listed on the screen 
as the extraction proceeds.

9. Ensure that the PATH environment variable for the user root on the NetWorker 
server and the user on each NetWorker client contain the directory where the 
NetWorker executables reside. Table 17 on page 42 provides details.

Table 16 Commands to extract the software

Operating system Command to extract the software

AIX tar -xvpf nw761_aix.tar

HP-UX 11.x tar -xvpf nw761_hpux11_64.tar

HP-UX 11i on the Itanium Processor Family 
(IPF)

tar -xvpf nw761_hpux11_ia64.tar

HP Tru64 UNIX tar -xvpf nw761_tru64.tar

IRIX tar -xvpf nw761_sgi.tar

Linux Itanium tar -xvpf nw761_linux_ia64

Linux for Intel x86 tar -xvpf nw761_linux_x86.tar

Linux for Intel x86-64 tar -xvpf nw761_linux_x86_64.tar

Linux for IBM PowerPC tar -xvpf nw761_linux_ppc64.tar

Mac OS X not applicable

Solaris for Intel x86 tar -xvpf nw761_solaris_x86.tar

Solaris for Intel x86-64 tar -xvpf nw761_solaris_amd64.tar

Table 17 NetWorker installation directories

Operating system NetWorker installation directory

AIX /usr/bin

HP-UX /opt/networker/bin

HP Tru64 UNIX /usr/opt/networker/bin

IRIX /usr/etc

Linux  /usr/sbin

Mac OS X  /usr/sbin

Solaris /usr/sbin
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10. Install the software by using the instructions in the appropriate chapters:

• Chapter 5, “AIX Installation,” 

• Chapter 6, “HP-UX Installation,”

• Chapter 11, “HP Tru64 UNIX Installation,”

• Chapter 7, “IRIX Installation,” 

• Chapter 8, “Linux Installation,”

• Chapter 9, “Mac OS X Client Installation,”

• Chapter 10, “Solaris Installation,”
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Introduction
When updating to NetWorker release 7.6 and later from NetWorker release 7.3 or 
earlier, there is no way to revert to a previous release of the NetWorker software. It is 
a one-way conversion as the client file indexes are automatically reorganized into 
new directory structures. However, upgrades from NetWorker release 7.3.x or later 
can be downgraded back to the same release.

The NetWorker software does not support direct upgrade, which means the previous 
installed version must be removed before the new version can be installed. When 
upgrading the NMC version, make a copy of the current database. This database will 
be required if you downgrade the software.

Update enablers 
When updating from a 7.5.x release to 7.6 and later, an update enabler is not required 
and is not generated. If you are upgrading to release 7.6 and later from a release prior 
to 7.5, an update enabler is required. If an update enabler is required, the NetWorker 
software automatically generates and adds the required update enabler code to its 
configuration. The update enabler expires after 45 days. Contact Powerlink Licensing  
within 45 days to permanently authorize the update enabler. More information is 
available in the NetWorker licensing guide.

Note: If the required update enabler expires or the auth code is not applied, the NetWorker 
software will not function at the new release level.

With a first-time purchase of NetWorker software, a one-year update agreement may 
be included. After a year, an update enabler may be acquired with a new update 
agreement purchase.

Alert Message
An alert message is generated 45 days before a NetWorker update enabler code is 
about to expire. This alert remains until the NetWorker license is authorized or 
deleted.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide46



Update from a Previous Release
Update the NetWorker software on Microsoft Windows
To upgrade the operating system on a NetWorker server, storage node, or client host 
(for example, to update from Windows 2000 to Windows XP), first upgrade 
Windows, then update the NetWorker software.

When you update from a previous release, the NetWorker software is automatically 
installed in the same location.

The following options are not supported during an upgrade:

◆ Change the installation type (for example, from client to server)

◆ Edit the list of NetWorker servers that are allowed to access the computer

◆ Install NetWorker License Manager

However, details of changes that can be made after the update is available in 
“Maintain a NetWorker software installation” on page 52.

Note: When updating the NetWorker software, to install ConnectEMC, it is recommended that 
ConnectEMC is installed on the NetWorker client. Also, it is recommended that the previous 
version of the NetWorker client is uninstalled, and that the tmp directory is deleted. More 
information is provided in the best practices for installing ConnectEMC, in Step 9 of “Task 1: 
Install the NetWorker software” on page 140.
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Windows update roadmap

Table 18 on page 48 provides a roadmap to follow for updating the NetWorker 
software on Windows.

Update the NetWorker software on Windows
To update the NetWorker software to release 7.6 and later:

1. Before updating, make notes of the current database location and port numbers 
used before removing the current installation.

2. Verify that the target computer satisfies the requirements. “Microsoft Windows 
requirements” on page 16 provides details.

3. Log in with administrator privileges to the target computer.

4. Access the installation files. “Accessing the software” on page 39 provides details.

5. Double-click the setup.exe file. Skip this step if Autorun started the installation 
automatically. The Setup program detects the existing installation and displays 
the Welcome to NetWorker Update dialog box.

6. In the Welcome to NetWorker Update dialog box, click Next. A warning message 
appears, indicating that the NetWorker Management Console (NMC) is currently 
installed.

7. Click OK, then click Next to continue uninstalling NMC.

Table 18 Update roadmap for NetWorker on Windows

For this type of NetWorker host Refer to these section

NetWorker server To update the NetWorker server on Windows:
• “Update from a different bit version of NetWorker (32-bit, 64-bit)” 

on page 51. Complete this section only if you are updating from a 
different bit version of NetWorker.

• “Update the NetWorker software on Windows” on page 48
• “Update from 7.4 or 7.5 to 7.6 and later for VCB backups” on 

page 56. Complete this section only if you have NetWorker clients 
that are virtual machines configured for a VCB proxy server.

• “Maintain a NetWorker software installation” on page 52

NetWorker Management Console To update the NetWorker Management Console on Windows, 
complete the following sections in order:
• “Update from a different bit version of NetWorker (32-bit, 64-bit)” 

on page 51. Complete this section only if you are updating from a 
different bit version of NetWorker.

• “Update the NetWorker software on Windows” on page 48
• “Java Web Start jnlp file caching issue after updating the 

NetWorker Management Console” on page 51
• “Maintain a NetWorker software installation” on page 52

NetWorker client or storage node To update a NetWorker client or storage node on Windows, complete 
the following sections in order:
• “Update from a different bit version of NetWorker (32-bit, 64-bit)” 

on page 51. Complete this section only if you are updating from a 
different bit version of NetWorker.

• “Update the NetWorker software on Windows” on page 48 or 
“Update clients by using the software distribution feature” on 
page 57.

• “Maintain a NetWorker software installation” on page 52
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Note: The latest version of NMC will be installed after NetWorker has been updated.

8. In the Ready to Update dialog box, click Update.

Note: If the setup wizard requests that Internet Explorer (IE) windows be closed in order to 
continue the installation, close the IE window, then click Retry to continue the installation.

9. In the NetWorker Server Selection page, select the NetWorker servers that can 
perform backups and directed recoveries for this client: 

• To add a NetWorker server that is not listed in the Available Servers list, type 
the name of the server in the Enter a server name text box and click Add. 

• To browse for available NetWorker servers, click Update List. You can select a 
NetWorker server from the Available Servers list.

• To add or remove NetWorker servers from the Available Servers list to the 
Selected Servers list, use the arrow buttons.

Note: If the Selected Servers list remains empty, any NetWorker server can perform 
backups and directed recoveries of this computer’s data. This might affect the security of 
your data.

10. Click Finish when the update is complete. If NMC is being upgraded as well, the 
Welcome to NetWorker Management Console Installation page displays. 
Perform Step 11 through Step 17 if upgrading NMC. Otherwise, skip to Step 18.

11. In the Welcome to NetWorker Management Console Installation page, click 
Next.

12. In the Customer Information page, enter the customer information and click 
Next.

13. In the Product Setup page, click Next.

14. In the Configuration Ports page, customize the ports if necessary, then click Next.

Note: Do not change the Database Destination Folder.

15. In the Customer Database Maintenance page, select Keep database to use the 
existing database. Otherwise, select Overwrite the existing NMC database. Click 
Next.

16. When the NMC installation is complete, click Finish. The NetWorker setup page 
appears again.

17. When prompted to run the NetWorker Change Journal Manager, select this 
option if required, then click Finish.

Note: If you are updating the software on a computer running Windows XP Professional, 
Windows 2000 or 2003, at the end of the setup process there is a prompt to run the Change 
Journal Manager. The NetWorker administration guide provides information about 
configuring NetWorker software to use the Windows Change Journal.

18. In the Production Configuration Summary page, review the configuration to be 
installed, then click Next.

19. In the Ready to Install the Program page, click Install.
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20. When the installation is complete, you have the option to open the NMC client in 
a browser. Select this option if desired, then click Finish. 

Note: A NetWorker 7.5.x Console server configured to use LDAP for authentication can 
cause the NMC to fail to start after the update to NetWorker 7.6 and later. If this occurs, this 
message is written to the gstd.raw file in the Console logs directory: 
"acm: External directory library initialization failed".

21. If the NMC fails to start after the update to NetWorker 7.6 and later, reset the 
Console authentication configuration and reconfigure LDAP by performing the 
following steps:

a. Stop all gstd services.

b. Go to NMC install directory/cst.

c. Delete the files Config.xml, cst.clb, cst.clb.bak and upgrade_cst.tag, if 
present.

d. Copy Config.xml.template to Config.xml.

e. Start the Console.

The Console starts in native authentication mode.

f. Log into the Console as administrator with the password last set for 
administrator before switching to LDAP mode.

g. In Setup > Configure Login Authentication, configure LDAP again.

22. Enable and register the NetWorker software. More information is available in the 
NetWorker licensing guide.

“Update from 7.4 or 7.5 to 7.6 and later for VCB backups” on page 56 provides 
instructions on updating the NetWorker server for VCB backups. 

Downgrade the Console to NetWorker release 7.4.x
If, after upgrading to NMC for NetWorker 7.6 and later, it is required to downgrade 
to the previous version of NMC, perform the following:

1. Re-install the previous version of NMC for NetWorker release 7.4.x and select the 
new database when prompted.

2. After installing, run recoverpsm to recover the last backed up version of the NMC 
for NetWorker release 7.4.x database.

Note: In order to retrieve the previous database upon downgrading to NMC for NetWorker 
release 7.4.x, the NMC database must have been backed up before the upgrade to NMC for 
NetWorker release 7.6 and later.
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Java Web Start jnlp file caching issue after updating the NetWorker Management Console

After the NetWorker Management Console (NMC) is updated or a client locale is 
changed, the gconsole.jnlp file will be different than the original gconsole.jnlp file in 
the Java Web Start cache. NMC will fail to launch.

Workaround
Remove the NetWorker Management Console Application and Language Pack 
from the Java Application Cache Viewer:

1. Open a command line to find and launch the javaws.exe application. The default 
location C:\Program Files\Java\jre1.6.0_06\bin\javaws.exe -viewer can be used 
to run javaws.exe based on the JRE version installed, for Java 1.6.x.

2. Run the Java Application Cache Viewer.

3. Select NetWorker Management Console Application and Language Pack.

4. Click Remove Selected Application.

Update NetWorker Modules from a previous release

After updating to NetWorker release 7.6 and later from a release 6.x, NetWorker 
Modules must be reinstalled. Additionally, it is possible that minor changes must be 
made to the Users attribute of the User Group resource (within the Users group) to 
ensure successful backups.

Note: If updating to NetWorker release 7.6 and later from release 7.x, NetWorker Modules do 
not need to be reinstalled.

The NetWorker Module documentation provides more information.

Update from a different bit version of NetWorker (32-bit, 64-bit)
The following procedure is required only if updating from a 32-bit installation of 
NetWorker software to a 64-bit version.

To update the NetWorker software:

1. Use the NetWorker software to back up the client file index and the media 
database. The NetWorker administration guide provides instructions.

2. Ensure that all NetWorker scheduled backups have been stopped before starting 
the upgrades.

3. Uninstall the NetWorker software. “Uninstall the NetWorker software” on 
page 148 provides instructions.

4. Delete the existing client file index and the media database.

5. Install the new version NetWorker software. “Install the NetWorker software” on 
page 140 provides instructions.

6. Perform a bootstrap recovery of the saved NetWorker client file index and the 
media database. The NetWorker administration guide provides instructions.
Update the NetWorker software on Microsoft Windows 51



Update from a Previous Release
Maintain a NetWorker software installation

After NetWorker software is installed, you can run the Setup program to perform the 
following maintenance tasks:

◆ Change the setup language type for the NetWorker installation. 

◆ Change the installation type (for example, from client to server), edit the servers 
list, add the NetWorker License Manager, add or remove the NetWorker Console 
software.

◆ Replace missing or corrupted program files.

◆ Remove the NetWorker software from the computer.
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Update the NetWorker software on UNIX
To update the operating system on a NetWorker server, storage node, or client host, 
first upgrade the operating system, then update the NetWorker software.

When updating from a previous release, the NetWorker software is automatically 
installed in the same location. 

The following options are not supported during a NetWorker software update:

◆ Change the installation type (for example, from client to server)

◆ Edit the list of NetWorker servers that are allowed to access the computer

◆ Install NetWorker License Manager

However, details of changes that can be made after the update is available in 
“Maintain a NetWorker software installation” on page 52.

UNIX Update roadmap
Table 19 on page 53 provides a roadmap to follow for updating the NetWorker 
software on UNIX.

Table 19 Update roadmap for NetWorker on UNIX 

For this type of NetWorker host Refer to these section

NetWorker server To update the NetWorker server on UNIX:
• “Update from a different bit version of NetWorker (32-bit, 64-bit)” 

on page 51. Complete this section only if you are updating from a 
different bit version of NetWorker.

• “Update the NetWorker software on UNIX” on page 54
• “Update from 7.4 or 7.5 to 7.6 and later for VCB backups” on 

page 56. Complete this section only if you have NetWorker clients 
that are virtual machines configured for a VCB proxy server.

• “Maintain a NetWorker software installation” on page 52

NetWorker Management Console To update the NetWorker Management Console on UNIX, complete 
the following sections in order:
• “Update from a different bit version of NetWorker (32-bit, 64-bit)” 

on page 51. Complete this section only if you are updating from a 
different bit version of NetWorker.

• “Update the NetWorker software on UNIX” on page 54
• “Java Web Start jnlp file caching issue after updating the 

NetWorker Management Console” on page 51
• “Maintain a NetWorker software installation” on page 52

NetWorker client or storage node To update a NetWorker client or storage node on UNIX, complete the 
following sections in order:
• “Update from a different bit version of NetWorker (32-bit, 64-bit)” 

on page 51. Complete this section only if you are updating from a 
different bit version of NetWorker.

• “Update the NetWorker software on UNIX” on page 54 or “Update 
clients by using the software distribution feature” on page 57.

• “Maintain a NetWorker software installation” on page 52
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Update the NetWorker software on UNIX

To update the NetWorker software, perform these tasks:

◆ “Task 1: Prepare to update the NetWorker software to release 7.6 and later” on 
page 54

◆ “Task 2: Update the software on the NetWorker client, storage node, and server” 
on page 54

Task 1: Prepare to update the NetWorker software to release 7.6 and later
To update the NetWorker software to release 7.6 and later:

1. Before updating, make notes of the current database location and port numbers 
used before removing the current installation.

2. Verify that the target computer satisfies the requirements. “UNIX requirements” 
on page 16 provides details.

3. Make a copy of the current database and store it in a safe location.

4. Back up all client file indexes and generate a bootstrap for the server. If a current 
bootstrap does not exist, or a backup of all client file indexes, perform scheduled 
backups on all clients before updating the software. For example, to save the 
bootstrap information, type this command: 

savegrp -O group

Note: Ensure that all clients are included in the groups to be backed up.

5. Record the latest bootstrap save set ID and its associated volume label. To obtain 
this information, type this command:

mminfo -B

6. If the NetWorker software is not currently installed in the default location, record 
the location of the client file indexes.

Note: A NetWorker storage node release 7.4 or later is not compatible with a NetWorker release 
7.3 or earlier server. Update the NetWorker servers to at least version 7.4 before updating a 
storage node.

Task 2: Update the software on the NetWorker client, storage node, and server
To update the software on the NetWorker client, storage node, and server:

1. Keep a copy of the current configuration.

2. Ensure that all NetWorker  scheduled backups have been stopped before starting 
the upgrades.

3. Type the following command to shut down the NetWorker software:

nsr_shutdown

4. Uninstall the current NetWorker and NetWorker Management Console (NMC) 
software packages.

5. Verify that no NMC processes (gstd, gsttclsh, dbsrv9) are still running.

Note: If performing a re-install of NetWorker release 7.6 and later, the processes are gstd, 
dbsrv9, and httpd.
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide54



Update from a Previous Release
6. Install the new release of the NetWorker software. 

Note: Do not start the NetWorker daemons. If client computers have a previous release of 
the NetWorker Client for Linux installed, update those clients to the latest NetWorker 
release to fully exercise all the features in the software. When the installation identifies an 
existing NetWorker client package for Linux, it prompts for permission to update the 
client. The update process removes the existing NetWorker client and man pages and 
installs the new version of the NetWorker client software.

7. Apply any required NetWorker software patches.

8. Restart the software by running the NetWorker startup script, 
/etc/init.d/networker start.

9. At the command prompt, type this command:

nsrck –L 2

10. License the NetWorker software. More information is available in the NetWorker 
licensing guide.

“Update from 7.4 or 7.5 to 7.6 and later for VCB backups” on page 56 provides 
instructions on updating the NetWorker server for VCB backups. 
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Update from 7.4 or 7.5 to 7.6 and later for VCB backups
After updating from NetWorker Release 7.4.x or 7.5.x to NetWorker Release 7.6 and 
later, to prevent existing VCB related backups from using the NetWorker Integration 
module, run the following command on the NetWorker server:

nsrvcbserv_tool –p VCB proxy hostname or IP address

By default, the nsrvcbserv_tool is located c:\program files\legato\nsr\bin.

Updating to NetWorker Version 7.6 or later, enables the use of all new VCB features.

Note: The Proxy Host client must be configured with Administrator privileges for the 
operating system. Specify a user name and password for an account with Administrator rights 
on the Proxy server in the Remote User and Password fields in the Client resource. 

The nsrvcbserv_tool does the following:

◆ Identifies the NetWorker clients that are virtual machines configured for the 
specified VCB Proxy server.

◆ Executes the nsrvcbclnt_tool on the NetWorker client configured as the VCB 
Proxy server. 

◆ Reads the configuration file (config.js) and sends the information to the 
NetWorker server.

◆ Updates the Application Information attribute of the NetWorker Client resource 
acting as the VCB Proxy server with the information from the config.js file. 

◆ Sets the backup command attribute in the NetWorker Client resource of all virtual 
machines configured for the specified VCB Proxy server to nsrvcb_save.

◆ Creates the Virtual Center or ESX Hypervisor resource, if not already available in 
the RAP database of the NetWorker server.

Note: The nsrvcbserv_tool and nsrvcbclnt_tool, supported on Windows only are only 
supported when the NetWorker server and VCB Proxy host are NetWorker Release 7.6 and 
later.

These sections provide instructions on updating the NetWorker software:

◆ “Update the NetWorker software on Microsoft Windows” on page 47

◆ “Update the NetWorker software on UNIX” on page 53
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide56



Update from a Previous Release
Update clients by using the software distribution feature
Use the software distribution feature to remotely distribute and update the 
NetWorker software from a centralized NetWorker server to one or more NetWorker 
clients.

The following NetWorker software packages can be updated on computers that have 
the NetWorker version 7.3 or later client software already installed:

◆ Client

◆ Storage node

◆ Man pages

◆ NMO, NMSQL and NMExch NetWorker Modules

Note: The software distribution feature is not supported on HP Tru64 UNIX, IRIX, Mac OS X, 
NetWare, Open VMS platforms, and cluster environments.

The software distribution feature can be used to:

◆ Manage the software repository.

◆ Inventory NetWorker software installed on NetWorker clients.

◆ Update NetWorker software packages on existing NetWorker clients.

◆ Monitor software distribution inventory and upgrade operations (only available 
from the Software Administration Wizard).

Software distribution can be performed on the NetWorker client software by using 
either the Software Administration Wizard or the nsrpush command. These sections 
provide instructions on how to perform these operations.

Software requirements
The following software and administrative privileges are required:

◆ NetWorker server release 7.4 or later software is installed on the NetWorker 
server.

◆ NetWorker client package release 7.4 or later software has been installed on the 
NetWorker client computer involved in the update operation.

◆ Administrative privileges on the NetWorker Console server.

◆ Administrator privileges on the NetWorker server or Software Administration 
server.

◆ Write permissions for the Administrator and SYSTEM users to the temp folders 
defined in the SYSTEM user TEMP and TMP environment variables.

Note: Enabling write permissions is only a requirement on a Windows 2008 client. Write 
permissions must be enabled when performing software updates, add to repository 
operations, and inventory operations using the Software Administration Wizard or the 
nsrpush command.
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Supported server operating systems
The software distribution feature is supported on the following server operating 
systems:

◆ Windows (x86, x64 and Itanium 64-bit)

◆ AIX (32-bit and 64-bit)

◆ Linux (x86 and x64)

◆ Solaris (64-bit)

◆ HP UX (64-bit and Itanium 64-bit)

Note: The software distribution feature is not supported on the Linux Itanium 64-bit, Solaris 
AMD64, HP Tru64 and SGI IRIX server platforms.

Supported client operating systems
Upgrade operations using the software distribution feature are supported on the 
following client operating systems:

◆ Windows (x86, x64 and Itanium 64-bit)

◆ AIX (32-bit and 64-bit)

◆ Linux (x86 and x64)

◆ Solaris (64-bit)

◆ HP-UX (64-bit and Itanium 64-bit)

Note: Upgrading using the software distribution feature is not supported on the Linux Itanium 
64-bit, Linux PPC, Solaris AMD64, Solaris x86, HP Tru64, SGI IRIX, Mac OS-X, NetWare, and 
OpenVMS client platforms. Upgrading of PowerSnap clients and Cluster clients is not 
supported.

Repository operations using the Software Administration Wizard

To start the Software Administration Wizard:

1. Start the NetWorker Management Console software.

2. Launch the Administration window and click Configuration.

3. From the Configuration menu, select Software Administration Wizard.The 
Software Administration Wizard launches.

4. Follow the prompts to manage the software repository (add or remove install 
packages), inventory, update, or monitor NetWorker client update operations.

Manage the software repository
The software repository is a centralized database that contains the NetWorker 
software packages that can be pushed to NetWorker clients from the NetWorker 
server. NetWorker software packages can be added to, or removed from the software 
repository.

When you add products to the repository, the product can be added in one of the 
following ways:

◆ On the same platform as the server (for example, a Windows product to a 
Windows server, or a UNIX product to a UNIX server)

◆ As a cross-platform product (for example, a UNIX product to a Windows server)
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Add the same operating system products to the repository 
To add products to the repository that are on the same platform as the server:

1. Prepare the source of the product:

• If using a software distribution disk, insert the disk. If using UNIX, it may also 
be necessary to mount the disk.

• If using a downloaded installation package, unzip the package (gunzip for 
UNIX). If using UNIX, also untar it.

2. Launch the Software Administration Wizard and click Next to navigate to the 
Software Repository Operations page.

3. Select Add or remove products from my software repository, then click Next.

Note: When products are added to the repository for the first time, you must confirm the 
default repository location (for example, <NetWorker Install Dir>/repository, where 
<NetWorker Install Dir> is the directory location of the installed software), or specify 
another location for the repository.
Also, when you specify a repository location, ensure that this location has enough 
available space to hold all of the products that will be in the repository at any time.

4. Navigate through the Wizard to select the platform type and enter the path or 
directory location on the server of the product source (the source that contains the 
installation files and the metafile for the product).

Note: The product source could also be a directory containing multiple subdirectories with 
products and metafiles.

5. Select the products to be added to the repository, then click Next.

Add cross-platform products to the repository 
To add cross-platform products to the repository (for example, a UNIX product to a 
Windows server):

1. Prepare the source of the product:

• If using a software distribution disk, insert the disk. If using UNIX, it may also 
be necessary to mount the disk.

• If using a downloaded installation package:

a. Copy the installation package to the NetWorker server (the server where 
the products will be added to the repository) and to the client where the 
product will be added from.

b. Extract the contents of the package to local directories on both the server 
and the client (on UNIX, gunzip, then untar to separate subdirectories).

2. Launch the Software Administration Wizard and click Next to navigate to the 
Software Repository Operations page.

3. Select Add or remove products from my software repository, then click Next.

Note: All UNIX or Windows packages can be added to the server's repository from only 
one UNIX or Windows client with the NetWorker client installed. Different operating 
system packages need to be added only once to be ready to use for all clients with the 
corresponding platforms.
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4. Navigate through the Wizard to select the platform type and enter the path or 
directory location on the server of the product source (the source that contains the 
installation files and the metafiles for the products).

Note: The product source could also be a directory containing multiple subdirectories with 
products and metafiles.

5. Select the products to be added to the repository and click Next. The last page of 
the Wizard prompts you for the cross-platform client host name and client Media 
Kit Location (the location of the installation files).

6. If using a CD or DVD as the source, move the software distribution disk to the 
client machine, and mount the disk if necessary. Once the local machine is 
scanned for metafiles, the disk must be on the client to add the product to the 
repository.

7. Specify the client host name and the location of the media kit on the client, then 
click Next.

IMPORTANT!
Ensure the cross-platform path entered here is at the same level of the directory 
structure that you specified for the path of the product source on the server. For 
example, if the product source containing the metafiles is located at 
/tmp/prod/nw761_solaris64 on UNIX, and at C:\temp\prod\nw761_solaris64 
on Windows, enter these paths when prompted.
If the product source is a directory containing multiple products (and their 
metafiles) in subdirectories, specify the directory path for the Media Kit 
Location, not the subdirectory path. For example, if using a product 
distribution disk mounted to /cdrom0 on UNIX and D:\ on Windows, and the 
disk contains subdirectories for solaris_64 and win_ia64, type /cdrom0 or D:\ 
when prompted for the media kit location, then choose one or more products to 
add, based on the subdirectories found in the media kit location. Then, type 
the hostname of the client where the product files need to be added, and the 
pathname (for example, /cdrom0) for the media kit location on the 
cross-platform client. Do not specify the path name with the subdirectory (for 
example, D:\solaris_64), or an error will occur.

Inventory clients for currently installed products
Before upgrading NetWorker clients using the Software Distribution feature, it is 
necessary to inventory the clients to determine their currently installed NetWorker 
software. 

To inventory the clients:

1. Launch the Software Administration Wizard and click Next to navigate to the 
Software Repository Operations page.

2. Select Discover the currently installed software products on my NetWorker 
clients, then click Next. A list of the clients configured on the NetWorker server 
appears.

3. Select some or all of the clients (use the Ctrl or Shift key when selecting multiple 
clients), then click Next.

4. Select Yes and click Next to monitor the inventory operation, or select No to 
return to the main window of the Software Administration Wizard.
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Update client software packages
Update NetWorker software packages on NetWorker clients for one client, or for 
many NetWorker clients at the same time. 

The Software Administration Wizard provides two ways to perform client updates:

◆ By client

◆ By product and version

Update by client
To update the client software packages by client:

1. Ensure that all NetWorker scheduled backups have been stopped before starting 
any upgrades. 

2. Inventory the clients to be updated (refer to the section “Inventory clients for 
currently installed products” on page 60).

3. Launch the Software Administration Wizard and click Next to navigate to the 
Software Repository Operations page.

4. Select Upgrade the software on my NetWorker clients and click Next. 

5. Select the option By Client, will upgrade on the clients that you choose and click 
Next. A list of available clients appears.

6. Select the appropriate clients (use the Ctrl or Shift key to make multiple 
selections), then click Next. A list of clients and products appears, showing one 
client/product per line.

7. Select one or more of the client/product combinations to upgrade, and click Next. 
The Monitor Activity window appears.

Update by product and version
To update the client software packages by product and version:

1. Ensure that all NetWorker scheduled backups have been stopped before starting 
any upgrades. 

2. Inventory the clients to be updated (refer to the section “Inventory clients for 
currently installed products” on page 60).

3. Launch the Software Administration Wizard and click Next to navigate to the 
Software Repository Operations page.

4. Select Upgrade the software on my NetWorker clients and click Next. 

5. Select the option By Product and Version, will upgrade all clients to a new 
software version and click Next.

6. Select one or more products to update clients to (use the Ctrl or Shift key to make 
multiple selections), then click Next. A list of clients and products appears, 
showing one client/product per line.

7. Select one or more of the client/product combinations to update, then click Next. 
The Monitor Activity window appears.
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Monitor the inventory and update activity of the software
You can monitor the progress of the NetWorker client operations and restart those 
that have failed from the Console server. The Monitor Activity window 
automatically appears after starting update operations from the Software 
Administration Wizard, and can be shown after initiating an inventory operation. 
The monitor operation can also be started manually at any time.

To monitor the NetWorker inventory and update activity:

1. Launch the Software Administration Wizard and click Next to navigate to the 
Software Repository Operations page.

2. Select the option Monitor current upgrade and inventory activities.   The 
Monitor Activity window appears.

Repository operations with the nsrpush command

Repository operations can also be performed by using the nsrpush command from 
the command line.

Manage the software repository
To view the products available on provided media kits (for example, on software 
distribution disks or downloaded installation packages):

◆ For UNIX products, run: 

nsrpush -L -U -m <media kit location>

◆ For Windows products, run:

nsrpush -L -W -m <media kit location>

Add same platform products to the repository
To add same platforms products to the repository, run the following commands:

◆ On UNIX:

nsrpush -a -p <Product Name> -v <versions> -P <platform> -U -m <media 
kit location>

◆ On Windows:

nsrpush -a -p <Product Name> -v <versions> -P <platform> -U -m <media 
kit location>

Note: You can only add one product at a time to the repository using this method.

Add cross-platform products to the repository
To add cross-platform products to the repository:

◆ On UNIX, run the following:

nsrpush -a -p <Product Name> -v <versions> -P <platform> -U -m <media 
kit location> -c <cross-platform client> -C <cross-platform media 
kit location>

For example, to add a 64-bit Solaris product to a UNIX server with the media kit 
located in /tmp/prod, and at D:\\temp\downloads on the cross-platform client 
named "unixhost", run:

nsrpush -a -p NetWorker -v 7.6.1 -P solaris_64 -U -m /tmp/prod -c 
"unixhost" -C "D:\\temp\downloads"
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◆ On Windows, run the following:

nsrpush -a -p <Product Name> -v <versions> -P <platform> -U -m <media 
kit location> -c <cross-platform client> -C <cross-platform media 
kit location>

For example, to add a 64-bit Solaris product to a Windows server with the media 
kit located at D:\temp\downloads on the server, and at /tmp/prod on the 
cross-platform client named "solaris_host":

nsrpush -a -p NetWorker -v 7.6.1 -P solaris_64 -U -m 
"D:\temp\downloads" -c "solaris_host" -C /tmp/prod

More details on the nsrpush command are provided on the nsrpush man page, or 
from nsrpush usage (running nsrpush with no options).

Inventory currently installed products
To inventory clients using the nsrpush command:

1. Type the following command from the command line to view the list of clients to 
be inventoried:

nsrpush -i <client list>

where <client list> is a list of clients to be inventoried, separated by spaces.

2. Type the following command from the command line to inventory all configured 
clients:

nsrpush -i -all 

Update client software packages
You can update NetWorker software packages on existing NetWorker clients for one 
client, or for many clients, by using the nsrpush command. 

To update the client software packages:

1. Ensure that all NetWorker scheduled backups have been stopped before starting 
any upgrades.

2. Ensure that the clients to be upgraded have been inventoried.

3. Initiate the update by using the nsrpush command:

• To update all clients:

nsrpush -u -p <Product> -v <version> -all

• To update selected clients:

nsrpush -u -p <Product> -v <version> <Client list>

Note: When using the nsrpush command, multiple clients on different platform types can be 
updated at the same time if the product and version are the same. For example, if you wanted 
to update two clients to the same version of a product (NetWorker release 7.6 and later), type 
nsrpush –u –p NetWorker –v 7.6.1 clientname1 clientname2. However, to update clients for 
different versions, only one product at a time can be updated.

More details on the nsrpush command are provided on the nsrpush man page, or 
from nsrpush usage (running nsrpush with no options).
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Install the NetWorker software
Complete these tasks to install the NetWorker software:

◆ “Task 1: Prepare to install the NetWorker software” on page 66

◆ “Task 2: Install the client, storage node, and server software” on page 66

◆ “Task 3: Change the NetWorker servers with access to a client” on page 69

◆ “Task 4: Start the NetWorker daemons” on page 70

◆ “Task 5: Install the Console server” on page 70

Task 1: Prepare to install the NetWorker software
If you plan to install the NetWorker Server, make and retain a copy of the current 
configuration. The NetWorker installation process modifies several of the 
configuration files.

1. Run this command for each of the files that get modified:

cp <filename> <filename>.old>

where <filename> is one of these files: 

• /etc/inittab

• /etc/rc.nsr

• /etc/rpc

• /etc/syslog.conf

If required, change the default location for NetWorker configuration files. To put 
these files somewhere other than the default location, which is /nsr, create 
another nsr directory. For example:

mkdir /disk2/nsr
ln -s /disk2/nsr /nsr

2. Ensure that there is enough space in the /usr/bin file system for the NetWorker 
binaries. 

If more space is required and you have enough unallocated disk space, the AIX 
installp utility allocates more space to the /usr/bin file system so that the 
installation completes successfully. Table 8 on page 28 provides information 
about the space required for NetWorker binaries.

IMPORTANT!
The AIX installp utility does not enable you to change the default installation 
location of packages. NetWorker binaries are installed to the /usr/bin file system. 

Task 2: Install the client, storage node, and server software

This section describes how to install the software for the NetWorker client, storage 
node, and server.

Note: The NetWorker software is shipped in a 32-bit version. This 32-bit version can be 
installed on both the 32-bit and the 64-bit version of the AIX operating system. You might need 
to install the UTF-8 converters available with your operating system. 
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Client installation
To install the NetWorker software on a client computer:

1. Type this command to begin the NetWorker software installation:

smitty install_latest

2. Type the location of the NetWorker installation software in the Entry Field.

3. Select the option, SOFTWARE to install.

4. When installing the Java5.sdk package for the first time, two license prompts 
appear.

• Type yes in response to the following prompt:

Accept new license agreements?

• Type no in response to the following prompt:

Preview new license agreements?

5. Select Esc+F4=List to display the list of NetWorker software packages. 

The following NetWorker installation packages appear: 

• LGTOnw.clnt.rte (client software package)

• LGTOnw.node.rte (storage node software package)

• LGTOnw.serv.rte (server software package)

• LGTOnw.man.rte (optional man pages)

• LGTOnw.licm.rte (optional NetWorker License Manager software package)

• LGTOnw.fr.rte (optional French language support package)

• LGTOnw.ja.rte (optional Japanese language support package)

• LGTOnw.ko.rte (optional Korean language support package)

• LGTOnw.zh.rte (optional Simplified Chinese language support package)

6. Select LGTOnw.clnt.rte to install the NetWorker client software.

7. If required, install one of the following language support packages:

• LGTOnw.fr.rte

• LGTOnw.ja.rte

• LGTOnw.ko.rte 

• LGTOnw.zh.rte

8. If required, select LGTOnw.man.rte to install the optional NetWorker man pages.

9. Press Enter to begin the installation.

Storage node installation
To install the NetWorker software on a storage node: 

1. Type this command to begin the NetWorker software installation:

smitty install_latest

2. Type the location of the NetWorker installation software in the [Entry Field].

3. Select the option, SOFTWARE to install.

4. When installing the Java5.sdk package for the first time, two license prompts 
appear.
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Type yes in response to this prompt:

Accept new license agreements?

Type no in response to the following prompt:

Preview new license agreements?

5. Select Esc+F4=List to display the list of NetWorker software packages. 

The following NetWorker installation packages appear: 

• LGTOnw.clnt.rte (client software package)

• LGTOnw.node.rte (storage node software package)

• LGTOnw.serv.rte (server software package)

• LGTOnw.man.rte (optional man pages)

• LGTOnw.licm.rte (optional NetWorker License Manager software package)

• LGTOnw.fr.rte (optional French language support package)

• LGTOnw.ja.rte (optional Japanese language support package)

• LGTOnw.ko.rte (optional Korean language support package)

• LGTOnw.zh.rte (optional Simplified Chinese language support package)

6. Select these packages to install the NetWorker client software.

• LGTOnw.clnt.rte 

• LGTOnw.node.rte 

7. Select Install and Update Software.

8. If required, install one of the following language support packages:

• LGTOnw.fr.rte

• LGTOnw.ja.rte

• LGTOnw.ko.rte 

• LGTOnw.zh.rte

9. If required, select LGTOnw.man.rte to install the optional NetWorker man pages.

10. Press Enter to begin the installation.

Server installation
To install the NetWorker software on the computer that is designated as the 
NetWorker server:

1. Type this command to begin the NetWorker software installation:

smitty install_latest

2. Type the location of the NetWorker installation software in the [Entry Field].

3. Select the option, SOFTWARE to install.

4. When installing the Java5.sdk package for the first time, two license prompts 
appear.

Type yes in response to the following prompt:

Accept new license agreements?

Type no in response to this prompt:

Preview new license agreements?
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5. Select Esc+F4=List to display the list of NetWorker software packages. 

The following NetWorker installation packages appear: 

• LGTOnw.clnt.rte (client software package)

• LGTOnw.node.rte (storage node software package)

• LGTOnw.serv.rte (server software package)

• LGTOnw.man.rte (optional man pages)

• LGTOnw.licm.rte (optional NetWorker License Manager software package)

• LGTOnw.fr.rte (optional French language support package)

• LGTOnw.ja.rte (optional Japanese language support package)

• LGTOnw.ko.rte (optional Korean language support package)

• LGTOnw.zh.rte (optional Simplified Chinese language support package)

6. Select these packages to install the NetWorker server software:

• LGTOnw.clnt.rte

• LGTOnw.node.rte

• LGTOnw.serv.rte

7. If required, install these optional NetWorker software packages:

• To install the NetWorker License Manager software, select LGTOnw.licm.rte

• To install the NetWorker man pages, select LGTOnw.man.rte

8. If required, install one of the following for language support:

• LGTOnw.fr.rte

• LGTOnw.ja.rte

• LGTOnw.ko.rte 

• LGTOnw.zh.rte

9. Press Enter to begin the installation.

Note: Install the Console server software on one computer in the datazone to manage and 
monitor the NetWorker server. Only one installation of the Console server is required to 
manage multiple NetWorker servers and to take full advantage of the Console’s consolidated 
reporting feature.

Task 3: Change the NetWorker servers with access to a client
To limit the servers authorized to access a client, specify a list of trusted NetWorker 
servers for a client in the /nsr/res/servers file. After installing the client, storage 
node, and server software, you must change the NetWorker servers that are 
authorized to access a client.

To change which NetWorker servers can access a client:

1. Shut down the NetWorker daemons:

nsr_shutdown

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that requires access to the client. The first entry in this file becomes the 
default NetWorker server.
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Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

3. If necessary, remove the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. Running nsrexecd with the -s option supersedes the 
/nsr/res/servers file:

a. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. The boot-time startup file for the AIX platform is 
/etc/rc.nsr. 

b. If the -s option exists in the boot-time startup file, remove all occurrences of 
this from the startup file:

-s server_name

Task 4: Start the NetWorker daemons

The NetWorker daemons must be started after the installation procedure. 

1. Start the NetWorker daemons: 

/etc/rc.nsr

2. Type this command at the system prompt:

ps -ef | grep nsr

Table 20 on page 70 lists the NetWorker daemons.

Note: The NetWorker nsrmmd daemon is present only if one or more devices are enabled. The 
nsrmmgd and nsrlcpd daemons are only present on the server if the library is enabled.

Task 5: Install the Console server
Install the Console server software on one computer in the datazone to manage and 
monitor the NetWorker server. Only one installation of the Console server is required 
to manage multiple NetWorker servers and to take full advantage of the Console’s 
consolidated reporting feature.

To manage the NetWorker server, install the Console and the NetWorker client 
software on one computer in the datazone. The Console server installation relies on 
the existence of several other components. Ensure that all installation prerequisites 
are met. The section “Console” on page 31 provides details. 

Table 20 NetWorker daemons

NetWorker packages NetWorker daemons

NetWorker server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, nsrjobd, nsrmmgd, nsrlcpd

NetWorker client nsrexecd

NetWorker storage node nsrexecd, nsrmmd, nsrlcpd

NetWorker license manager lgtolmd
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Before installing the Console server software, the following patches are required:

◆ On AIX version 5.3 TL6, if using the default user/group “nobody/nobody” or a 
User ID greater than 65534, install the patch IZ03262 in order to validate the web 
server user. The patch can be downloaded from the IBM website.

◆ On AIX version 5.2 for 32-bit, install the patch IY84915, available for download 
from the IBM website.

◆ On AIX version 5.3 for 32-bit, install the patch IY85958, available for download 
from the IBM website.

To install software on the computer that is designated as the Console server:

1. Ensure that JRE version 1.6 or later is installed. This enables the command line 
reporting feature. If the required JRE version is not installed, go to the Java 
website to download and install the version.

Note: Java WebStart is a caching mechanism for web deployed applications such as NMC. 
If cache is disabled in the Java options, WebStart will fail. To verify that Keep temporary 
files on my computer is enabled (default), in Control Panel > Java > General > Temporary 
Internet Files > Settings > Keep temporary files on my computer. Click the checkbox to 
enable temporary internet file caching if it is not checked.

2. If not already installed, install the NetWorker client software. “Client installation” 
on page 67 provides instructions.

3. To begin the NetWorker software installation, type:

smitty install_latest

4. Type the following in the Entry Field:

lgtonmc.rte

5. When installing the Java5.sdk package for the first time, two license prompts 
appear.

Type yes in response to this prompt:

Accept new license agreements?

Type no in response to this prompt:

Preview new license agreements?

6. If required, install one of the following language support packages:

• LGTOnw.fr.rte

• LGTOnw.ja.rte

• LGTOnw.ko.rte 

• LGTOnw.zh.rte

7. Press Enter to begin the installation. When the installation is complete, exit the 
SMIT program.

8. Type this command:

/opt/lgtonmc/bin/nmc_config.sh

The lgtonmc package is installed in the /opt/lgtonmc directory.

9. Specify a User/Group with limited privileges that NMC will use to run the web 
server. This must be a non-root user. For example, AIX operating systems have a 
default user/group [nobody/nobody] that can be used.
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Note: If the default group [nobody/nobody], a user/group with limited privileges does 
not exist, follow the Console server requirements described in “Console” on page 31.

10. For the web server port number, use the default port number (9000) or use a 
custom port number. Valid port numbers are between 1024 and 49151.

11. For the Console server, use the default port number (9001) or use a custom port 
number. Valid port numbers are between 1024 and 49151.

Note: Do not use port numbers that are already in use. Port 2638 is reserved by the Console 
server as it uses Tabular Data Stream (TDS) protocol to communicate with the database.

12. Specify the directory to use for the lgtonmc database (for example, 
/export/home/lgto_gstdb).

13. Specify the location of the NetWorker binaries (for example, /usr/sbin).

14. Start the Console daemon:

/etc/rc.gst start

The NetWorker Management Console daemon starts these processes:

• gstd

• dbsrv9

• httpd (2 or more processes)

• gstsnmptrapd (optional daemon) for managing integrated Data Domain 
backups.

15. If the Console server and the NetWorker server are installed on separate hosts, 
you must add the Console administrator to the administrator lists of the 
monitored NetWorker server. This enables the Console administrator to 
administer and monitor the target NetWorker server. 

On the NetWorker server:

a. Specify the process owner of the Console daemon process (gstd) depending on 
which host contains the Console server: 

– If on a Microsoft Windows host, type:
nsraddadmin -u "user=SYSTEM, host=console_host"

– If on a AIX, HP-UX, Linux or Solaris only host, type:
nsraddadmin -u "user=root, host=console_host"

b. Specify the Console administrator user:

nsraddadmin -u "user=administrator, host=console_host"

where console_host is the Console server hostname.

Note: The gstd process must be stopped when applying changes.
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IMPORTANT!
The NetWorker software must be able to resolve the loopback address, ::1, to 
localhost. This entry must exist in the system's respective /etc/hosts file for the 
localhost as follows:
::1 localhost loopback
The ::1 entry must remain in the /etc/hosts file, whether operating in an IPv4 or 
IPv6 configuration.

Launching Java Web Start if NMC GUI fails to start
When the NMC installation is complete and the NMC client GUI starts, a message 
indicates that Java is loading before the NMC console appears. If the NMC console 
does not open, Java Web Start may have failed to load, due to a corrupted Java Web 
Start cache or an incompatible version of Java Web Start. To resolve the issue, it is 
recommend to clean up the $HOME/.java cache location.

Perform the following commands to load Java Web Start:

1. Run setenv or export HOME if it is not set:

cd $HOME

2. Move or remove the $HOME/.java directory:

mv .java .java_orig

3. Navigate to JRE HOME and launch javaws. Reconfigure the Java Web Start 
preference if necessary. A new $HOME/.java will be created:

javaws [-viewer]

Note: Only JRE version 1.6 is supported.

4. If step 3 is successful, restart the web browser to launch the NMC client.

Task 6: Optional install the HomeBase Agent
The Homebase agent enables Bare Metal Recovery (BMR) for server system data. The 
NetWorker software supports version 6.2.x, and version 6.4 of the HomeBase Agent.

Note: HomeBase Agent 6.4 is supported for AIX 5.3. AIX 6.1 does not support HomeBase 
Agent 6.4.

To install the HomeBase Agent, download the HomeBase Agent installation package 
from Powerlink and follow the installation instructions provided in the HomeBase 
Agent Installation and Configuration Guide.

Note: The Homebase Agent client version that you use, requires that the equivalent Homebase 
Server version be installed in order for BMR to function in the NetWorker 7.6 and later 
environment. 

Information about installing and configuring the Homebase Agent 6.2.x, or 6.4 is 
available in the HomeBase Agent Installation and Configuration Guide. Information on 
BMR recovery is available in the HomeBase Recovery and Migration Guide.

The HomeBase Agent collects configuration information about the operating system 
platform of the host on which it is installed. This information is called a profile.
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A profile can be used to:

◆ Monitor configuration changes

◆ Migrate configuration changes

◆ Recover the operating system’s configuration from an EMC HomeBase Server

The profile data includes hardware configurations, operating system levels, system 
tuning, network configuration and connections, security, and storage layouts. This 
information is captured with a NetWorker save set backup and is sent to a secure 
HomeBase Server for storage and analysis. The HomeBase Server is also required to 
perform a BMR server recovery or migration.

The following documents provide information about the HomeBase Server features:

◆ EMC HomeBase Server Installation and Administration Guide

◆ EMC HomeBase Server User Guide

HomeBase Agent space requirements
Table 21 on page 74 specifies the location and space requirements for the HomeBase 
Agent.

Enable BMR server support
Connection with a HomeBase Server is enabled during the set up of the NetWorker 
server. This connection enables the delivery of profile data from the NetWorker client 
to the HomeBase Server.

To enable BMR support:

1. From the Administration window, click Configuration.

2. Select the NetWorker server name.

3. From the File menu, select Properties.

4. In the Properties dialog box, click the Configuration tab.

5. Type the IP address or hostname for the HomeBase Server in the BMR server 
field.

6. Click OK.

Note: The HomeBase Server SSL protocol must be configured and activated on the HomeBase 
Server. The EMC HomeBase Server Installation and Administration Guide provides information 
about enabling the SSL protocol.

Table 21 HomeBase Agent location and minimum system requirements

NetWorker files Location

Space Processor

x86 x64

EMC HomeBase Agent binary /opt/homebase-agent/ 512 MB 512 MB 1 GHz

Temporary space required for 
EMC HomeBase Agent

/tmp 512 MB 512 MB 1 GHz
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License the HomeBase Server and Agent
This section provides details for licensing the HomeBase Server, and HomeBase 
Agent software.

The EMC HomeBase Server Installation and Administration Guide, and the The EMC 
HomeBase Agent Installation and Configuration Guide provides complete details on 
licensing the HomeBase software.

HomeBase Server
The HomeBase 6.2.x server software comes with a 30 day evaluation enabler for the 
HomeBase Server with 20 HomeBase Agent licences. 

Note: Be sure to permanently enable the HomeBase Server and Agent licenses, as they expire 
after 30 days with no grace period.

During the installation of the HomeBase Server, a license request file is automatically 
generated in the keys directory. The license request is then forwarded to 
licensing@emc.com with all required purchase order details. Copies of the following 
are then sent:

◆ licence.zip file (the HomeBase Server licence)

◆ homebase.bks file (a set of encryption keys used for the recovery and replication 
of profiles between HomeBase Servers) 

◆ Agent licence batch files (there can be multiple agent licence batch files) that are 
associated with the HomeBase Server licence.

The default temporary enablers can be overridden by applying a permanent enabler 
and Agent licence batch to the HomeBase Server when the HomeBase Server Console 
is first accessed.

HomeBase Agent
When a HomeBase Agent is installed with the NetWorker software, the Agent license 
is provided automatically during the first profile run from the NetWorker software as 
it must be able to contact the HomeBase Server to forward profiles for backups. The 
-L setting in the NetWorker client BMR configuration setting is used to do this.

The EMC HomeBase Server Installation and Administration Guide provides details on 
how to license the HomeBase Agent for a Remote HomeBase Server.
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Uninstall the software
This section provides instructions to uninstall the NetWorker software.

Uninstall the NetWorker software
Use SMIT to uninstall individual NetWorker software packages or all of the 
NetWorker packages simultaneously. 

To uninstall the NetWorker software:

1. Log in as root on the computer where the software is being removed.

2. Type this command to shut down the NetWorker daemons:

nsr_shutdown

3. Type this command to remove the NetWorker software:

smitty remove

4. Select Esc+F4=List to display a list of NetWorker software packages.

5. Select the NetWorker software packages to remove. 

Table 22 on page 76 provides the list of commands.  

6. Press Enter to uninstall the NetWorker software.

7. Exit the SMIT program.

Table 22 Select NetWorker files to remove

To remove this NetWorker package Select these files for removal

Client software LGTOnw.clnt.rte

Storage Node software LGTOnw.node.rte

Server software LGTOnw.serv.rte

Console LGTO.nmc.rte

Man pages LGTOnw.man.rte

NetWorker License Manager LGTOnw.licm.rte

French language support LGTOnw.fr.rte 

Japanese language support LGTOnw.ja.rte 

Korean language support LGTOnw.ko.rte 

Simplified Chinese language support LGTOnw.zh.rte
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8. If there is no requirement to update or reinstall the NetWorker software:

a. Remove the /nsr directory.

b. Delete the NMC directory. By default, NMC is installed at /opt/lgtonmc.

c. Delete the directory containing the NMC database files lgto_gst.db, 
lgto_gst.log and gstd_db.conf.

9. If there is no longer a requirement for the Java Runtime Environment, uninstall 
the JRE.

Uninstall the HomeBase Agent

To uninstall the HomeBase Agent, use the HomeBase uninstall program. The 
HomeBase Agent Installation and Configuration Guide provides complete details on 
uninstalling the HomeBase Agent.
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Install the NetWorker software
Complete these tasks to install the NetWorker software:

◆ “Task 1: Prepare to install the NetWorker software” on page 80

◆ “Task 2: Install the client, storage node, and server software” on page 81

◆ “Task 3: Continue the installation” on page 83

◆ “Task 4: Install the required HP-UX patches” on page 83

◆ “Task 5: Change the NetWorker servers with access to the client” on page 84

◆ “Task 6: Start the NetWorker daemons” on page 85

◆ “Task 7: Install NetWorker Management Console software” on page 85

Task 1: Prepare to install the NetWorker software
Install the NetWorker software on HP-UX 11.x, or HP-UX 11i platforms on IPF by 
using the swinstall utility. The swinstall utility uses the terminal format or the 
System Administration Manager (SAM) utility. The terminal format swinstall 
screens contain the same types of information as the SAM utility. The same choices 
are made with both formats.

Note: There are different versions of the NetWorker software binaries for different versions of 
HP-UX:
- For HP-UX 11.x, install the binaries that are located in the hpux11_64 directory.
- For HP-UX 11i on IPF, install the binaries that are located in the hpux11_ia64 directory.

To install the NetWorker software:

1. Log in as root on the computer that the NetWorker software is to be installed.

2. Ensure that the latest HP-UX patches have been installed as described in “Install 
the required HP-UX patches for CDI support” on page 81.

3. Use the SAM utility to set the nfile parameter on HP-UX 11.x, 11i v1 and 11iv2, 
according to this formula: 

new_NFILE setting = current_NFILE setting + (y *55)

where y is the number of concurrent saves.

For example:

Minimum: 14
Maximum: Memory limited
Default: (16*(Nproc+16+MaxUsers)/10)+32+2*(Npty+Nstrpty)

Note: If a file table overflow error is reported, the HP-UX operating system has reached the 
configured limit for the nfile kernel parameter. Setting the nfile parameter is not 
applicable to HP-UX 11i v3.

Details on the nfile parameter are available in the nfile man page. 

4. To start the installation, type this command:

swinstall &

Note: With the character interface, omit the & symbol.
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5. Check the Source Host Name attribute to ensure that the correct hostname is 
selected. The correct hostname is the computer where the NetWorker software is 
to be installed.

6. Select the installation media:

• If installing from a CD-ROM, select local CD-ROM.

• If installing from a downloaded package, select local directory.

7. In the Source Depot Path attribute, type the appropriate path and package name.

• To install the NetWorker software from a CD-ROM, complete this step as 
follows:

– If on a HP-UX 11.x system, install the binaries from the hpux11_64 
directory. For example:
‘absolute path’/Networker.pkg

– If on a HP-UX 11i on IPF system, install the binaries from the hpux11_ia64 
directory. For example:
‘absolute path’/Networker.pkg

The absolute path represents the complete path of the CD-ROM and 
appropriate subdirectory.

• To install the NetWorker software from a local directory, complete this step as 
follows:

– If on a HP-UX 11.x system, install the binaries from the download directory. 
For example:
/var/spool/sw/nw761_hpux11_64.pkg

– If on a HP-UX 11i on IPF system, install the binaries from the download 
directory. For example: 
/var/spool/sw/nw761_hpux11_ia64.pkg

8. Click OK. 

9. In the Software Selection window, double-click  software. 

Task 2: Install the client, storage node, and server software
Review these sections:

◆ “Install the required HP-UX patches for CDI support” on page 81

◆ “Install all the NetWorker software with the language packages” on page 82

◆ “Install only the NetWorker software without the language packages” on page 82

◆ “Install only the NetWorker language packages without the software packages” 
on page 82

Install the required HP-UX patches for CDI support
To install the required package For CDI support, on HP-UX 11iv1, HP-UX 11iv2 and 
HP-UX 11iv3 servers and storage nodes, ensure that the PHKL_36312 package is 
installed:

swlist | grep PHKL_36312
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Install all the NetWorker software with the language packages
To install all the NetWorker software (client, storage node, and server) including all 
the language packages (French, Japanese, Korean, Simplified Chinese):

1. In the Software Selection window, select NetWorker 7.6.

2. From the Actions menu, select Install.

Install only the NetWorker software without the language packages
To install only the NetWorker software (client, storage node, and server):

1. In the Software Selection window, select NetWorker 7.6 and press Enter.

2. Mark the appropriate NetWorker software packages in Table 23 on page 82 for 
installation.

3. From the Actions menu, select Install.

Install only the NetWorker language packages without the software packages
To install only the language support packages: 

1. In the Software Selection window, mark NetWorker 7.6 and press Enter.

2. Mark the appropriate NetWorker language support package in Table 24 on 
page 82 for installation. For example, NWr-JA.

3. From the Actions menu, select Install.

Table 23 Selecting NetWorker files for installation

To install this NetWorker package Select these files Select these optional packages

Client software NWr-Client NWr-Man

Storage node software NWr-Client
NWr-Node

NWr-Man

Server software NWr-Client
NWr-Node
NWr-Server

NWr-Man
NWr-Lic

Table 24 Installing all the language packages

To install this NetWorker package Select these optional packages

French language support NWr-FR

Japanese language support NWr-JA 

Korean language support NWr-KO

Simplified Chinese language support NWr-ZH
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Task 3: Continue the installation

To continue with the installation:

1. To run an install analysis, select Install from the Actions menu.

To verify the status of the install analysis:

a. Click Logfile to check the log file to verify that swinstall did not find errors. 

b. If there were errors, correct the problems before proceeding with the 
installation.

2. In the Install Analysis window, click OK to proceed with the installation.

3. In the Install window, click Logfile to check the log file for error or warning 
messages generated during installation.

4. Click Done, and then exit swinstall.

5. Type this command to start the daemons:

/sbin/init.d/networker start

IMPORTANT!
If the NetWorker services do not start, it might be required to install a patch 
from HP. Information on which HP platforms are affected. Instructions for 
downloading the required patches are provided in “Task 4: Install the required 
HP-UX patches” on page 83

6. Ensure that the PATH environment variable for the user root is updated to 
contain the directory where the NetWorker binaries reside (/opt/networker/bin).

Table 8, “UNIX location and space requirements,” on page 28 provides 
information about this directory. This update takes effect the next time you log in.

Note: If required, install the UTF-8 converters available with the operating system.

After installation, the list of trusted servers that can access the client’s data can be 
changed by editing the /nsr/res/servers file. “Task 5: Change the NetWorker servers 
with access to the client” on page 84 provides instructions on changing the list of 
trusted servers.

Task 4: Install the required HP-UX patches
This task applies only if performing the NetWorker installation on an HP-UX RISC, 
HP-UX ia64, HP-UX 11i v1 or HP-UX 11.23 platform.

Patches QPK1123 and PHSS_37492 are required to run NetWorker on HP-UX RISC 11.23
The NetWorker services do not start on an HP-UX RISC system until the following 
patches are downloaded from the HP website:

◆ QPK1123(B.11.23.0712.070a) 1185010 Quality Pack Depot

◆ PHSS_37492

To obtain the patches, go to the HP website, and click Patch database. 
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PHSS_37500 patch required to run NetWorker on HP-UX 11.23
After installing NetWorker on HP-UX 11.23, the patch PHSS_37500 must be obtained 
from the HP website and installed before starting the NetWorker services.

To download the patch:

1. At the HP website, and click Patch database to download PHSS_37500.

2. At the prompt, provide an appropriate User ID and login password to download 
the patch

3. Follow the instructions provided to download the patch. Provide an appropriate 
user name and login to download the patch.

IPv6NCF11i patch required to run NetWorker services on HP-UX 11i v1
The IPv6NCF11i package is included in HP-UX 11.23 and later. If you are running a 
HP-UX 11i v1, install the IPv6NCF11i package, available from the HP website, using 
the following steps:

1. Navigate to the HP website and search for the IPv6NCF11i packages.

2. Install the first depot, J4256AA_A.02.01.01_HP-UX_B.11.11_32_64.depot

3. Run this command:

swinstall -x autoreboot=true -s 
$PWD/J4256AA_A.02.01.01_HP-UX_B.11.11_32_64.depot \*

4. Install the second depot, IPv6NCF11i_B.11.11.0705_HP-UX_B.11.11_32+64.depot

5. Run this command:

swinstall -x autoreboot=true -x enforce_dependencies=false -s 
$PWD/IPv6NCF11i_B.11.11.0705_HP-UX_B.11.11_32+64.depot

Note: If the NetWorker services start on an HP-UX version previous to 11.23 without installing 
these packages, the nsrexecd daemon may not start, resulting in a core dump and returning the 
error “Unable to find library libipv6.sl” on the terminal console.

Task 5: Change the NetWorker servers with access to the client
To limit the servers authorized to access a client, specify a list of trusted NetWorker 
servers for a client in the /nsr/res/servers file. After installing the client, storage 
node, and server software, use the following procedure to change the NetWorker 
servers that are authorized to access a client.

To change which NetWorker servers can access a client:

1. Log in as root on the NetWorker computer.

2. Type this command to shut down the NetWorker daemons:

nsr_shutdown

3. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that require access to the client. The first entry in this file becomes the 
default NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to:
- Access and back up the client.
- Perform a directed recovery to the client.
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4. If necessary, remove the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. The running of nsrexecd with the -s option supersedes 
the /nsr/res/servers file:

a. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. The boot-time startup file is /sbin/init.d/networker.

b. If the -s option exists in the boot-time startup file, remove all occurrences of 
this in the startup file:

-s <server_name>

Task 6: Start the NetWorker daemons

The NetWorker daemons must be started after the installation procedure. 

1. Start the NetWorker daemons:

/sbin/init.d/networker start

2. Type this command to verify that the NetWorker daemons shown in Table 25 on 
page 85 are running:

ps -ef | grep -E "nsr|lgto"

Note: The NetWorker nsrmmd daemon is only present if one or more devices are enabled. 
The nsrmmgd and nsrlcpd daemons are only present on the server if the library is enabled.

3. If the daemons are not running, use the NetWorker startup script to start the 
NetWorker daemons:

/sbin/init.d/networker start

Task 7: Install NetWorker Management Console software 
To manage the NetWorker server, install the Console and NetWorker client software 
on one computer in the datazone. The Console server installation relies on the 
existence of several other components. Ensure that all installation prerequisites are 
met. The section “Console” on page 31 provides details. 

Note: Only one installation of the Console server is required to manage multiple NetWorker 
servers and to take full advantage of the Console’s consolidated reporting feature.

Table 25 NetWorker daemons

NetWorker packages NetWorker daemons

NetWorker server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, nsrjobd, nsrmmgd, 
nsrlcpd

NetWorker client nsrexecd

NetWorker storage node nsrexecd, nsrmmd, nsrlcpd

NetWorker license manager lgtolmd
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To install software on the computer that is designated as the Console server:

1. Ensure that thse JRE.depot file for JRE version 1.6.0_1 and later software is 
installed to enable the command line reporting feature.

If the required Java version is not installed, go to the Java website to download 
and install the recommended JRE package or to download the latest 1.6.x version.

Note: JRE version 6.0 for HP does not include Java Web Start. It is recommended to use JRE 
version 6.0.01, which includes Java Web Start. 
Java WebStart is a caching mechanism for web deployed applications such as NMC. If 
cache is disabled in the Java options, Webstart will fail. To verify that Keep temporary files 
on my computer is enabled (default), in Control Panel > Java > General > Temporary 
Internet Files > Settings > Keep temporary files on my computer. Click the checkbox to 
enable temporary internet file caching if it is not checked.

2. Determine if these required HP packages are installed:

HP-UX 11i v1: swlist | grep PHSS_38154 
HP-UX 11i v2: swlist | grep PHSS_38134 
HP-UX 11i v3: swlist | grep PHSS_38135

Note: GOLDBASE11i is a required bundle contained in GOLDQPK11i, available on the HP 
Support Plus CDs. Make sure it is installed.

3. If required, obtain and install the patches/bundles required to run the Console 
server from HP.

Note: Check the HP website for the most current available patches.

4. Use the sam utility to configure the parameters for the maximum number of 
shared memory segments on the system (shmmni) and the maximum number of 
shared memory segments per process (shmseg). The default values may not be 
enough for the NetWorker Management Console server to run. 

• Set shmmni to a minimum value of 400.

Note: This value may need to be even higher if there are other processes running on the 
machine that uses shared memory.

• Set shmseg to a minimum value of 120.

5. If not already installed, install the NetWorker client software. “Task 2: Install the 
client, storage node, and server software” on page 81 provides detailed 
instructions.

Note: The Console server software is dependent upon the installation of the NetWorker 
client software.

6. Locate the NMC.pkg file and select it as the source for the installation.

7. Select the NWr-NMC file for install.
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8. If required, select one of the following language support packages for install:

• NWr-FR (French language support)

• NWr-JA (Japanese language support)

• NWr-KO (Korean language support)

• NWr-ZH (Simplified Chinese language support)

9. From the Actions window, select Install to run an install analysis:

a. Click Logfile to check the log file to verify that swinstall did not find errors. 

b. Correct any errors before proceeding with the installation.

10. Click OK in the Install Analysis window to proceed with the installation, and 
then click Yes in the Confirmation dialog box. 

11. In the Install windows, click Logfile to check the log file for error or warning 
messages generated during installation.

12. Click Done, and then exit swinstall.

13. Run this script from the command line:

/opt/lgtonmc/bin/nmc_config.sh

The lgtonmc package is installed in the /opt/lgtonmc directory.

14. Specify a User/Group with limited privileges that NMC will use to run the web 
server. This must be a non-root user. For example, if enabled the default 
user/group [nobody/nobody] can be used.

Note: If the default user/group [nobody/nobody] is not created as a user/group with 
limited privileges, follow the Console server requirements specified in the section 
“Console” on page 31.

15. For the web server port number, use the default port number (9000) or use a 
custom port number. Valid port numbers are between 1024 and 49151.

16. For the Console server, use the default port number (9001) or use a custom port 
number. Valid port numbers are between 1024 and 49151.

Note: Do not use port numbers that are already in use. Port 2638 is reserved by the Console 
server. The Console server uses the Tabular Data Stream (TDS) protocol to communicate 
with the database. Port 9002 is the preferred port for EMC Backup Advisor product.

17. Specify the directory to use for the lgtonmc database (for example, 
/export/home/lgto_gstdb).

18. Specify the location of the NetWorker binaries (for example, /usr/sbin).

19. Run the NetWorker Management Console server daemon:

/sbin/init.d/gst start

The NetWorker Management Console daemon starts these processes:

• gstd

• dbsrv9

• httpd (2 or more processes)
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20. If the Console server and the NetWorker server are installed on separate hosts, 
you must add the Console administrator to the administrator lists of the 
monitored NetWorker server. This enables the Console administrator to 
administer and monitor the target NetWorker server. On the NetWorker server:

a. Specify the process owner of the Console daemon process (gstd) depending on 
which host contains the Console server: 

– If on a Microsoft Windows host, type:
nsraddadmin -u "user=SYSTEM, host=console_host"

– If on a AIX, HP-UX, Linux or Solaris only host, type:
nsraddadmin -u "user=root, host=console_host"

b. Specify the Console administrator user:

nsraddadmin -u "user=administrator, host=console_host"

where console_host is the Console server hostname.

Note: Ensure the gstd process is stopped when applying these changes.

IMPORTANT!
The NetWorker software must be able to resolve the loopback address, ::1, to 
localhost. This entry must exist in the system's respective /etc/hosts file as follows:
::1 localhost loopback
The ::1 entry must remain in the /etc/hosts file, whether operating in an IPv4 or 
IPv6 configuration.

launch Java Web Start if NMC GUI fails to start
When the NMC installation is complete and the NMC client GUI starts, a message 
indicates that Java is loading before the NMC console appears. If the NMC console 
does not open, Java Web Start may have failed to load, due to a corrupted Java Web 
Start cache or an incompatible version of Java Web Start. To resolve the issue, it is 
recommend to clean up the $HOME/.java cache location. 

Perform the following commands to load Java Web Start:

1. Run setenv or export HOME if not set:

cd $HOME

2. Move or remove the $HOME/.java directory:

mv .java .java_orig

3. Navigate to JRE HOME and launch javaws. Reconfigure the Java Web Start 
preference if necessary. A new $HOME/.java will be created:

javaws [-viewer]

Note: Only JRE version 1.6 is supported.

4. If step 3 is successful, restart the web browser to launch the NMC GUI client.
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Uninstall the NetWorker software
Use the swremove utility command to uninstall individual NetWorker packages or 
all of the NetWorker packages simultaneously.

Note: Like swinstall, the swremove program can be run in either terminal mode or from the 
graphical user interface. 

To uninstall the NetWorker software:

1. Log in as root on the NetWorker computer.

2. Type this command to shut down the NetWorker daemons:

nsr_shutdown

3. Type this command at the shell prompt:

swremove &

Note: If you are using the character interface, do not include the & symbol.

4. Select the NetWorker software to be removed in the Software Selection window.

5. To run an analysis of the Remove operation, select Remove from the Actions 
window. 

6. Click Logfile to check for any error or warning messages. Fix any problems 
before continuing with the operation.

7. Click OK in the Remove Analysis window to proceed with the remove operation. 

8. To exit from the swremove utility, click Done in the Remove window, and then 
select Exit from the File menu in the Software Selection window.

9. To ensure that the NetWorker software has been completely uninstalled after the 
remove operation, verify that all the files have been uninstalled from these 
directories:

• /opt/networker

• /opt/lgtonmc

10. If there is no longer a requirement to update or reinstall the NetWorker software:

a. Remove the /nsr directory.

b. Delete the NMC directory. By default, NMC is installed at /opt/lgtonmc.

c. Delete the directory containing the NMC database files lgto_gst.db, 
lgto_gst.log, and gstd_db.conf.

11. If there is no longer a requirement for the Java Runtime Environment, uninstall 
the JRE.
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Install the NetWorker software
Follow these tasks to install the NetWorker software:

◆ “Task 1: Install the NetWorker client software” on page 92

◆ “Task 2: Change the NetWorker servers with access to a client” on page 93

Task 1: Install the NetWorker client software

The NetWorker client software and License Manager can be installed by using the 
Software Manager.

If the /nsr directory must be on another disk, create /nsr as a symbolic link. For 
example, type this command to install the software on /disk2:

ln -s /disk2/nsr /nsr

Note: If installing from a downloaded .tar package, tardist will delete the original .tar package 
after installation. A copy should be made prior to installation if you want to keep it. If required, 
install the UTF-8 converters available with the operating system.

To install the software by using the Software Manager:

1. Access the Software Manager window:

tardist /tmp/sgi.tardist

The Software Manager window opens. 

2. Select Customize to install this software:

• NetWorker client

• NetWorker License Manager (optional)

• Man pages (optional)

3. Double-click the NetWorker product to display these components:

NetWorker Client Software for IRIX
NetWorker License Manager for IRIX
NetWorker Man Pages for IRIX

The client and man pages are default options. 

4. Select the components to install.

5. Click Start and then click OK when the installation process is complete. 

6. Exit the Software Manager window.

7. To limit the servers that are authorized to access this client, see “Task 2: Change 
the NetWorker servers with access to a client” on page 93.

Note: Ensure that the PATH environment variable for the user root is updated to contain 
the directory where the NetWorker binaries reside (/usr/etc).

8. To start the daemons, type:

/etc/init.d/networker start

9. To verify that the nsrexecd daemon is running on the NetWorkerclient, type:

ps -ef | grep nsr
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Task 2: Change the NetWorker servers with access to a client

To limit the servers authorized to access a client, specify a list of trusted NetWorker 
servers for a client in the/nsr/res/servers file. After installing the client, storage 
node, and server software, this procedure can be used to change the NetWorker 
servers that are authorized to access a client. 

To change which NetWorker servers can access a client:

1. Shut down the NetWorker daemons by typing the following command:

nsr_shutdown

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that require access to the client. The first entry in this file becomes the 
default NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

3. If necessary, remove the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. 

Running nsrexecd with the -s option supersedes the /nsr/res/servers file:

a. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. This file is located in the /etc/init.d/networker 
directory.

b. If the -s option exists in the boot-time startup file, remove all occurrences of 
this in the startup file:

-s server_name
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Uninstall the software
To uninstall the software by using the Software Manager:

1. In the NetWorker Administrator program, type this command to shut down the 
daemons:

/usr/etc/nsr_shutdown

2. To open the Software Manager window, type:

swmgr

3. Select the Manage Installed Software option. 

The window displays a list of the installed components.

4. Select the components to remove.

5. Click Start to begin the uninstall.

6. Click OK when the uninstall is complete.

7. If you no longer to plan to update or reinstall the NetWorker software, remove the 
/nsr directory.
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Install the NetWorker software
Follow these tasks to install the NetWorker software:

◆ “Task 1: Review before the installation” on page 96

◆ “Task 2: Install the NetWorker software” on page 98

◆ “Task 3: Change the NetWorker servers with access to a client” on page 105

◆ “Task 4: Start the NetWorker daemons” on page 106

More information on installation requirements for the client, server and storage node 
is provided in Chapter 2, “Software Requirements.”

Task 1: Review before the installation
Consider these troubleshooting requirements before installing the NetWorker 
software on the following Linux platforms:

◆ “Compatibility library requirements” on page 96

◆ “SuSE Linux requirements for SLES 11” on page 96

◆ “Required pdksh package for SuSE 10 x86” on page 97

◆ “Disable SELinux on Red Hat 5” on page 97

◆ “Install the required libraries” on page 97

Compatibility library requirements
On Red Hat and SuSE Linux (SLES 9 and 10) platforms, the compatibility library (for 
example, /usr/lib/libstdc++.so.5) must be installed before the NetWorker software is 
installed and run. The package name containing this library might differ between 
Red Hat and SuSE platforms:

◆ For SLES 9, the package name is libstdc++-3.3.3

◆ For SLES 10, the package name is compat-libstdc++-5.0.7

◆ For Red Hat 4 and 5, the package name is compat-libstdc++-33-3.2.3.-47.3

SuSE Linux requirements for SLES 11
Assuming that the default installation options are selected for SLES 11, the following 
additional items must be installed before NetWorker is installed and run:

◆ Openmotif package openmotif-2.3.2-1.suse11.1.i586.rpm or 
openmotif-2.3.2-1.suse11.1.x86_64.rpm (to support the x86 and x64 platforms 
respectively).

Openmotif is not packaged with the SLES 11 installation media, it can be 
downloaded at:
http://www.motifzone.net/files/public_downloads/openmotif/2.3/2.3.2/

◆ The libcap.so package libcap1, which is available on the SLES11 installation 
media. 
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Required pdksh package for SuSE 10 x86
On SuSE 10 x86, you may need to install the pdksh package if the required version is 
not installed. The required package is pdksh-5.2.14-801.i586.rpm.

Download the pdksh-5.2.14-801.i586.rpm package from the SuSE/Novell website. 
Also, the packages with the --nodeps option can be installed.

Disable SELinux on Red Hat 5
On Red Hat 5, mandatory access control architecture SELinux must be disabled. 
SELinux is enabled by default.

To disable SELinux on Red Hat 5:

1. Run system-config-securitylevel.

2. In the window that appears, select the SELinux tab.

3. Select Disable SELinux.

Install the required libraries

Note: For Linux s390/zLinux ensure that X Windows is installed to support utilities that ship 
with the NetWorker software. 

Ensure that these packages are installed before installing openmotif on all Linux 
architectures:

◆ expat-1.95.7-4.s390.rpm

◆ libstdc++-3.4.6-11.s390.rpm

◆ freetype-2.1.9-8.el4.6.s390.rpm

◆ fontconfig-2.2.3-13.el4.s390.rpm

◆ xorg-x11-Mesa-libGL-6.8.2*.rpm

◆ xorg-x11-libs-6.8.2*.rpm

To install the required libraries:

1. Determine if the required Linux packages are installed:

• openmotif-libs-2.3.0-84.1.i586.rpm and openmotif-2.3.0-84.1.i586.rpm

rpm -qa | grep openmotif

• compat-libstdc++-5.0.7 or later

rpm -qa | grep compat-libstdc++ 

• glibc-2.3.4 or later:

rpm -qa | grep glibc

Note: If configuring more than 32 VLAN NICs, install glibc 2.5-12 or later.

• libcap1-1.10-10.1.i586.rpm:

rpm -qa | grep libcap

Note: If the zh_CN.utf8 locale is used, ensure that the 
ttf-founder-simplified-0.20040419-6.1.noarch.rpm, and the 
ttf-founder-traditional-0.20040419-6.1.noarch.rpm packages are also installed.
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2. Download any required packages that are missing to a temp folder on the Linux 
computer. The operating system website provides download details specific to 
the operating system.

3. Change to the temp directory where the packages are downloaded.

4. Unzip the packages:

gunzip file_name.gzip

5. Untar the packages:

tar -xvf file_name.tar

6. Install the packages:

rpm -ivh file_name

7. Remove the packages from the temp directory.

RPM reports missing libraries on Linux IA64
During the installation of NetWorker packages on Linux IA64, the rpm program 
incorrectly reports these missing libraries:

rpm -i lgtoclnt-1.ia64.rpm
error: Failed dependencies:
ld-linux-ia64.so.2 is needed by lgtoclnt-1
libc.so.6.1 is needed by lgtoclnt-1
libc.so.6.1(GLIBC_2.2) is needed by lgtoclnt-1
libncurses.so.5 is needed by lgtoclnt-1

To correct these installation errors:

1. Log in as root.

2. Verify that the libraries exist as described in step 1 on page 97.

3. Run the rpm program, for example:

rpm -i --nodeps lgtoclnt-1.ia64.rpm

4. Repeat this procedure for each required NetWorker package: 

• lgtonode

• lgtoserv

• lgtodrvr

Task 2: Install the NetWorker software
By default, the NetWorker software is installed in the /usr directory; however, the 
software can be installed in a different directory. If you have insufficient disk space on 
the /usr partition, choose another location to install the software.

Follow the instructions in one of the following sections to install the software:

◆ “Install the software to the default location” on page 99

◆ “Task 3: Change the NetWorker servers with access to a client” on page 105

Note: When installing the NetWorker software on the SuSE 10 x86 platform, this error message 
is displayed if the required version of the pdksh package is not installed:
error: Failed dependencies:
/bin/ksh is needed by lgtoclnt-7.6-1
To resolve this issue, install pdksh-5.2.14-801.i586.rpm. Obtain the pdksh-5.2.14-801.i586.rpm 
from the SuSE/Novell download Pages, or install the packages with the --nodeps option.
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Install the software to the default location
To install the client, storage node, and server software to the default location, see the 
following sections:

◆ “Client installation” on page 99

◆ “Storage node installation” on page 100

◆ “Server installation” on page 101

◆ “Console software” on page 102

Note: The UTF-8 converters might be required to be available with the operating system. The 
NetWorker Management Console (Console) server software is supported on the 
Linux x86 platform. The Console server software is not supported on the Linux 
Itanium platform.

Client installation

Note: The NetWorker software uses the rpm utility for installation. The Linux rpm man page 
provides more information on using rpm.

To install the NetWorker software on the computer designated as the NetWorker 
client:

1. Log in to the NetWorker Linux client.

2. Change to the directory containing the NetWorker software.

3. Type the appropriate command:

• For Itanium:

rpm -ivh lgtoclnt-7.6.1-1.ia64.rpm

• For Intel x86:

rpm -ivh lgtoclnt-7.6.1-1.ii686.rpm

• For s390/zLinux (client only):

rpm -ivh lgtoclnt-7.6.1-1.s390.rpm

• For x64:

rpm -ivh lgtoclnt-7.6.1-1.x86_64.rpm

• For Power Linux (client only):

rpm -ivh lgtoclnt-7.6.1-1.ppc64.rpm

4. (Optional) To install the man pages and the appropriate language support 
packages, type the commands in Table 26 on page 99.

Table 26 Optional software packages (page 1 of 2)

Software Package Linux Itanium Processor Intel x86

man pages rpm -ivh 
lgtoman-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoman-7.6.1-1.ii686.rpm

French rpm -ivh 
lgtofr-7.6.1-1.ia64.rpm

rpm -ivh 
lgtofr-7.6.1-1.ii686.rpm
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Storage node installation
On the computers designated as storage nodes, install the NetWorker client and 
storage node software. The storage node package must be installed on the NetWorker 
server, regardless of whether separate systems are used as designated storage nodes. 

Note: The NetWorker software uses the rpm utility for installation. For information about using 
rpm is available in the Linux rpm man page.

To install the storage node software:

1. Change to the directory containing the NetWorker software.

2. Type this command to install the client and storage node packages:

• For Itanium:

rpm -ivh lgtoclnt-7.6.1-1.ia64.rpm lgtonode-7.6.1-1.ia64.rpm

• For Intel x86:

rpm -ivh lgtoclnt-7.6.1-1.i686.rpm lgtonode-7.6.1-1.i686.rpm

• For x64:

rpm -ivh lgtoclnt-7.6.1-1.x86_64.rpm lgtonode-7.6.1-1.x86_64.rpm

3. (Optional) To install the man pages and the appropriate language support 
packages, type the commands in Table 27 on page 100.

Japanese rpm -ivh 
lgtoja-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoja-7.6.1-1.ii686.rpm

Korean rpm -ivh 
lgtoko-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoko-7.6.1-1.ii686.rpm

Simplified Chinese rpm -ivh 
lgtozh-7.6.1-1.ia64.rpm

rpm -ivh 
lgtozh-7.6.1-1.ii686.rpm

Table 26 Optional software packages (page 2 of 2)

Software Package Linux Itanium Processor Intel x86

Table 27 Optional software packages 

Software Package Linux Itanium Processor Intel x86

man pages rpm -ivh 
lgtoman-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoman-7.6.1-1.i686.rpm

French rpm -ivh 
lgtofr-7.6.1-1.ia64.rpm

rpm -ivh 
lgtofr-7.6.1-1.i686.rpm

Japanese rpm -ivh 
lgtoja-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoja-7.6.1-1.i686.rpm

Korean rpm -ivh 
lgtoko-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoko-7.6.1-1.i686.rpm

Simplified Chinese rpm -ivh 
lgtozh-7.6.1-1.ia64.rpm

rpm -ivh 
lgtozh-7.6.1-1.i686.rpm
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Server installation
On the computer designated as the NetWorker server, install all the NetWorker 
software packages in the following order: client, storage node, server. The NetWorker 
License Manager software can be installed at any point in this sequence after the 
client package is installed.

Note: The NetWorker software uses the rpm utility for installation. For information about 
using rpm, refer to the Linux rpm man page.

To install the server software:

1. Change to the directory containing the NetWorker software.

2. Type the appropriate commands to install the client, storage node, server, and 
NetWorker License Manager software:

• For Itanium:

rpm -ivh lgtoclnt-7.6.1-1.ia64.rpm lgtonode-7.6.1-1.ia64.rpm 
lgtoserv-7.6.1-1.ia64.rpm lgtolicm-7.6.1-1.ia64.rpm

• For Intel x86:

rpm -ivh lgtoclnt-7.6.1-1.i686.rpm lgtonode-7.6.1-1.i686.rpm 
lgtoserv-7.6.1-1.i686.rpm lgtolicm-7.6.1-1.i686.rpm

• For x64:

rpm -ivh lgtoclnt-7.6.1-1.x86_64.rpm lgtonode-7.6.1-1.x86_64.rpm 
lgtoserv-7.6.1-1.x86_64.rpm lgtolicm-7.6.1-1.x86_64.rpm

Note: Installing the NetWorker License Manager software is optional. It can be installed 
any time after the client software.

3. (Optional) To install the man pages and the appropriate language support 
packages, type the commands in Table 28 on page 101.

The NetWorker software installation modifies these system files during installation. 
To keep a copy of the current configuration, save the following original files:

◆ /etc/rpc

◆ /etc/syslog.conf

◆ /etc/ld.so.conf

Table 28 Optional software packages 

Software Package Linux Itanium Processor Intel x86

man pages rpm -ivh 
lgtoman-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoman-7.6.1-1.i686.rpm

French rpm -ivh 
lgtofr-7.6.1-1.ia64.rpm

rpm -ivh 
lgtofr-7.6.1-1.i686.rpm

Japanese rpm -ivh 
lgtoja-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoja-7.6.1-1.i686.rpm

Korean rpm -ivh 
lgtoko-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoko-7.6.1-1.i686.rpm

Simplified Chinese rpm -ivh 
lgtozh-7.6.1-1.ia64.rpm

rpm -ivh 
lgtozh-7.6.1-1.i686.rpm
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These files are added during the installation process:

◆ /etc/init.d/networker 

◆ /etc/init.d/rc3.d/S95networker

◆ /etc/init.d/rc5.d/S95networker 

◆ /etc/init.d/rc0.d/K05networker 

Console software
To manage the NetWorker server, install the NetWorker Console and client software 
on one machine in the datazone.

The NetWorker Console installation relies on the existence of several other 
components. Ensure that all installation prerequisites are met. The section “Console 
client” on page 35 provides details.

Note: NetWorker Management Console server software is supported on the Linux x86 
platform. The NetWorker Management Console server software is not supported on the Linux 
Itanium platform.

To install NetWorker software on the computer that is designated as the NetWorker 
Console server:

1. If the required JRE version 1.6 and later is not installed, go to the Java website to 
download and install the required version.

Note: If running on a 64-bit Linux host, install the 32-bit JRE version.

2. When installing the required JRE version:

a. Remove the following Mozilla file from /usr/lib/mozilla-1.7.12/plugins:

libnullplugin.so

b. Create a symbolic link within the Mozilla plugins directory to the 
libjavaplugin_oji.so file. For example:

ln -s /usr/local/jre1.6.0/plugin/i386/ns7/libjavaplugin_oji.so

3. If the NetWorker software was downloaded from the web:

a. Type the following command to verify that execute permissions are applied to 
the JRE file. For example:

chmod +x j2re-1_6_0-linux-i586.bin

b. Change to the directory where the JRE is to be installed.

c. Run this executable:

j2re-1_6_0-linux-i586.bin

d. Accept the Java licensing agreement.

Note: Java WebStart is a caching mechanism for web deployed applications such as 
NMC. If cache is disabled in the Java options, WebStart will fail. To verify that Keep 
temporary files on my computer is enabled (default), in Control Panel > Java > 
General > Temporary Internet Files > Settings > Keep temporary files on my 
computer. Click the checkbox to enable temporary internet file caching if it is not 
checked.

4. Change to the directory containing the NetWorker software.
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5. Type this command to install the NetWorker client software, if not already 
installed:

rpm -ivh lgtoclnt-7.6.1-1.i686.rpm

6. Start the NetWorker daemons, if not already started. “Task 4: Start the NetWorker 
daemons” on page 106 provides information on how to start the NetWorker 
daemons.

7. To install the NetWorker Console software, type:

rpm -ivh lgtonmc-7.6.1-1.i686.rpm

By default, the software is installed in /opt.

8. (Optional) To install the man pages and the appropriate language support 
packages, type the commands listed in Table 29 on page 103.

9. Run this configuration script to install the lgtonmc package in the /opt/lgtonmc 
directory:

/opt/lgtonmc/bin/nmc_config

10. Specify a User/Group with limited privileges that NMC will use to run the web 
server. This must be a non-root user. For example, Linux operating systems have a 
default user/group [nobody/nobody] that can be used.

Note: If the default group [nobody/nobody] is not available, and a user/group is not 
created with limited privileges, follow the Console server requirements specified in the 
section “Console” on page 31

11. For the web server port number, use the default port number (9000) or use a 
custom port number. Valid port numbers are between 1024 and 49151.

12. For the Console server, use the default port number (9001) or use a custom port 
number. Valid port numbers are between 1024 and 49151.

Note: Do not use port numbers already in use. Port 2638 is reserved by the NetWorker 
Console software by using the Tabular Data Stream (TDS) protocol to communicate with 
the database. Port 9002 is the preferred port for EMC Backup Advisor product.

13. Specify the directory to use for the lgtonmc database (for example, 
/export/home/lgto_gstdb).

14. Specify the location of the NetWorker binaries (for example, /usr/sbin).

Table 29 Optional software packages

Software Package Linux Itanium Processor Intel x86

man pages rpm -ivh 
lgtoman-7.6.1-1.ia64.rpm

rpm -ivh 
lgtoman-7.6.1-1.i686.rpm

French rpm -ivh lgtofr-7.6.1-1.ia64.rpm rpm -ivh 
lgtofr-7.6.1-1.i686.rpm

Japanese rpm -ivh lgtoja-7.6.1-1.ia64.rpm rpm -ivh 
lgtoja-7.6.1-1.i686.rpm

Korean rpm -ivh lgtoko-7.6.1-1.ia64.rpm rpm -ivh 
lgtoko-7.6.1-1.i686.rpm

Simplified Chinese rpm -ivh lgtozh-7.6.1-1.ia64.rpm rpm -ivh 
lgtozh-7.6.1-1.i686.rpm
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15. Start the NetWorker Console daemons if not already started:

/etc/init.d/gst start

The NetWorker Console daemons include the following:

• gstd

• dbsrv9

• httpd (2 or more processes)

• gstsnmptrapd (optional daemon) for managing integrated Data Domain 
backups.

16. For Red Hat Enterprise Server 4 only, from the client machine with more than one 
JRE installed, you may want to reconfigure the usage of the JRE as follows:

a. Run the Java Web Start application named javaws. This application is located 
in the same directory where the previous software was installed.

b. From the Java Application Runtime Settings window:

– Select the JRE 1.6.0 version software. This forces the Java Web Start 
application to use JRE version 1.6.0 to run applications.

– Clear the other versions of the JRE software, for example JRE version 
1.5.0_11.

Note: Only JRE version 1.6.0 and later is supported.

c. Start the NetWorker Console server. The Console launch page appears.

d. Specify to run the Console with the Java Web Start version 1.6 software. Type 
the path to the Java Web Start executable.

Note: There are two libraries, libXp.so.6 and libXm.so.3 (open motiff lib), that are required 
on Red Hat Enterprise Linux 4 and 5 to launch the nwrecover program. By default, these 
libraries are not part of the operating system.
On Red Hat Linux 4, libXp.so.6 is installed with the xorg-x11-deprecated-libs rpm. Install 
this package, then launch nwrecover.
The missing packages are contained on Red Hat Linux 5, however, the packages are not 
selected by default. To select these packages, when installing Red Hat 5, go to the Optional 
Packages in X Software Development Packages and individually select libXp.so.6 and 
libXm.so.3.

17. If the Console server and the NetWorker server are installed on separate hosts, be 
sure to add the Console administrator to the administrator lists of the monitored 
NetWorker server. This enables the Console administrator to administer and 
monitor the target NetWorker server. 
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On the NetWorker server:

a. Specify the process owner of the Console daemon process depending on 
which host contains the Console server: 

– If on a Microsoft Windows host, type:
nsraddadmin -u "user=SYSTEM, host=console_host"

– If on a AIX, HP-UX, Linux or Solaris only host, type:
nsraddadmin -u "user=root, host=console_host"

b. Specify the Console administrator user:

nsraddadmin -u "user=administrator, host=console_host"

where console_host is the Console server hostname.

Launch Java Web Start if the NMC GUI fails to start
When the NMC installation is complete and the NMC client GUI starts, a message 
indicates that Java is loading before the NMC console appears.

If the NMC console does not open, Java Web Start may have failed to load, due to a 
corrupted Java Web Start cache or an incompatible version of Java Web Start. To 
resolve the issue, it is recommend to clean up the $HOME/.java cache location. 

Perform these commands to load Java Web Start:

1. Run setenv or export HOME if not set:

cd $HOME

2. Move or remove the $HOME/.java directory:

mv .java .java_orig

3. Navigate to JRE HOME and launch javaws. Reconfigure the Java Web Start 
preference if necessary. A new $HOME/.java will be created:

javaws [-viewer]

Note: Only JRE version 1.6 is supported.

4. If step 3 is successful, restart the web browser to launch the NMC GUI client.

Task 3: Change the NetWorker servers with access to a client

To limit the servers that are authorized to access a client, a list of trusted NetWorker 
servers can be specified for a client in the /nsr/res/servers file. After installing the 
client, storage node, and server software, use the following procedure to change the 
NetWorker servers that are authorized to access a client.
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To change the NetWorker servers that can access a client:

1. Edit or create the /nsr/res/servers file and add the NetWorker servers, one per 
line, that require access to the client. The first entry in this file becomes the default 
NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to:
- Access and back up the client.
- Perform a directed recovery to the client.

2. If necessary, delete the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. Running nsrexecd with the -s option supersedes the 
/nsr/res/servers file.

Task 4: Start the NetWorker daemons
Upon startup, the NetWorker software creates the /nsr directory on the root partition. 
To change the default location of the nsr directory, do so before starting the 
NetWorker daemons.

The NetWorker daemons must be started after the installation procedure:

1. Type this command to start the NetWorker daemons:

/etc/init.d/networker start

2. Type this command to determine if the NetWorker daemons are started:

ps -ef | grep nsr

Table 30 on page 106 lists the NetWorker daemons for each of the software 
components.

Note: The NetWorker daemon nsrmmd is only present if one or more devices are enabled. The 
nsrmmgd and nsrlcpd daemons are only present on the server if the library is enabled.

IMPORTANT!
The NetWorker software must be able to resolve the loopback address, ::1, to 
localhost. This entry must exist in the system's respective /etc/hosts file as follows:
::1 localhost loopback
The ::1 entry must remain in the /etc/hosts file, whether operating in an IPv4 or 
IPv6 configuration.

Table 30 NetWorker daemons

NetWorker packages NetWorker daemons

NetWorker server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, nsrjobd, nsrmmgd, nsrlcpd

NetWorker client nsrexecd

NetWorker storage node nsrexecd, nsrmmd, nsrlcpd
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HomeBase Agent installation

The Homebase agent enables Bare Metal Recovery (BMR) for server system data. 
NetWorker release 7.6 and later ships with the EMC HomeBase Agent version 6.2.x 
and installs it automatically. 

Note: Ensure that there is enough disk space for the HomeBase Agent binaries during the 
NetWorker installation. Details on the amount of space required for the HomeBase Agent is 
available in the HomeBase Agent Installation and Configuration Guide.

The NetWorker software also supports version 6.4 of the Homebase Agent. 
Information about upgrading to and configuring the Homebase 6.4 agent is available 
in the HomeBase Agent Installation and Configuration Guide. Information on BMR 
recovery is available in the HomeBase Recovery and Migration Guide.

IMPORTANT!
The Homebase Agent client version that you use, requires that the equivalent 
Homebase Server version be installed in order for BMR to function in the 
NetWorker 7.6 and later environment. 

The HomeBase Agent collects configuration information about the operating system 
platform of the host on which it is installed. This information is called a profile.

A profile can be used to:

◆ Monitor configuration changes

◆ Migrate configuration changes

◆ Recover the operating system’s configuration from an EMC HomeBase Server

The profile data includes hardware configurations, operating system levels, system 
tuning, network configuration and connections, security, and storage layouts. This 
information is captured with a NetWorker save set backup and is sent to a secure 
HomeBase Server for storage and analysis. The HomeBase Server is also required to 
perform a BMR server recovery or migration.

The following documents provide information about the HomeBase Server features:

◆ EMC HomeBase Server Installation and Administration Guide

◆ EMC HomeBase Server User Guide

HomeBase Agent space requirements
Table 31 on page 107 specifies the location and space requirements for the HomeBase 
Agent.

Table 31 HomeBase Agent location and minimum system requirements

NetWorker files Location

Space Processor

x86 x64

EMC HomeBase Agent binary /opt/homebase-agent/ 512 MB 512 MB 1 GHz

Temporary space required for EMC HomeBase Agent /tmp 512 MB 512 MB 1 GHz
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Enable BMR server support
Connection with a HomeBase Server is enabled during the set up of the NetWorker 
server. This connection enables the delivery of profile data from the NetWorker client 
to the HomeBase Server.

To enable BMR support:

1. From the Administration window, click Configuration.

2. Select the NetWorker server name.

3. From the File menu, select Properties.

4. In the Properties dialog box, click the Configuration tab.

5. Type the IP address or hostname for the HomeBase Server in the BMR server 
field.

6. Click OK.

Note: The HomeBase Server SSL protocol must be configured and activated on the HomeBase 
Server. The EMC HomeBase Server Installation and Administration Guide provides information 
about enabling the SSL protocol.

License the HomeBase Server and Agent
This section provides details for licensing the HomeBase Server, and HomeBase 
Agent software.

The EMC HomeBase Server Installation and Administration Guide, and the The EMC 
HomeBase Agent Installation and Configuration Guide provides complete details on 
licensing the HomeBase software.

HomeBase Server
The HomeBase server software comes with a 30 day evaluation enabler for the 
HomeBase Server with 20 HomeBase Agent licences. 

Note: Be sure to permanently enable the HomeBase Server and Agent licenses, as they expire 
after 30 days with no grace period.

During the installation of the HomeBase Server, a license request file is automatically 
generated in the keys directory. The license request is then forwarded to 
licensing@emc.com with all required purchase order details. Copies of the following 
are then sent:

◆ licence.zip file (the HomeBase Server licence)

◆ homebase.bks file (a set of encryption keys used for the recovery and replication 
of profiles between HomeBase Servers) 

◆ Agent licence batch files (there can be multiple agent licence batch files) that are 
associated with the HomeBase Server licence.

Note: The default temporary enablers can be overridden by applying a permanent enabler 
and Agent licence batch to the HomeBase Server when the HomeBase Server Console is 
first accessed.
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HomeBase Agent
When a HomeBase Agent is installed with the NetWorker software, the Agent license 
is provided automatically during the first profile run from the NetWorker software as 
it must be able to contact the HomeBase Server to forward profiles for backups. The 
-L option in the NetWorker client BMR configuration setting is used to do this.

The EMC HomeBase Server Installation and Administration Guide provides details on 
how to license the HomeBase Agent for a Remote HomeBase Server.

Using the NetWorker client port under a firewall server
If the NetWorker client and HomeBase Agent are on the same system outside of the 
firewall with the HomeBase Server inside the firewall, then port 18821 is required for 
communication between the HomeBase Agent and the HomeBase Server.
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Uninstall the software
This section provides instructions for the following:

◆ “Uninstall the NetWorker software” on page 110

◆ “Uninstall the HomeBase Agent” on page 111

Uninstall the NetWorker software

Use the rpm -e package_name command to uninstall individual NetWorker packages or 
all of the NetWorker packages simultaneously. For information about using rpm, 
refer to the rpm man page.

Note: The NetWorker software packages have dependencies on each other and must be 
uninstalled in the following order: lgtolicm, lgtoserv, lgtonode, lgtoclnt. The man pages 
(lgtoman) and document files have no dependencies and can be uninstalled any time.

The lgtonmc package must be uninstalled before the lgtoclnt package. 

To uninstall the NetWorker software packages:

1. Log in as root to the computer from which the software is being uninstalled.

2. Run a query to see which packages are installed:

rpm -qa | grep lgto

3. Type these commands to uninstall the software:

• To uninstall all the packages, type:

rpm -e lgtolicm lgtoserv lgtonode lgtonmc lgtoclnt lgtoman

• To uninstall packages individually, type:

rpm -e package_name

Example 1 Uninstall the software

Table 32 NetWorker packages to uninstall 

To uninstall these package Type this package name

Server lgtoserv-7.6

Storage node lgtonode-7.6

Console server lgtonmc-7.6

NetWorker License Manager lgtolicm-7.6

Client lgtoclnt-7.6

Man pages lgtoman-7.6

French language support lgtofr-7.6

Japanese language support lgtoja-7.6

Korean lgtoko-7.6

Simplified Chinese language support lgtozh-7.6
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4. If there is no plan to update or reinstall the NetWorker software:

a. Remove the /nsr directory.

b. Delete the NMC directory. By default, NMC is installed at /opt/lgtonmc.

c. Delete the directory containing the following NMC database files:

– lgto_gst.db

– lgto_gst.log
– gstd_db.conf

5. If the Java Runtime Environment is no longer required, uninstall the JRE. 

6. If NetWorker release 7.4 is installed and an update to NetWorker release 7.6 or 
later is required, type this command to uninstall all NetWorker packages:

rpm -e lgtolicm-7.4 lgtoserv-7.4 lgtonode-7.4 lgtoclnt-7.4 
lgtoman-7.4

Uninstall the HomeBase Agent
To uninstall the HomeBase Agent, use the HomeBase uninstall program. The 
HomeBase Agent Installation and Configuration Guide provides complete details on 
uninstalling the HomeBase Agent.
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Introduction
The information in this chapter assumes that you have a basic knowledge of:

◆ Mac OS X terminal emulator

◆ UNIX command line tools using the Mac OS X Terminal application utility

For information on using the Mac OS X Terminal application:

1. Open the Mac Help database by pressing the ? key combination within the Finder 
application.

2. Search for Terminal.

Install the Mac OS X client software
To install the software:

1. Double-click the NetWorker.dmg Disk Image icon on your desktop to mount the 
NetWorker software.

2. Double-click the NetWorker.pkg Disk Image package on the NetWorker volume 
to launch the NetWorker software.

3. Follow the instructions to install the NetWorker software.

Verify the installation

Note: Before testing the Mac OS X client, ensure that the NetWorker server software has been 
properly installed. Review the NetWorker Installation Guide for the platform of the NetWorker 
server that will back up the Mac OS X client.

To verify that the NetWorker client software is correctly installed:

1. Use the Mac OS X Activity Monitor application to check that the NetWorker 
client daemon (nsrexecd) is active on the host computer. For example:

nsrexecd

Note: By default, the nsrexecd daemon is automatically started after installation.

2. If the nsrexecd daemon is not listed, type this command:

$ sudo /sbin/launchctl start com.emc.NetWorker
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Uninstall the Mac OS X client software

Note: Do not use the nsr_shutdown command to shutdown nsrexecd. Only the -l option is 
supported.

To uninstall the NetWorker software, run the appropriate uninstall script. Table 33 on 
page 115 provides details.

Table 33 NetWorker client uninstall scripts

To remove this 
NetWorker package Uninstall script

Client software $ sudo /usr/sbin/NetWorkerUninstall
Uninstall the Mac OS X client software 115



Mac OS X Client Installation
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide116



10

This chapter includes these sections:

◆ Install the software...........................................................................  118
◆ Uninstall the NetWorker software .................................................  129

Solaris Installation
Solaris Installation 117



Solaris Installation
Install the software
Complete these tasks to install the NetWorker software:

◆ “Task 1: Install the NetWorker software” on page 118

◆ “Task 2: Change the NetWorker servers with access to a client” on page 125

◆ “Task 3: Start the NetWorker daemons” on page 125

◆ “HomeBase Agent installation” on page 126

Task 1: Install the NetWorker software
By default, the NetWorker software is installed in the /usr directory. 

The NetWorker software can be installed in a default or nondefault location.

Install the required Solaris 10 patches 
This section describes the patches required for the Solaris 10 operating system.

For x86/Sparc
To avoid shared memory corruption, or possible failures of the NetWorker services 
on a NetWorker server, Sun patch142900-03 on Sparc or Sun Patch 142901-03 on x86 
or later must be applied:

1. Obtain the patches from the Sun website.

2. Confirm the patch is applied:

• On Solaris Sparc servers, type this command:

pkginfo | grep 142900

• On Solaris x86 servers, type this command:

pkginfo | grep 142901

Note: This patch has dependencies on other system patches. Ensure that all requirements are 
met before applying the patch.

CDE/Motif patch on Sparc V240
In order for nwrecover to function correctly, Sun patch 119280 on Sparc or Sun patch 
119281 on x86 or later must be applied:

1. Obtain the patch from the Sun website.

2. Confirm the patch is applied:

• On Solaris Sparc servers, run the following command:

pkginfo | grep 119280

• On Solaris x86 servers, type the following command:

pkginfo | grep 119281

Note: This patch has dependencies on other system patches. Ensure that all requirements are 
met before applying the patch.
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Install the NetWorker software to the default location
This section explains how to install the client, storage node, server, and Console 
server:

Client
To install the NetWorker software on the computer that is designated as the 
NetWorker client:

1. Type this command:

pkgadd -d /cdrom/cdrom1/solaris

Note: Do not press Enter for the default response All. Accepting the default installs the 
server.

2. Type the number of the option to install the client package (LGTOclnt). The client 
package temporarily requires 35 MB of free space on the client computer.

3. (Option) Type the number of the option to install a language support package. 

4. Type the number of the option to install a language support package. For 
example:

• LGTOfr (French)

• LGTOja (Japanese)

• LGTOko (Korean)

• LGTOzh (Simplified Chinese)

5. (Optional) Type the a number of the option to install the man pages (LGTOman).

Note: If installing additional NetWorker software packages (storage node, server) to a 
NetWorker client that has processes running (for example, the nsrexecd process), an RPC 
error is reported. Before each software package is installed, the NetWorker software 
requires all NetWorker processes be shutdown. The RPC error is generated because the 
nsr_shutdown process attempts to stop NetWorker server processes when in fact no 
NetWorker server is running. This error message can be ignored and the installation 
process completes successfully. 

During the pkgadd process, ensure that no NetWorker processes are running. Do not 
start the NetWorker daemons until the final package is installed.

Storage node
To install the NetWorker software on the computer that is designated as the 
NetWorker storage node and for which you have purchased an enabler code:

1. Type the following command:

pkgadd -d /cdrom/cdrom1/solaris

2. Type the appropriate options to install the following packages. 

Software packages on the storage node must be installed in this order:

a. LGTOclnt (client software package)

b. LGTOnode (storage node software package)

c. LGTOman (optional man pages)
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3. Type the number of the option to install a language package. For example:

• LGTOfr (French)

• LGTOja (Japanese)

• LGTOko (Korean)

• LGTOzh (Simplified Chinese)

Dedicated Storage Node in a Solaris 10 local zone

In NetWorker version 7.5, and earlier, you cannot install and run a NetWorker 
Dedicated Storage Node (DSN) in a Solaris 10 local zone to direct the backup data 
stream directly to a physically attached device that avoids sending backup data 
across the network. 

However, NetWorker version 7.6 does support DSN installed in a Solaris 10 local 
zone to backup directly to a physically attached device without sending data across 
the IP network. It manages the sharing of a device between multiple dedicated 
storage nodes or storage nodes that are installed in multiple local zones of a single 
physical host, as long as all are contained within a single NetWorker data zone.

Server
To install the NetWorker software on the computer that is designated as the 
NetWorker server:

1. Keep a copy of the current configuration. The NetWorker software installation 
script modifies the /etc/rpc and /etc/syslog.conf files during the installation 
process.

Type these commands:

cp /etc/rpc /etc/rpc.old
cp /etc/syslog.conf /etc/syslog.conf.old

2. Type this command:

pkgadd -d /cdrom/cdrom1/solaris

3. Type the appropriate options to install the following packages. 

Software packages on the server must be installed in the following order:

a. LGTOclnt (client software package)

b. LGTOnode (storage node software package) 

c. LGTOserv (server software package)

d. LGTOman (optional man pages)

e. LGTOlicm (optional NetWorker License Manager software package)

The NetWorker License Manager Installation and Administration Guide provides 
information about the NetWorker License Manager software.

4. Type the number of the option to install a language support package. For 
example:

• LGTOfr (French)

• LGTOja (Japanese)

• LGTOko (Korean)

• LGTOzh (Simplified Chinese)
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Console server
To manage the NetWorker server, install the NetWorker Console and NetWorker 
client software on one machine in the datazone. The Console server installation relies 
on the existence of several other components. Ensure that all installation prerequisites 
are met. “Console” on page 31 provides details.

Note: If the environment runs only LDAPS, also known as LDAP over SSL, and native 
NetWorker user authentication is not used, the Console server must not be installed on a 
Solaris server.

To install NetWorker software on the computer that is designated as the NetWorker 
Console server:

1. Ensure that JRE version 1.6.0 or later is installed. This enables the command line 
reporting feature. If the required JRE version is not installed, go to the Java 
website to download and install the required version.

a. If the NetWorker software was downloaded from the web, type this command 
to verify that execute permissions are applied to the JRE file. 

For example:

chmod +x /tmpdir/jre-1_6_0-solaris-sparc.sh

The jre-1_6_0-solaris-sparc.sh creates an install directory in the working 
directory where it is run.

b. Change to the directory where the JRE is to be installed.

c. Run this script:

tmpdir/jre-1_6_0-solaris-sparc.sh

d. Accept the Java licensing agreement.

Note: Java WebStart is a caching mechanism for web deployed applications such as 
NMC. If cache is disabled in the Java options, WebStart will fail. To verify that Keep 
temporary files on my computer is enabled (default), in Control Panel > Java > 
General > Temporary Internet Files > Settings > Keep temporary files on my 
computer. Click the checkbox to enable temporary internet file caching if it is not 
checked.

2. Start the NetWorker software installation:

pkgadd -d /cdrom/cdrom1/solaris

Note: Do not press Enter for the default response All. Accepting the default installs the 
server.

3. Type the appropriate option number to install the client package (LGTOclnt), if 
not already installed.

The client package temporarily requires 35 MB of free space on the client 
computer.

4. Type the appropriate option number to install the Console server package, 
LGTOnmc.
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5. (Optional) Type the appropriate option number to install the man pages 
(LGTOman).

• LGTOfr (French)

• LGTOja (Japanese)

• LGTOko (Korean)

• LGTOzh (Simplified Chinese)

6. Specify the directory to install the LGTOnmc package (for example, 
/opt/LGTOnmc).

7. Specify a User/Group with limited privileges that NMC will use to run the web 
server. This must be a non-root user. For example, Solaris operating systems have 
a default user/group [nobody/nobody] that can be used.

Note: If the default group [nobody/nobody] does not exist, and a user/group is not 
created with limited privileges, follow the Console server requirements specified in the 
section “Console” on page 31.

8. For the web server port number, use the default port number (9000) or use a 
custom port number. Valid port numbers are between 1024 and 49151.

9. For the Console server, use the default port number (9001) or use a custom port 
number. Valid port numbers are between 1024 and 49151.

Note: Do not use port numbers that are already in use. Port 2638 is reserved by the Console 
server as it uses Tabular Data Stream (TDS) protocol to communicate with the database. 
Port 9002 is the preferred port for the EMC Backup Advisor product.

10. Specify the directory to use for the LGTOnmc database (for example, 
/export/home/lgto_gstdb).

11. Specify the location of the NetWorker binaries (for example, /usr/sbin).

12. Start the NetWorker Console daemons:

/etc/init.d/gst start

The NetWorker Console daemons include the following:

• gstd

• dbsrv9

• httpd (2 or more processes)

• gstsnmptrapd (optional daemon) for managing integrated Data Domain 
backups.

13. If the Console server and the NetWorker server are installed on separate hosts, 
you must add the Console administrator to the administrator lists of the 
monitored NetWorker server. This enables the Console administrator to 
administer and monitor the target NetWorker server. 
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On the NetWorker server:

a. Specify the process owner of the Console daemon process depending on 
which host contains the Console server: 

– If on a Microsoft Windows host, type:
nsraddadmin -u "user=SYSTEM, host=console_host"

– If on a AIX, HP-UX, Linux or Solaris only host, type:
nsraddadmin -u "user=root, host=console_host"

b. Specify the Console administrator user:

nsraddadmin -u "user=administrator, host=console_host"

where console_host is the Console server hostname.

Launch the Java Web Start if the NMC GUI fails to start
When the NMC installation is complete and the NMC client GUI starts, a message 
indicates that Java is loading before the NMC console opens. If the NMC console does 
not open, Java Web Start may have failed to load, due to a corrupted Java Web Start 
cache or an incompatible version of Java Web Start. To resolve the issue, it is 
recommended to clean up the $HOME/.java cache location.

Perform these steps to load Java Web Start:

1. Run setenv or export HOME if not set:

cd $HOME

2. Move or remove the $HOME/.java directory:

mv .java .java_orig

3. Navigate to JRE HOME and launch javaws. Reconfigure the Java Web Start 
preference if necessary. A new $HOME/.java will be created:

javaws [-viewer]

Note: Only JRE version 1.6 is supported.

4. If step 3 is successful, restart the web browser to launch the NMC GUI client.

Install the NetWorker software to a nondefault location
By default, the following NetWorker software is installed in the /usr directory. If 
there is insufficient disk space on the /usr partition, the following NetWorker 
packages can be relocated to a specified directory on another partition:

◆ LGTOclnt (client software package)

◆ LGTOnode (storage node software package)

◆ LGTOserv (server software package)

◆ LGTOfr (French)

◆ LGTOja (Japanese)

◆ LGTOko (Korean)

◆ LGTOzh (Simplified Chinese)
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By default, the NetWorker Console server software is installed in the /opt directory. If 
there is insufficient disk space on the /opt partition, the NetWorker Console server 
package, LGTOnmc can be relocated to a specified directory on another partition.

The NetWorker man pages package (LGTOman) must always be installed in the 
default location. Table 8, “UNIX location and space requirements,” on page 28 
provides a listing of the default locations and size requirements 

Note: Do not relocate any of the packages if NetWorker Module software is already installed on 
the computer.

To install the NetWorker packages to a nondefault location:

1. Create a symbolic link between the default NetWorker location and the 
nondefault NetWorker location. For example:

ln -s /my_path/lib/nsr /usr/lib/nsr

2. Copy the /var/sadm/install/admin/default file, as shown:

cp /var/sadm/install/admin/default /tmp/default.tmp

3. Edit the /var/sadm/install/admin/default file and change the value assigned to 
the basedir variable from default to ask, as shown:

basedir=ask

4. Create a directory and the bin and sbin subdirectories to install the NetWorker 
packages, for example:

mkdir -p /my_path/sbin
mkdir -p /my_path/bin

5. Modify the root PATH variable to include the bin and sbin subdirectories of the 
directory just created, for example:

/my_path/bin:/my_path/sbin

6. Type this command:

pkgadd -d /cdrom/cdrom1/solaris

When this prompt appears in the script, type the same base directory for all the 
relocated packages:

Enter path to package base directory (default: /usr) [?,q] /my_path
Using /my_path as the package base directory.

7. When all the applicable packages are added and the prompt appears, press [q] to 
exit.

8. Copy the /tmp/default.tmp file to the following location. For example:

cp /tmp/default.tmp /var/sadm/install/admin/default

If pkgrm is used to remove the packages at a later date, specify the base directory.
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Task 2: Change the NetWorker servers with access to a client

To limit the servers authorized to access a client, specify a list of trusted NetWorker 
servers for a client in the /nsr/res/servers file. After installing the client, storage node, 
and server software, use the following procedure to change theNetWorker servers 
that are authorized to access a client.

To change which NetWorker servers can access a client:

1. Type this command to shut down the NetWorker daemons:

nsr_shutdown

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that require access to the client. The first entry in this file becomes the 
default NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to: 
- Access and back up the client.
- Perform a directed recovery to the client.

3. If necessary, remove the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. Running nsrexecd with the -s option supersedes the 
/nsr/res/servers file:

a. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. The boot-time startup file for the Solaris environment is 
/etc/init.d/networker.

b. If the -s option exists in the boot-time startup file, remove all occurrences of 
this in the startup file:

-s server_name

Task 3: Start the NetWorker daemons
The NetWorker daemons must be started after the installation procedure. 

1. Start the NetWorker daemons by using this command: 

/etc/init.d/networker start

2. Verify that the NetWorker daemons are running:

ps -ef | grep nsr

3. If the output does not list nsrd and nsrexecd as current processes, run the 
following command to start the NetWorker daemons on the NetWorker server:

/etc/init.d/networker start

The NetWorker daemon nsrmmd is only present if one or more devices are 
enabled.

Note: The UTF-8 converters available with the operating system might need to be installed.
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Table 34 on page 126 lists the NetWorker daemons that should be running. 

Note: The NetWorker nsrmmd daemon is only present if one or more devices are enabled. The 
nsrmmgd and nsrlcpd daemons are only present on the server if the library is enabled.

HomeBase Agent installation
The Homebase agent enables Bare Metal Recovery (BMR) for server system data. 
NetWorker release 7.6 and later ships with the EMC HomeBase Agent version 6.2.x 
and installs it automatically. 

Note: Ensure that there is enough disk space for the HomeBase Agent binaries during the 
NetWorker installation. Details on the amount of space required for the HomeBase Agent is 
available in the HomeBase Agent Installation and Configuration Guide.

The NetWorker software also supports version 6.4 of the Homebase Agent. 
Information about upgrading to and configuring the Homebase 6.4 agent is available 
in the HomeBase Agent Installation and Configuration Guide. Information on BMR 
recovery is available in the HomeBase Recovery and Migration Guide.

IMPORTANT!
The Homebase Agent client version that you use, requires that the equivalent 
Homebase Server version be installed in order for BMR to function in the 
NetWorker 7.6 and later environment. 

The HomeBase Agent collects configuration information about the operating system 
platform of the host on which it is installed. This information is called a profile.

A profile can be used to:

◆ Monitor configuration changes

◆ Migrate configuration changes

◆ Recover the operating system’s configuration from an EMC HomeBase Server

The profile data includes hardware configurations, operating system levels, system 
tuning, network configuration and connections, security, and storage layouts. This 
information is captured with a NetWorker save set backup and is sent to a secure 
HomeBase Server for storage and analysis. The HomeBase Server is also required to 
perform a BMR server recovery or migration.

Table 34 NetWorker daemons

NetWorker installation packages NetWorker daemons

server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, nsrjobd, 
nsrmmgd, nsrlcpd

client nsrexecd

storage node nsrexecd, nsrmmd, nsrlcpd

NetWorker License Manager lgtolmd
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Note: On Solaris, an additional screen warns that a particular level of operating system patch 
must be installed prior to installing the agent. The server may already have these patches 
installed. The installer does not verify that the patches are installed. Failure to install the 
identified patches can result in the installation failing or the execution of the agent to fail.

The following documents provide information about the HomeBase Server features:

◆ EMC HomeBase Server Installation and Administration Guide

◆ EMC HomeBase Server User Guide

HomeBase Agent space requirements
Table 35 on page 127 specifies the location and space requirements for the HomeBase 
Agent.

Enable BMR server support
Connection with a HomeBase Server is enabled during the set up of the NetWorker 
server. This connection enables the delivery of profile data from the NetWorker client 
to the HomeBase Server.

To enable BMR support:

1. From the Administration window, click Configuration.

2. Select the NetWorker server name.

3. From the File menu, select Properties.

4. In the Properties dialog box, click the Configuration tab.

5. Type the IP address or hostname for the HomeBase Server in the BMR server 
field.

6. Click OK.

Note: The HomeBase Server SSL protocol must be configured and activated on the HomeBase 
Server. The EMC HomeBase Server Installation and Administration Guide provides information 
about enabling the SSL protocol.

License the HomeBase Server and Agent
This section provides details for licensing the HomeBase Server, and HomeBase 
Agent software.

The EMC HomeBase Server Installation and Administration Guide, and the The EMC 
HomeBase Agent Installation and Configuration Guide provides complete details on 
licensing the HomeBase software.

Table 35 HomeBase Agent location and minimum system 
requirements

NetWorker files Location

Space Processor

x86 x64

EMC HomeBase Agent binary /opt/homebase-agent/ 512 MB 512 MB 1 GHz

Temporary space required for 
EMC HomeBase Agent

/tmp 512 MB 512 MB 1 GHz
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HomeBase Server
The HomeBase server software comes with a 30 day evaluation enabler for the 
HomeBase Server with 20 HomeBase Agent licences. 

Note: Be sure to permanently enable the HomeBase Server and Agent licenses, as they expire 
after 30 days with no grace period.

During the installation of the HomeBase Server, a license request file is automatically 
generated in the keys directory. The license request is then forwarded to 
licensing@emc.com with all required purchase order details. 

Copies of the following are then sent:

◆ licence.zip file (the HomeBase Server licence)

◆ homebase.bks file (a set of encryption keys used for the recovery and replication 
of profiles between HomeBase Servers) 

◆ Agent licence batch files (there can be multiple agent licence batch files) that are 
associated with the HomeBase Server licence.

The default temporary enablers can be overridden by applying a permanent enabler 
and Agent licence batch to the HomeBase Server when the HomeBase Server Console 
is first accessed.

HomeBase Agent
When a HomeBase Agent is installed with the NetWorker software, the Agent license 
is provided automatically during the first profile run from the NetWorker software as 
it must be able to contact the HomeBase Server to forward profiles for backups. The 
-L setting in the NetWorker client BMR configuration setting is used to do this.

The EMC HomeBase Server Installation and Administration Guide provides details on 
how to license the HomeBase Agent for a Remote HomeBase Server.

Use the NetWorker client port under a firewall server
If the NetWorker client and HomeBase Agent are on the same system outside of the 
firewall with the HomeBase Server inside the firewall, then port 18821 is required for 
communication between the HomeBase Agent and the HomeBase Server.
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Uninstall the NetWorker software
Use the pkgrm command to uninstall individual NetWorker packages or all of the 
NetWorker packages simultaneously:

This section provides instructions for the following:

◆ “Software dependencies” on page 129

◆ “Uninstall the NetWorker software” on page 129

◆ “Uninstall the HomeBase Agent” on page 131

Software dependencies

The NetWorker software packages depend on each other. Uninstall them in this 
order:

1. LGTOserv

2. LGTOnode

3. LGTOnmc

If the Console server software is installed (LGTOnmc), there is a dependency on 
the NetWorker client software and the Console server software must be 
uninstalled first.

4. LGTOlicm

If the NetWorker License Manager software is installed, there is a dependency on 
the NetWorker client software and the NetWorker License Manager software 
must be uninstalled first.

5. LGTOclnt 

6. LGTOman 

7. LGTOfr (French language support package)

8. LGTOja (Japanese language support package)

9. LGTOko (Korean language support package)

10. LGTOzh (Simplified Chinese language support package)

Note: The man pages and document files have no dependencies and can be uninstalled at any 
time.

Uninstall the NetWorker software
To remove the NetWorker software packages:

1. Log in as root on the system where the software is being removed.

2. Type this command to shut down the NetWorker daemons:

nsr_shutdown

A list of NetWorker daemons that will be shut down appears, along with a 
prompt that asks whether to continue with the nsr_shutdown command.
Uninstall the NetWorker software 129



Solaris Installation
3. Type this command to shut down the Console server:

/etc/init.d/gst stop

4. Remove the software:

• To remove all the packages, type this command:

pkgrm LGTOserv LGTOnode LGTOnmc LGTOlicm LGTOclnt LGTOman

Note: Do not choose the default option All to remove the NetWorker software 
packages. Choosing this option removes all the software packages (not just NetWorker 
software) that were installed on the computer by using the pkgadd utility.

• To remove only select the NetWorker packages, see Table 36 on page 130.

5. If you no longer to plan to update or reinstall the NetWorkersoftware:

a. Remove the /nsr directory.

b. Delete the NMC directory. By default, NMC is installed at /opt/LGTOnmc.

c. Delete the directory containing the following NMC database files:

– lgto_gst.db
– lgto_gst.log
– gstd_db.conf

6. If the Java Runtime Environment is no longer required, uninstall the JRE.

Table 36 NetWorker packages to uninstall 

To uninstall these NetWorker packages Type this command and package name

Server pkgrm LGTOserv

Storage node pkgrm LGTOnode

Console server pkgrm LGTOnmc

Note: The LGTOnmc package must be uninstalled before the 
LGTOclnt package.

NetWorker License Manager pkgrm LGTOlicm

Client software pkgrm LGTOclnt

Man pages pkgrm LGTOman

Note: This removes the LGTOman package from the server, 
storage node, or client where the man pages are installed.

French language support pkgrm LGTOfr 

Japanese language support pkgrm LGTOja 

Korean language support pkgrm LGTOko 

Simplified Chinese language support pkgrm LGTOzh
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Uninstall the HomeBase Agent

To uninstall the HomeBase Agent, use the HomeBase uninstall program. The 
HomeBase Agent Installation and Configuration Guide provides complete details on 
uninstalling the HomeBase Agent.
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Install the NetWorker software
Complete these tasks to install the NetWorker software:

◆ “Task 1: Install the client, storage node, and sever software” on page 134

◆ “Task 2: Change the NetWorker servers with access to a client” on page 135

◆ “Task 3: Start the NetWorker daemons” on page 136

Task 1: Install the client, storage node, and sever software

The following sections describe how to install the software on the client, storage 
node, and server.

Client installation
To install NetWorker software on the computer that is designated as the client:

1. Change to the directory that contains the NetWorker software:

setld -l 

2. Select and install the client package.

3. Respond to the prompts as required.

Note: The PATH environment variable for the user root on the NetWorker server and the user 
on each NetWorker client must contain the directory where the NetWorker executables reside 
(/usr/opt/networker/bin).

Storage node installation
The storage node contains the device driver files, installed in 
/usr/opt/networker/bin.

To install NetWorker software on the computer that is designated as the NetWorker 
storage node and for which you have purchased an enabler code:

1. Change to the directory that contains the NetWorker software:

setld -l

2. Select and install these software packages:

• Client

• Storage node

3. Respond to the prompts as required. 

Server installation
To install NetWorker software on the computer that is designated as the NetWorker 
server:

1. Keep a copy of the current configuration. The NetWorker software installation 
script modifies the following files during the installation process:

• /etc/rpc

• /etc/syslog.conf

2. Determine if the packages that are required to run the NetWorker software are 
installed on the computer. For example:

setld -i | grep package_identifier
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If the package is not installed, load the missing package or patch before installing 
NetWorker software. The following tables provide a list of the package names:

• Table 4, “HP Tru64 UNIX: required client software,” on page 24

• Table 11, “HP Tru64 UNIX required server and storage node software,” on 
page 30

3. Ensure that there is enough free space to install these software packages:

• Client

• Storage node

• Server

4. Change to the directory where the NetWorker software is installed, and type:

setld -l

If the /nsr directory still exists, it will be reused. If not, there will be a prompt to 
provide a new location for the /nsr directory. The default location is /var/nsr. 

5. At the prompt, choose option 5 to install all of the packages on the server. Install 
all of the NetWorker software on the server simultaneously.

Software packages on the server must be installed in the following order:

a. Client software

b. Storage node software

c. Server software

d. NetWorker License Manager software

e. (Optional) man pages or reference pages

Note: The PATH environment variable for the root user on the NetWorker server and the user 
on each NetWorker client must contain the directory where the NetWorker executables reside 
(/usr/opt/networker/bin).

Task 2: Change the NetWorker servers with access to a client

To limit the servers authorized to access a client, specify a list of trusted NetWorker 
servers for a client in the /nsr/res/servers file. After installing the client, storage 
node, and server software, use the following procedure to change the NetWorker 
servers that are authorized to access a client.

To change which NetWorker servers can access a client:

1. Type this command to shut down the NetWorker daemons:

nsr_shutdown

2. Edit or create the /nsr/res/servers file and add the set of NetWorker servers, one 
per line, that require access to the client. The first entry in this file becomes the 
default NetWorker server.

Note: If the /nsr/res/servers file is empty or does not exist, any NetWorker server is 
authorized to:
- Access and back up the client.
- Perform a directed recovery to the client.
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3. If necessary, remove the -s option from the nsrexecd command that is invoked by 
the boot-time startup file. Running nsrexecd with the -s option supersedes the 
/nsr/res/servers file:

a. Check the NetWorker boot-time startup file to see whether nsrexecd is being 
run with the -s option. 

The boot-time startup file is /sbin/init.d/NSRstartstopstart.

b. If the -s option exists in the boot-time startup file, remove all occurrences of 
this in the startup file: 

-s server_name

Task 3: Start the NetWorker daemons

The NetWorker daemons must be started after the installation procedure.

1. Start the NetWorker daemons:

/sbin/init.d/NSRstartstop start

2. Type this command:

ps -ef | grep nsr

Table 37 on page 136 lists the NetWorker daemons.

Note: The NetWorker nsrmmd daemon is only present if one or more devices are enabled. The 
nsrmmgd and nsrlcpd daemons are only present on the server if the library is enabled.

Table 37 Daemons

NetWorker packages NetWorker daemons

NetWorker server nsrd, nsrexecd, nsrindexd, nsrmmdbd, nsrmmd, nsrjobd, nsrmmgd, nsrlcpd

NetWorker client nsrexecd

NetWorker storage node nsrexecd, nsrmmd, nsrlcpd
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Uninstall the NetWorker software
Individual NetWorker packages or all of the NetWorker packages can be removed 
simultaneously.

To uninstall the NetWorker software packages:

1. Log in as root.

2. Type this command to shut down the NetWorker daemons:

nsr_shutdown

A list of NetWorker daemons to be shut down appears, along with a prompt that 
asks whether to continue with the nsr_shutdown command.

3. Determine the NetWorker packages installed on the computer:

setld -i | grep LGTO

4. Type these commands to remove the software:

• To uninstall all the packages, type:

setld -d LGTOSERVxxx LGTONODExxx LGTOLICMxxx LGTOCLNTxxx 
LGTOMANxxx

where xxx represents the version of NetWorker software installed on the 
system.

Note: The NetWorker software packages depend on each other. Remove them in the 
following order:
1. Server
2. Storage node
3. NetWorker License Manager
4. Client
The man pages, language packages, and documentation files have no dependencies. 
They can be removed any time.

• To remove only specific NetWorker packages, see Table 38 on page 137. 

5. If you no longer to plan to update or reinstall the NetWorker software:

a. Remove the /nsr directory.

Table 38 NetWorker packages to uninstall

To uninstall these NetWorker packages Type this command and package name

Server setld -d LGTOSERVxxx

Storage node setld -d LGTONODExxx 

NetWorker License Manager setld -d LGTOLICMxxx

Man pages setld -d LGTOMANxxx

Client setld -d LGTOCLNTxxx

Note: Always uninstall these software packages before 
uninstalling the client software:
1. Server
2. Storage node
3. NetWorker License Manager
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b. Delete the NMC directory. By default, NMC is installed at /opt/lgtonmc.

c. Delete the directory containing the NMC database files lgto_gst.db and 
lgto_gst.log.

6. If you no longer require the Java Runtime Environment, uninstall the JRE.
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Install the NetWorker software
On windows, be sure to use the NetWorker installer to install both the NetWorker 
software and the NetWorker Management Console: 

1. Click autorun.exe. 

2. Select Install EMC NetWorker 7.6.1 software.

Note: Do not use Control Panel > Add or Remove Programs to install or uninstall the 
NetWorker or the NetWorker Management Console packages. 

Complete these tasks to install the NetWorker software:

◆ “Task 1: Install the NetWorker software” on page 140

◆ “Task 2: Install the Console software” on page 142

◆ “Task 3:Optional install the HomeBase Agent” on page 145

Task 1: Install the NetWorker software
This section provides instructions for installing the following NetWorker software:

◆ Client

◆ Storage node

◆ Server

◆ NetWorker language pack support

◆ NetWorker License Manager

◆ HomeBase Agent

◆ ConnectEMC

Note: Install the Console server software on one computer in your datazone to manage the 
NetWorker server. Only one installation of the NetWorker Console server is required to 
manage multiple NetWorker servers. “Task 2: Install the Console software” on page 142 
provides details.
Install the NetWorker License Manager with any of the NetWorker software components. The 
NetWorker client must be installed before the NetWorker Management Console software.

To install NetWorker software:

1. Verify that the target computer satisfies the requirements. The section “Console” 
on page 31 provides details.

2. Log in with administrator privileges to the target computer for the NetWorker 
software installation.

3. If Autorun did not automatically start the installation, double-click the setup.exe 
file, then click Run when prompted.

4. In the Choose Setup Language page, select a language type. The Welcome to 
NetWorker Installation page appears. Click Next.

Note: You cannot de-select the English language package.

5. In the Customer Information page, fill in the appropriate information and click 
Next.
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6. In the Windows XP Firewall page, select Configure the Windows XP client-side 
firewall.

Note: If the firewall is not configured for NetWorker, scheduled backups will not function.

7. In the Installation Type and Location page, make the following selections and 
click Next:

• Select the Client, Storage Node, or Server and Client option.

• To install the NetWorker software in a location other than the default location, 
click Change and specify the installation path.

• To install the Language Packs software, select the checkbox.

• To install the NetWorker License Manager software, select the checkbox.

• To install the HomeBase Agent software, select the checkbox.

• To install the NetWorker Management Console software, select the checkbox.

• Verify the location for the installation files is the desired location, then click 
Next.

8. ConnectEMC is a console program that polls previously stored information from 
the RAP database, such as server errors and system configuration, and it creates 
an xml file with this data once per month. The file is then sent to EMC Corporate 
Customer Service.

Observe the following best practices when installing ConnectEMC:

• It is strongly recommended that ConnectEMC not be installed on an existing 
Windows NetWorker server or storage node. Folder permissions might not 
allow for the creation of the data files required by ConnectEMC installations.

• If upgrading a NetWorker 7.4 Service Pack 3 or earlier client on Windows and 
installing ConnectEMC, it is strongly recommended that the previous version 
of NetWorker client be uninstalled and that the Legato/nsr/tmp folder be 
deleted prior to installing the new NetWorker client and ConnectEMC.

• Only one instance of ConnectEMC should be installed in a NetWorker 
datazone.

• An instance of ConnectEMC can only be configured to query one NetWorker 
server.

• The minimum NetWorker server version required to support ConnectEMC is 
NetWorker 7.6 and later. Previous versions of the NetWorker server are not 
able to launch nsrconnect.

• Currently, ConnectEMC can only be installed on a 32-bit Windows system. 
Install ConnectEMC on one of the 32-bit Windows systems in the NetWorker 
datazone.

Note: The ConnectEMC software is installed by default under C:\Program Files. You 
cannot specify a non-default path for the ConnectEMC software installation.

9. On a Windows x86 system, the ConnectEMC Installation page is displayed:

• Select the Install ConnectEMC checkbox.

• Type the Name or IP address of the NetWorker server in the appropriate field, 
then click Next.
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Note: Make sure that the specified NetWorker server is running during the 
ConnecEMC installation. If the NetWorker server is not running, the installation fails.

When ConnectEMC is installed, an icon for ConnectEMC Console is placed on the 
desktop. Post-installation instructions for configuring ConnectEMC are provided 
in the NetWorker 7.6 Service Pack 1 Administration Guide.

10. If required, in the Feature Selection page, select a language pack.

11. If the server is installed, the License Agreement page appears. Review the license 
agreement, select I accept the terms in this license agreement, and then click 
Next.

12. The installation program is ready to install. In the Ready to Install the Program 
page, review the settings and click Install.

13. In the NetWorker Server Selection page, select the NetWorker servers that can 
perform backups and directed recoveries for this client: 

• To add a NetWorker server that is not listed in the Available Servers list, type 
the name of the server in the Enter a server name text box and click Add. 

• To browse for available NetWorker servers, click Update List. Select a 
NetWorker server from the Available Servers list.

• To add or remove NetWorker servers from the Available Servers list to the 
Selected Servers list, use the arrow buttons.

Note: If the Selected Servers list is left empty, any NetWorker server can perform backups and 
directed recoveries of this computer’s data. This might affect the security of your data. 
“Maintain a NetWorker software installation” on page 52 describes how to change the Selected 
Servers list after installation.

For Windows Server 2003, Windows XP Professional, or Windows 2000, there is a 
prompt to run the Change Journal Manager. The NetWorker administration guide 
provides information about configuring NetWorker software to use the Windows 
Change Journal.

IMPORTANT!
For a Windows Server 2003 installation, be sure to install the latest Microsoft VSS 
roll-up fix. To view more information on the roll-up fix and to download the 
package appropriate to the operating system, go to the Microsoft knowledge base 
article at http://support.microsoft.com/kb/940349.

Task 2: Install the Console software
Install the Console server software on one computer in the datazone to manage the 
NetWorker server. Only one installation of the Console server is required to manage 
multiple NetWorker servers. 

Perform either of these steps:

◆ “Install the NetWorker Management Console software on the Windows” on 
page 143

◆ “Install the NetWorker software on the Windows 2008 Server Core” on page 144
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Note: If the NetWorker Management Console software installation option was selected in the 
Installation Type and Location page, the Console software is installed after the NetWorker 
software. The Console installation relies on the existence of several other components. Ensure 
that all of the installation prerequisites are met. The section “Console” on page 31 provides 
details.

Install the NetWorker Management Console software on the Windows
To install the Console:

1. In the Welcome to NetWorker Management Console Installation page, click 
Next.

2. In the Customer Information page, fill in the appropriate information and click 
Next.

3. In the Product Setup page:

a. To install the software in the default directory, click Next.

b. To install the software in a different directory, click Change and navigate to or 
type a new destination.

Note: The estimated disk space required for the Console components is 270 MB.

If the Setup wizard detects that there is insufficient disk space to install the 
software, another dialog box appears listing the local drives, and highlighting the 
drive with insufficient disk space. The list also displays disk size, available space, 
and required space, which allows the selection of an appropriate drive on which 
to continue the installation.

4. Specify a User/Group with limited privileges that NMC will use to run the web 
server.

Note: If a default group that can be used, or is not created a user/group with limited 
privileges does not exist, follow the Console server requirements specified in the section 
“Console” on page 31

5. In the Configuration Options page, indicate the Database Destination path, the 
IP port numbers to use for the embedded HTTP server, and the Client Service 
port: 

• To change the default database path, select Change.

• To use the default port numbers, type 9000 for the HTTP server and 9001 for 
the Client Service port.

• To use different port numbers, type the new port numbers (between 1024 and 
49151).

Note: Port 2638 is reserved by the Console software as it uses the TDS protocol to 
communicate with the database. Port 9002 is the preferred port for EMC Backup Advisor 
product.

6. Review information in the Product Configuration Summary page and click Next. 

7. In the Ready to Install the Program page, click Install.

a. Select the checkbox (the default is selected) to launch the client in the default 
browser immediately after exiting the InstallShield Wizard.

b. Click Finish to exit the InstallShield Wizard.
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When the installation is complete, the NetWorker Management Console Setup 
Completed page appears. The box shows where the install.log file and gstd.log 
file can be viewed. It also gives the browser URL to use to start the Console 
software from any desktop. 

8. When the client launches, if a supported version of Java cannot be detected on the 
host, a message appears with instructions on how to install the appropriate 
version of Java. The JRE is required on the Console Client host to run the Console 
GUI. The JRE is optional on the Console Server host, and is only required for 
running command line reports.

• Follow the instructions to install the JRE version 1.6 software.

Note: Only JRE version 1.6 is supported.

• If the required JRE version is already installed, click the appropriate link to 
start the NetWorker Management Console. 

• For a 64-bit Windows host, install the 32-bit JRE version.

Note: Java WebStart is a caching mechanism for web deployed applications such as 
NMC. If cache is disabled in the Java options, WebStart will fail. To verify that Keep 
temporary files on my computer is enabled (default), in Control Panel > Java > 
General > Temporary Internet Files > Settings > Keep temporary files on my 
computer. Click the checkbox to enable temporary internet file caching if it is not 
checked.

9. If the Console server and the NetWorker server are installed on separate hosts, 
add the Console administrator to the administrator lists of the monitored 
NetWorker server. This enables the Console administrator to administer and 
monitor the target NetWorker server. 

On the NetWorker server:

a. Specify the process owner of the Console daemon process depending on 
which host contains the Console server: 

– If on a Windows host, type:
nsraddadmin -u "user=SYSTEM, host=console_host"

– If on a AIX, HP-UX, Linux or Solaris only host, type:
nsraddadmin -u "user=root, host=console_host"

b. Specify the Console administrator user:

nsraddadmin -u "user=administrator, host=console_host"

where console_host is the Console server hostname.

Install the NetWorker software on the Windows 2008 Server Core

IMPORTANT!
In Windows 2008, the vcredist_x64.exe and vcredist_x86.exe files are required for 
the NetWorker software. Do not uninstall these files.

When installing the NetWorker software on the Windows 2008 Server Core, do not use 
autorun.exe as Windows Explorer is not available. Instead, from the command 
prompt use setup.exe located in the networkr directory:

1. Run the following command to begin the NetWorker installation:

c:\installdir\networkr>setup.exe
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where installdir is the location of the NetWorker software.

2. Complete the installation as described in “Install the NetWorker software” on 
page 140.

IMPORTANT!
The Console client GUI is not supported on the Windows 2008 Server Core. You 
can install the Console server, however you cannot launch the Console when you 
complete the steps within the Installation Wizard.

Task 3:Optional install the HomeBase Agent

The Homebase agent enables Bare Metal Recovery (BMR) for server system data. 
Although NetWorker release 7.6 and later is bundled with the EMC HomeBase Agent 
version 6.2.x, NetWorker also supports version 6.4 of the Homebase Agent. 
Homebase 6.4 is required for BMR of the following host operating systems:

◆ Windows Server 2008 R2

◆ Windows Server 2008 SP2

◆ Windows Server 2003 SP1 or later

◆ Windows Server 2003 R2 SP1 or later

To provide bare metal disaster recovery for NetWorker clients on these platforms, 
upgrade to the Homebase 6.4 agent.

To install the HomeBase Agent on Windows, click the HomeBase Agent checkbox 
during the NetWorker software installation.

Information about upgrading to and configuring the Homebase 6.4 agent is available 
in the HomeBase Agent Installation and Configuration Guide. Information on BMR 
recovery is available in the HomeBase Recovery and Migration Guide.

IMPORTANT!
The Homebase Agent client version that you use, requires that the equivalent 
Homebase Server version be installed in order for BMR to function in the 
NetWorker 7.6 and later environment. 

Create an HBA.bat file for HomeBase Agent 6.4 for Windows NetWorker clients
For BMR-enabled Windows NetWorker clients, generating profiling information 
using HomeBase Agent 6.4 fails.

If HomeBase Agent version 6.4 is installed and BMR profiling is enabled on the 
NetWorker client, BMR profiling generation fails with an error similar to this:

HBA: 'hba.bat' is not recognized as an internal or external command

To avoid profiling generation failure: 

1. Manually create an hba.bat file in the directory in which hba.exe is located. 

2. Include these lines in the hba.bat file:

@echo off
hba.exe %*
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HomeBase Agent space requirements
Table 39 on page 146 specifies the minimum system requirements for the HomeBase 
Agent.

Table 39 HomeBase Agent minimum system requirement

The HomeBase Agent collects configuration information about the operating system 
of the host on which it is installed. This information is called a profile.

A profile can be used to:

◆ Monitor configuration changes

◆ Migrate configuration changes

◆ Recover the operating system configuration from an EMC HomeBase Server

The profile data includes hardware configurations, operating system levels, system 
tuning, network configuration and connections, security, and storage layouts. This 
information is captured with a NetWorker save set backup and is sent to a secure 
HomeBase Server for storage and analysis. The HomeBase Server is also required to 
perform a BMR server recovery or migration.

The following documents provide information about the HomeBase Server features:

◆ EMC HomeBase Server Installation and Administration Guide

◆ EMC HomeBase Server User Guide

Enable BMR server support
Connection with a HomeBase Server is enabled during the set up of the NetWorker 
server. This connection enables the delivery of profile data from the NetWorker client 
to the HomeBase Server.

To enable BMR support:

1. From the Administration window, click Configuration.

2. Select the NetWorker server name.

3. From the File menu, select Properties.

4. In the Properties dialog box, click the Configuration tab.

5. Enter the IP address or hostname for the HomeBase Server in the BMR server 
field and then, click OK.

Note: The HomeBase Server SSL protocol must be configured and activated on the HomeBase 
Server. The EMC HomeBase Server Installation and Administration Guide provides information 
about enabling the SSL protocol.

License the HomeBase Server and Agent
This section provides details for licensing the HomeBase Server, and HomeBase 
Agent software. The EMC HomeBase Server Installation and Administration Guide, and 

Table 3. 

NetWorker files

Space CPU

x86 x64

EMC HomeBase Agent binary 512 MB 512 MB 1 GHz

Temporary space required for EMC HomeBase Agent 512 MB 512 MB 1 GHz
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the The HomeBase Agent Installation and Configuration Guide provides complete details 
on licensing the HomeBase software.

HomeBase Server
The HomeBase server software comes with a 30 day evaluation enabler for the 
HomeBase Server with 20 HomeBase Agent licences. 

Note: Be sure to permanently enable the HomeBase Server and Agent licenses, as they expire 
after 30 days with no grace period.

During the installation of the HomeBase Server, a license request file is automatically 
generated in the keys directory. The license request is then forwarded to 
licensing@emc.com with all required purchase order details. Copies of the following 
are then sent:

◆ licence.zip file (the HomeBase Server licence)

◆ homebase.bks file (a set of encryption keys used for the recovery and replication 
of profiles between HomeBase Servers) 

◆ Agent licence batch files (there can be multiple agent licence batch files) that are 
associated with the HomeBase Server licence.

The default temporary enablers can be overridden by applying a permanent enabler 
and Agent licence batch to the HomeBase Server when the HomeBase Server Console 
is first accessed.

HomeBase Agent
When a HomeBase Agent is installed with the NetWorker software, the Agent license 
is provided automatically during the first profile run from the NetWorker software as 
it must be able to contact the HomeBase Server to forward profiles for backups. The 
-L setting in the NetWorker client BMR configuration setting is used to do this.

The EMC HomeBase Server Installation and Administration Guide provides details on 
how to license the HomeBase Agent for a Remote HomeBase Server.

Using the NetWorker client port under a firewall server
If the NetWorker client and HomeBase Agent are on the same system outside of the 
firewall with the HomeBase Server inside the firewall, then port 18821 is required for 
communication between the HomeBase Agent and the HomeBase Server.
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Uninstall the software
This section provides instruction for the following:

◆ “Uninstall the NetWorker software” on page 148

◆ “Uninstall ConnectEMC” on page 149

◆ “Uninstall the Windows 2008 Server Core software” on page 150

◆ “Uninstall the HomeBase Agent” on page 151

◆ “Install or uninstall the NetWorker software by using SMS” on page 151

Uninstall the NetWorker software

Note: Uninstall the Console before uninstalling the rest of the NetWorker software. 
If NetWorker License Manager, and ConnectEMC is installed, it will be removed along with the 
NetWorker software components. To remove only the NetWorker License Manager and leave 
the other NetWorker components intact, skip this procedure. “Maintain a NetWorker software 
installation” on page 52 provides details.

To uninstall the NetWorker software and the language packages from a host computer:

1. Log in with administrator privileges to the target computer.

2. Stop all NetWorker programs and ensure that no other program, such as 
Windows Explorer, is accessing directories or files under NetWorker_install_path.

3. In the Windows Control Panel, select Add/Remove Programs.

4. In the Add/Remove Programs page, select NetWorker Management Console 
Server and click Remove.

All of the NetWorker Management Console Server is removed except for the JRE 
Java Web Start programs on which the Console is dependant. You can remove the 
Java programs through the Add/Remove Programs window separately. 

Note: On 64-bit Windows, if you select NetWorker Management Console to remove the 
NMC server, the error message "An error occurred while trying to remove NetWorker 
Management Console..." appears, but the uninstallation process is unaffected.

5. In the Add/Remove Programs page:

a. Select NetWorker.

b. Select one of the following options:

– Change — Launches the Setup program in Maintenance mode and 
performs a partial uninstallation of the NetWorker software leaving the 
NetWorker metadata.You can remove all the language packages except 
English in Maintenance mode.

– Remove — Performs a complete uninstallation of the NetWorker software. 
If you select Remove, click Yes when prompted to perform the 
uninstallation.

6. In the Maintenance Type dialog box, select Remove, and then click Next.
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Note: If the NetWorker software is uninstalled from Maintenance Mode and the Console is 
also installed, the Console will be uninstalled first, then the NetWorker software will be 
uninstalled.

7. In the Ready to Remove dialog box, ensure that the Remove NetWorker 
Metadata option is selected to remove all metadata (if not reinstalling the 
software), and then click Remove.

By default, the Remove NetWorker Metadata checkbox is clear to ensure that all 
of the NetWorker configuration files (such as client file indexes, media database, 
logs, and resource files) are retained for a future installation of the NetWorker 
software. This has the same effect as Partial Uninstallation in NetWorker releases 
prior to 7.0. If the Remove NetWorker Metadata checkbox is not selected, the 
following client and server files remain in the \Program Files\Legato\nsr 
directory after uninstall:

• Any logs that have been created

• Any deduplication data

• All index entries

• All mm entries

• All res files

• All files in the tmp directory

• All files in the debug directory

8. In the Ready to Remove dialog box, click Remove.

9. In the NetWorker Setup Complete dialog box, click Finish.

10. Remove the NetWorker Management Console shortcut icon from the desktop. 
Uninstalling the NetWorker software does not remove the NetWorker 
Management Console shortcut icon from the desktop, it must be removed 
manually.

11. If the NetWorker software is not being updated or reinstalled:

a. Remove the \nsr directory.

b. Delete the NMC directory. By default, NMC is installed at c:\program 
files\legato.

c. Delete the directory containing the NMC database files lgto_gst.db and 
lgto_gst.log.

12. If the Java Runtime Environment no longer required, uninstall the JRE.

IMPORTANT!
In Windows 2008, the vcredist_x64.exe and vcredist_x86.exe files are required for 
the NetWorker software. Do not uninstall these files.

Uninstall ConnectEMC
Uninstalling ConnectEMC in Maintenance mode is not supported.

To uninstall ConnectEMC: 

1. Run the uninst_connect.cmd script from the installation media (CD), or the 
/networkr sub-directory where the NetWorker software package is extracted.
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2. Re-install ConnectEMC in Maintenance mode if required. 

Complete details for installing ConnectEMC is available in step 9 of the 
NetWorker installation procedure.

Note: ConnectEMC is automatically uninstalled with the NetWorker software.

Uninstall the Windows 2008 Server Core software
To uninstall the software, perform one of the following:

◆ Run the setup.exe file from the NetWorker installation disk and select to uninstall 
the software in maintenance mode.

◆ Use the Windows Management Instrumentation command-line utility (wmic.exe) 
to access information about the NetWorker software and to uninstall it:

c:\>wmic product where name="NetWorker" uninstall 
Executing(\\ANGUR-W2K8-CORE\ROOT\CIMV2:Win32_Product.IdentifyingNu
mber="{37AD08
79-5B35-4A5C-9739-13302230CD8B}",Name="NetWorker",Version="7.6.0")
->Uninstall()
Method execution successful.
Out Parameters:
instance of __PARAMETERS
{
ReturnValue = 0;
};

Note: For uninstalling NMC, name="NetWorker Management Console Server" must be 
used.

The Microsoft Knowledgebase article 290216 provides more information on the 
wmic.exe utility. 

◆ Use wmic.exe with msiexec to discover the installation product name for the 
NetWorker software, and the location of the msi package on the server to 
uninstall the software:

1. Run the wmic.exe utility:

c:\>wmic product NetWorker get /value
AssignmentType=1
Caption=NetWorker
Description=NetWorker
HelpLink=http://customernet.emc.com
HelpTelephone=1-877-534-2867
IdentifyingNumber={37AD0879-5B35-4A5C-9739-13302230CD8B}
InstallDate=20091001
InstallDate2=
InstallLocation=C:\Program Files\Legato\nsr\
InstallSource=C:\Build 102\nw761_win_x86\win_x86\networkr\
InstallState=5
Language=0
LocalPackage=C:\Windows\Installer\48b213b.msi
Name=NetWorker
PackageCache=C:\Windows\Installer\48b213b.msi
PackageCode={76673145-1A42-4354-98F6-E56374F89004}
PackageName=NetWorker.msi
ProductID=none
RegCompany=
RegOwner=Windows User
SKUNumber=
Transforms=@1033.MST
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URLInfoAbout=http://software.emc.com
URLUpdateInfo=http://softwareforms.emc.com/resources/downloads/
Vendor=EMC Corporation
Version=7.6.1
WordCount=0

2. Use the msiexec utility to uninstall the product with the IdentifyingNumber:

c:\>wmic>msiexec /I {37AD0879-5B35-4A5C-9739-13302230CD8B}

3. In NetWorker maintenance mode, use remove to uninstall the software.

Uninstall the HomeBase Agent

Uninstalling the NetWorker client automatically uninstalls the HomeBase Agent.

Note: Uninstalling the HomeBase Agent manually is possible, but not recommended as BMR 
functionality is removed from the NetWorker software.

The HomeBase Agent Installation and Configuration Guide provides complete details on 
uninstalling the HomeBase Agent.

Install or uninstall the NetWorker software by using SMS
Thee Microsoft Systems Management Server (SMS) can be used to perform 
automated NetWorker software installations, or uninstallations over a network.

Note: For best results, do not configure the SMS server on a NetWorker server. The SMS server 
can be configured on a separate NetWorker client.

How to Install or Remove NetWorker Software by Using SMS

Note: For detailed instructions on performing SMS procedures, such as creating an installation 
package or deploying an installation job, refer to the Microsoft SMS documentation.

To install or remove the NetWorker software by using SMS:

1. Create a shared directory on a local disk on the SMS server. 

For example, create a shared directory called networkr.

2. Copy all files from the appropriate directory on the NetWorker CD-ROM to the 
directory created in step 1. 

For example, copy the files from \win_x86\networkr on the CD-ROM to the 
networkr directory on the SMS server.

3. Using the SMS Administrator Console, create an installation package from the 
NetWorker.sms package definition file located in the networkr directory.

Note: The NetWorker.sms file is intended to be used as starting point for a package 
definition. The Microsoft SMS documentation provides complete instructions on 
customizing the package definition for a specific environment.

4. Using the SMS Administrator Console, create an installation or uninstallation job 
for the package you created in step 3.

5. Deploy the installation or uninstallation job created in step 4.
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This chapter provides information about testing and verifying the NetWorker 
software installation. 

Verify the Installation
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Test the Installation
To verify that the NetWorker software was installed properly, you must first connect 
to a NetWorker server, configure a device, and then test the software on the device:

To test the software, perform these tasks:

◆ “Task 1: Start the Console for the first time” on page 154

◆ “Task 2: Add a NetWorker server to the Console server” on page 155

◆ “Task 3: Configure a stand-alone device” on page 156

◆ “Task 4: Test the NetWorker software installation” on page 157

Task 1: Start the Console for the first time
To run the Console, ensure that the Console server has been installed on a Solaris, 
AIX, HP-UX, Microsoft Windows or Linux host. You can not initiate a browser 
session from an Irix or HP Tru64 UNIX server. You can however, open a browser 
session with the Console from a Linux, Solaris, Microsoft Windows, HP-UX, or an 
AIX host.

These steps assume that the NetWorker software is installed and that all of the 
software and hardware requirements have been met on the computer that will access 
the Console. “NetWorker Management Console” on page 13 provides information 
about the Console.

How to start the Console the first time
To start the Console server software for the first time:

1. Verify that the console processes gstd, dbsrv9 and httpd are running on the 
NetWorker Management Console server.

Note: On Windows, httpd is registered as the EMC GST Web Service, and there are 
always two httpd processes running when the NMC server is active. On UNIX, there are 
two or more httpd processes running, where the parent httpd process runs as root and the 
child process(es) run as the user name specified during the installation.

2. Start a web browser session.

3. Type the URL of the Console server:

http://server_name:http_service_port

where:

• server_name is the name of the computer where the Console server component 
was installed.

• http_service_port is the port for the embedded HTTP server. The HTTP port is 
specified during installation. The default HTTP port is 9000. For example:

http://houston:9000

4. From the Welcome page, click Start. 

5. From the Security Warning screen, click Start to install and run NetWorker 
Console.

6. Type this command to start the Console server: For Solaris and Linux platforms, 
type

/etc/init.d/gst start
EMC NetWorker Release 7.6 Service Pack 1 Installation Guide154



Verify the Installation
For AIX, type:

/etc/rc.gst start

For HP-UX, type:

/sbin/init.d/gst start

7. If the appropriate JRE version is not already installed on the system, a prompt to 
install it appears. Follow the onscreen instructions to install JRE.

8. For users upgrading from a previous release, in the NetWorker Management 
Console Login dialog box, type the username and password.

On Windows only, once the JRE is installed, the Java Web Start Desktop 
Integration dialog box appears.

9. For the Windows platform only, complete the Java Web Start Desktop 
Integration dialog box by selecting one of the following options:

• To place a shortcut on the desktop, click yes.

• To decline having a shortcut placed on the desktop, click No.

• To have the option to decide later, click Ask Later.

Note: If upgrading from a previous release and prompted for a user and password, the 
default user is administrator and the default password for the administrator is 
“administrator”. For security purposes, this password should be changed during the first 
login session.

10. Click OK. The Console window and the Getting Started page appears.

How to start the Console after the first time
After the Console has been started the first time, start it later by using one of the 
following methods:

◆ Point the browser to the same URL as in “Task 1: Start the Console for the first 
time” on page 154.

◆ Double-click NetWorker Console in the Java Web Start Application Manager.

◆ On Microsoft Windows, double-click the desktop icon, if one was set up through 
the Java Web Start Application Manager.

Task 2: Add a NetWorker server to the Console server

To add and select a NetWorker server:

1. Start the NetWorker Console software.

2. From the Console window, click Enterprise.

3. From the left pane, select the Enterprise icon.

4. From the File menu, select New>Host. 

5. Type a hostname and alias for the NetWorker server, and the NetWorker server 
appears in both the right pane and left pane.

6. From the left pane, select the NetWorker server.
Test the Installation 155



Verify the Installation
7. From the right pane, select the NetWorker application.

8. From the Enterprise menu, select Launch Application, and the NetWorker 
Administration window launches.

If the server connection fails, refer to the server connectivity information in the 
NetWorker administrator guide to troubleshoot the problem.

Task 3: Configure a stand-alone device

Devices must be configured before testing the NetWorker software.

You can configure one of these devices:

◆ “Stand-alone tape device” on page 156

◆ “Stand-alone file or advanced file device” on page 156

◆ “Autochanger or silo” on page 157

The NetWorker administrator guide provides information about configuring a 
device.

Stand-alone tape device
To configure a stand-alone tape device:

1. In the server’s NetWorker Administration interface, click Devices.

2. From the left pane, select Devices.

3. From the left pane, select Storage Nodes.

4. Right-click the storage node for the device.

5. Select Scan for devices. The Scan for Devices window appears.

6. From the list, select the storage node to be scanned.

7. Click Start Scan after filling in the requested information. The new device 
appears in the right pane.

8. From the right pane, select the new device.

9. From the Devices menu, select Devices>Device Operations>Label. The Label 
window appears.

10. Verify the information in the Label window and click OK.  

Stand-alone file or advanced file device
To configure a stand-alone file or advanced files device:

1. In the server’s NetWorker Administration interface, click Devices.

2. From the left pane, select Devices.

3. From the File menu, select New. The Create Devices window appears.

4. For the Name attribute, type the device path.

5. For the Media type attribute, select file or adv_file.

6. Click OK. The new device appears in the right pane.

7. From the right pane, select the new device.

8. From the Devices menu, select Devices>Device Operations>Label.

9. Verify the information in the Label window and click OK.  
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Autochanger or silo
To configure a new library resource (autochanger or silo) to a storage node: 

1. In the server’s NetWorker Administration interface, click Devices.

2. From the left pane, select Storage Nodes.

3. Right-click the storage node for the device.

4. Select Configure All Libraries.

5. Click Start Configuration after filling in the requested information.

6. Click Finish on the Configuration window, when the configuration is complete.

Task 4: Test the NetWorker software installation

Test a NetWorker installation by performing an ad hoc (manual) backup of a file or 
folder. You can also use the NetWorker Client Configuration Wizard to configure a 
scheduled backup. The NetWorker administrator guide provides information about 
the wizard.

The procedure to test the installation differs for Windows and UNIX.

On Microsoft Windows
To test the NetWorker software on a stand-alone tape device:

1. Start the NetWorker Console software and then start the NetWorker User 
program. 

To start the NetWorker User program:

a. From the Administration window, click Monitoring.

b. From the Monitoring menu, select Launch NetWorker User Application.

2. In the NetWorker User program, click Backup.

The NetWorker User program provides a graphical interface through which to 
perform adhoc backups. The NetWorker administrator guide provides 
information about the NetWorker User program.

3. In the left pane of the Backup window, click the appropriate directory folder.

4. Select each directory and/or file for the adhoc backup by performing one of the 
following:

• Select the directory or file and click Mark. To clear an item, click Unmark.

• Right-click the directory or file.

When a directory or file is marked for backup, a check mark appears next to that 
item.

5. Click Start to begin the adhoc backup. 

The Backup Status dialog box displays the progress of the backup. When the 
NetWorker server has successfully finished the backup, this message is displayed:

Backup completion time: 2-15-07 3:27p 

Note: If the backup fails, an error message appears. Use the Windows Event Viewer to 
examine the event logs for additional information. Error messages are also written to the 
NetWorker log file. If the test backup was not successfully completed, refer to the 
troubleshooting information in the NetWorker administrator guide to determine the cause.
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On UNIX

To test the NetWorker software on a stand-alone device, perform an adhoc backup 
from the command-prompt by using the save command. 

For example, to back up C:\myfile to the server jupiter, type:

save -s jupiter /tmp/myfile.txt

The UNIX man pages provide more information.
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